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Summary

Audience

Preface

This Preface provides supporting information for the Oracle Financial Services Behavior
Detection Applications Pack (OFS BD) Installation Guide and includes the following topics:

> Summary

> Audience

> Related Documents
> Conventions

»  Abbreviations

You can find the latest copy of this document in OTN Library which includes all the recent
additions/revisions (if any) done till date.

Before you begin the installation, ensure that you have an access to the Oracle Support Portal
with the required login credentials to quickly notify us of any issues at any stage. You can
obtain the login credentials by contacting Oracle Support.

Oracle Financial Services Behavior Detection Pack Installation Guide is intended for
administrators and implementation consultants who are responsible for installing and
maintaining the Applications Pack components.

Prerequisites for the Audience

Following are the expected preparations from the administrator before starting the actual
installation:

The document assumes that you have experience in installing Enterprise components and basic
knowledge about the following are recommended:

> Oracle Financial Services Behavior Detection pack components
> OFSAA Architecture

> UNIX Commands

> Database Concepts

> Web Server/Web Application Server
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Related Documents

This section identifies additional documents related to OFS BD.
OFSAAI Related Documents

Xiv

Following documents are available in OTN.

2

2

2

Oracle Financial Services Advanced Analytical Applications Infrastructure Applications
Pack Installation and Configuration Guide

Oracle Financial Services Analytical Applications Infrastructure Environment Check
Utility Guide

Oracle Financial Services Analytical Applications Infrastructure Administration Guide

Oracle Financial Services Analytical Applications Infrastructure User Guide

OFS BD Application Related Documents

Following documents are available in OTN.

2

2

2

2

Oracle Financial Services Behavior Detection Administration Guide
Oracle Financial Services Scenario Manager User Guide

Oracle Financial Services Behavior Detection Configuration Guide
Oracle Financial Services Know Your Customer Administration Guide

Oracle Financial Services Foreign Account Tax Compliance Act Administration and
Configuration Guide

Oracle Financial Services Currency Transaction Reporting Administration Guide
Oracle Financial Services Scenario Wizard Configuration Guide

Oracle Financial Services Know Your Customer Risk Assessment Guide
Oracle Financial Services Administration Tools User Guide

Oracle Financial Services FATCA Administration and Configuration Guide
Oracle Financial Services FATCA Assessment Guide

Oracle Financial Services FATCA RR User Guide

Oracle Financial Services FATCA RR Administration and Configuration Guide
Oracle Financial Services Alert Management User Guide

Oracle Financial Services Enterprise Case Management User Guide

Oracle Financial Services Common Reporting Standard User Guide

Oracle Financial Services Common Reporting Standard Administration Configuration
Guide

Oracle Financial Services Behavior Detection Release Notes

The following documents are available in My Oracle Support (MOS). You should have SSO
credentials to access MOS.

2

2

2

Oracle Financial Services Analytical Applications Infrastructure Security Guide
Oracle Financial Services Common Reporting Standard Data Model Reference Guide
Oracle Financial Services Know Your Customer Data Model Reference Guide

Financial Services Data Model Reference Guide Volume 1: Business Data
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> Financial Services Data Model Reference Guide Volume 2: Oracle Financial Services
Data

> Financial Services Data Model Reference Guide Volume 3: Case Management Data
> Data Interface Specification

> Oracle Financial Services Anti-Money Laundering Technical Scenario Description
> Oracle Financial Services Broker Compliance Technical Scenario Description

> Oracle Financial Services Energy and Commodity Trading Compliance Technical Scenario
Description

> Oracle Financial Services Fraud Technical Scenario Description

> Oracle Financial Services Trading Compliance Technical Scenario Description

Conventions

The following text conventions are used in this document:

Table 0-1 Conventions used in this guide

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables
for which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs,
code in examples, text that appears on the screen, or text that you
enter.
Abbreviations

The following table lists the abbreviations used in this document:

Table 0-2 Abbreviations and their meaning

Abbreviation Meaning

BD Behavior Detection

GUI Graphical User Interface

HTTPS Hypertext Transfer Protocol Secure

J2C J2EE Connector

J2EE Java 2 Enterprise Edition

JDBC Java Database Connectivity

LDAP Lightweight Directory Access Protocol

LHS Left Hand Side

MOS My Oracle Support

OFSAA Oracle Financial Services Analytical Application
OFSAAI Oracle Financial Services Analytical Application Infrastructure
OLAP On-Line Analytical Processing

oS Operating System
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Table 0-2 Abbreviations and their meaning

Abbreviation

Meaning

SFTP Secure File Transfer Protocol
URL Uniform Resource Locator
Web Archive WAR

XML Extensible Markup Language




1

About OFSAA and OFSAA Applications Packs

This chapter provides complete details about Behavior Detection (BD) Applications Pack.
This chapter includes the following topics:

> About OFSAA

> Introduction to OFS BD Application

> About OFSAA Infrastructure

About OFSAA

In today's turbulent markets, financial institutions require a better understanding of their
risk-return, while strengthening competitive advantage and enhancing long-term customer
value. Oracle Financial Services Analytical Applications (OFSAA) enable financial institutions
to measure and meet risk adjusted performance objectives, cultivate a risk management culture
through transparency, lower the costs of compliance and regulation, and improve insight into
customer behavior.

OFSAA uses industry-leading analytical methods, shared data model and applications
architecture to enable integrated risk management, performance management, customer insight,
and compliance management. OFSAA actively incorporates risk into decision making, enables
to achieve a consistent view of performance, promote a transparent risk management culture,
and provide pervasive intelligence.

With the help of OFSAA, the financial services organizations can achieve, management
excellence with a lower total cost of ownership, due to our integrated, architecture, combining
performance and risk applications into a single, seamlessly integrated framework.

OFSAA delivers a comprehensive and integrated suite of financial services analytical
applications for both banking and insurance domain.

The following figure depicts the various Applications Pack that are available across the
OFSAA Banking and Insurance domains:
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Figure 1-1 OFSAA Applications Packs
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Introduction to OFS BD Application

OFS BD Applications Pack includes the following applications:

?

Oracle Financial Services Analytical Applications Infrastructure (OFSAAI) powers
the Oracle Financial Services Analytical Applications family of products to perform the
processing, categorizing, selection and manipulation of data and information needed to
analyze, understand and report on specific performance, risk, compliance and customer
insight issues by providing a strong foundation for the entire family of Oracle Financial
Services Analytical Applications across the domains of Risk, Performance, Compliance
and Customer Insight.

Oracle Financial Services Inline Processing Engine (OFS IPE) provides real-time
monitoring, detection and interdiction of single and complex fraud events across multiple
channels and lines of business.

Oracle Financial Services Anti-Money Laundering (OFS AML) monitors transactions
to identify possible money-laundering activities. These scenarios consider whether the
geographical location or entities involved warrant enhanced scrutiny; monitor activity
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between accounts, customers, correspondents, and other entities to reveal relationships that
could indicate efforts to launder funds; address sudden, significant changes in transaction
activity that could indicate money laundering or fraud; and detect other types of activities
that are considered potentially suspicious or indicative of money laundering.

For example, the Journals Between Unrelated Accounts scenario detects accounts that
conduct journal transactions, within a specified period, to one or more accounts that do not
share tax identifiers, do not share a customer, are not in the same household, and are not
known to have a formal relationship. This behavior might indicate that money launderers
have established a number of accounts using aliases or slightly different identifying
information, and then moving money between accounts as part of a layering strategy, often
consolidating the funds in a single account before removing them from the institution.

Oracle Financial Services Fraud Enterprise Edition (OFS FEE) detects behaviors and
patterns that evolve over time and are indicative of sophisticated, complex fraud activity.
These scenarios monitor check and deposit / withdrawal activity, electronic payments, such
as funds transfer and payments completed through clearing house (ACH) mechanisms, and
ATM and Bank Card to identify patterns of activities that could be indicate fraud,
counterfeiting or kiting schemes, identity theft or account takeover schemes. Fraud
scenarios also monitor employee transactions to identify situations in which employees,
acting as insiders, take advantage of access to proprietary customer and account
information to defraud the financial institution's customers.

For example, the Excessive Withdrawals at Multiple Locations scenario monitors a sudden
increase in a customer's withdrawals at ATMs that may indicate money laundering,
terrorist financing, or an account takeover.

Oracle Financial Services Trading Compliance (OFS TC) examines prices and timing
of orders and executions by comparing them to market conditions and detect behaviors or
situations that violate exchange, market center, and individual broker or dealer policies and
procedures, including behaviors that violate the Chinese Wall policies and procedures
established by the Firm or those with confidential information held by the Firm about a
security.

For example, the Trading Ahead of Material Events scenario detects possible insider
trading by analyzing trades which occur prior to “events”, which can be defined by the
Oracle client. The type and volume of trades which occur prior to an event may indicate
that an employee, customer, trader, or trading desk was in possession of material
non-public information. As there may also be non-fraudulent reasons for this trading
activity, this scenario minimizes false alerts by excluding accepted hedging or trading
strategies.

Oracle Financial Services Trade Blotter (OFS TB) allows trades to be viewed and
reviewed, primarily for suitability issues within the wealth management sector, by
compliance analysts and business supervisors after a trade has been executed. The Trade
Blotter is a list of trades returned after a search based on specified criteria. Users can view
trade details, view related trade documents, enter a comment on a specific trade, and then
mark the trade as reviewed or requiring follow-up.

Oracle Financial Services Personal Trading Approval (OFS PTA) monitors employee
investment accounts and trades. Employees of the financial institution submit trade
requests to be made from their approved investment accounts. Compliance officers can
then review, approve, or reject the trade requests to ensure that their employees are acting
in compliance with regulations. Financial institutions can also use this solution to maintain
employee attestations.

Oracle Financial Services Broker Compliance (OFS BC) identifies activities or
situations in customer accounts that involve either a significant amount of risk-and
therefore may be unsuitable for the customer-or may violate trading rules set by the
exchanges or regulators; trades in mutual fund securities that may violate regulatory
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trading guidelines, Commission policies, or are unsuitable for a particular customer; and
activities performed by employees that may violate regulatory conduct rules or may be
prohibited by firm policies. These scenarios also detect instances in which an investment
advisor may be managing client accounts in a manner that is unsuitable for their customers,
giving preferential treatment to particular customers, or manipulating transactions between
accounts; and instances in which a portfolio manager may be placing orders on material,
non-public information, misrepresenting portfolio performance, or unfairly allocating
orders to accounts that they manage.

For example, the Reps Concentrating Solicitations in Too Few Securities scenario verifies
that Registered Representatives are not exposing their clients to undue risk by
recommending a significant percentage of buy solicitations in a single security, which can
result in an unbalanced and volatile portfolio.

> Oracle Financial Services Energy and Commodity Trading Compliance (OFS ECTC)
monitors trading activities that involve the financial institution as the buyer or seller on
energy and commodity related trades, including commodities, options, futures, and swaps.

For example, the Energy Trading Limits scenario monitors trading of energy instruments to
detect excessive hourly amounts of energy traded, based on internal limits which consider
physical and financial power as well as Financial Transmission Rights (FTR). The scenario
generates alerts when the amount of energy approaches or exceeds these internal limits.
This behavior may indicate an attempt to manipulate the market by knowingly creating
congestion with the purpose of benefiting from the creation of that congestion.

> Oracle Financial Services Enterprise Case Management (OFS ECM) manages and
tracks the investigation and resolution of cases related to one or more business entities
involved in potentially suspicious behavior. Cases can be manually created within
Enterprise Case Management or your firm may integrate other Oracle Financial Services
solutions, such as Alert Management, Know Your Customer, and FATCA Management,
which can be used to create cases.

> Oracle Financial Services Know Your Customer (OFS KYC) assesses the risk
associated with a customer by considering different attributes of the customer and enables
financial institutions to perform Due Diligence, Enhanced Due Diligence, and continuous
monitoring of customers. Cases generated in Know Your Customer can be managed within
Enterprise Case Management to track investigations until they have been resolved or
reported to the appropriate regulatory authorities.

> Oracle Financial Services Currency Transaction Reporting (OFS CTR) analyzes
transaction data from the organization and identifies any suspicious activities within the
institution that may lead to fraud or money laundering and must be reported to the
regulatory authorities. Currency Transaction Reports (CTRs) are created either at the
branches or through the end of day files, where the CTR application aggregates multiple
transactions performed at the branch, ATMs and Vaults. Oracle Financial Services
Currency Transaction Reporting then helps the organization file the CTR online with the
U.S. Financial Crimes Enforcement Network (FinCEN) using a discreet form or uploaded
in a batch form in a specific text file format.

Unlike alerts for other Oracle Financial Services products such as Anti-Money Laundering,
Fraud, Trading Compliance, Broker Compliance, or Energy and Commodity Trading
Compliance which appear in an Alert Management user interface, CTR alerts are
automatically processed and converted into CTR reports or Monetary Instrument Log
reports which can be worked through the CTR user interface.

For example, the Bank Secrecy Act Currency Transaction Report scenario detects activity
meeting the requirements for filing a Bank Secrecy Act Currency Transaction Report
(CTR) and reconciles alerts generated by this scenario which are considered batch CTRs
with Branch CTRs. The resulting CTRs are prepared for electronic filing in accordance
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with FinCEN's BSA Electronic Filing Requirements for Bank Secrecy Act Currency
Transaction Report (BSA CTR).

> Oracle Financial Services Foreign Account Tax Compliance Act (OFS FATCA)
Management allows financial institutions to comply with FATCA regulations from the
Internal Revenue Service and the US Treasury Department which prevent US taxpayers
who hold financial assets in non-US financial institutions and other offshore vehicles from
avoiding their US tax obligations. The FATCA Management solution integrates with
Enterprise Case Management to track investigations until they have been resolved or
reported to the appropriate regulatory authorities.

> Oracle Financial Services Common Reporting Standard (OFS CRS) is developed in
response to the G20 request and approved by the OECD Council on 15 July 2014, calls on
jurisdictions to obtain information from their financial institutions and automatically
exchange that information with other jurisdictions on an annual basis. It sets out the
financial account information to be exchanged, the financial institutions required to report,
the different types of accounts and taxpayers covered, as well as common due diligence
procedures to be followed by financial institutions.

About OFSAA Infrastructure

Oracle Financial Services Analytical Applications Infrastructure (OFSAAI) powers the Oracle
Financial Services Analytical Applications family of products to perform the processing,
categorizing, selection and manipulation of data and information needed to analyze, understand
and report on specific performance, risk, compliance and customer insight issues by providing a
strong foundation for the entire family of Oracle Financial Services Analytical Applications
across the domains of Risk, Performance, Compliance, and Customer Insight.

Components of OFSAAI

The OFSAA Infrastructure is comprised of a set of frameworks that operates on and with the
Oracle Financial Services Analytical Applications Data Model and form the array of
components within the Infrastructure.

The OFSAA Infrastructure components/frameworks are installed in two layers: primarily the
metadata server and Infrastructure services run on one layer, and the UI and presentation logic
runs on the other. The Ul and presentation layer is deployed on any of the supported J2EE
Servers.

The following figure depicts the various frameworks and capabilities that make up the OFSAA
Infrastructure:
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Figure 1-2 Components of OFSAAI
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OFSAA Infrastructure High Availability

The current release of the OFSAA Infrastructure supports only "Single Instance" installation for
the Infrastructure components. However, the High Availability (HA) for the Database Server
and/or the Web Application Server clustering and deployment are supported in this release.

This release supports Active-Passive model of implementation for OFSAAI

components. For more information, refer Configuration for High Availability- Best
Practices Guide.
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Understanding OFS BD Pack Installation

This chapter includes the following topics:
> Installation Overview

> Deployment Topology

> Hardware and Software Requirements
> Verifying System Environment

> Understanding the Installation Mode

Installation Overview

This section gives an overview of the OFS BD Pack Installation. Figure 2—1 shows the order of
procedures you will need to follow:
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Figure 2-1 Installation Overview
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Table 2—1 provides additional information and links to specific documentation for each task in
the flowchart.

Table 2-1 OFSBD Applications Pack Installation Tasks and Descriptions

Tasks Details and Documentation

Verify Systems Environment ~ To verify that your system meets the minimum necessary requirements
for installing and hosting the OFSBD Applications Pack, see Verifying
System Environment.

Obtain the software To access and download the OFSBD Applications Pack, see Obtaining
Software.

Configure and Execute the For instructions on creating the database schemas, see Configuring and

Schema Creator Utility Executing Schema Creator Utility.

Install OFS BD Pack For instructions on Installing OFS BD Applications Pack, see Installing

the OFS BD Applications Pack.

Configure OFS BD Pack after ~ See Post Installation Configuration.
installation

Deployment Topology

The following figure depicts the logical architecture implemented for OFS BD Applications
Pack.
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Figure 2-2 Deployment Topology
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Hardware and Software Requirements

This section describes the various Operating Systems, Database, Web Server, and Web
Application Server versions, and other variant details on which this release of the OFS BD
Applications Pack has been qualified.

Note:

OFS BD Applications Pack installation can be performed on both Virtual and Physical
servers.

The following tables show the minimum hardware and software requirements for installing
OFS BD Applications Pack:

Configurations supported for Java 7

Table 2-2 Configurations Supported for Java 7

Operating System
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Table 2-2 (Cont.) Configurations Supported for Java 7

Oracle Linux / Red Hat ?
Enterprise Linux (x86-64)

Oracle Linux Server release 5.3 up to 5.10 - 64 bit
Oracle Linux Server release 6.0 and above - 64 bit

Note: Same versions of RHEL is supported

Oracle Solaris (SPARC)/

~

Oracle Solaris v5.10 Update 11 and above - 64 bit

?

Solaris x86 > Oracle Solaris v5.11 update 1 and above - 64 bit
IBM AIX (POWERPC) »  AIX 6.1 (TL 09 and above) - 64 bit

Shell > KORN Shell (KSH)

Note:

If the OS is IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small,
configure the size parameter setting for "Large File Support". Follow these steps:

Change the file size limit for the user that initiates the transfer on the AIX system. To change the
file size limit for a particular user, add or edit the fsize attribute for the user in the
/etc/security/limits file on the AIX system. Change the file size limit to unlimited (fsize = -1) or to
a size equal to the size of the file being transferred. This may require an restart of the AIX server to
pick up the new configuration. For more information refer IBM Support.

If the operating system is RHEL, install the package Isb_release using one of the following
commands by logging in as root user:

> yum install redhat-lsb-core

> yum install redhat-1lsb

Java Runtime Environment

Oracle Linux / Red Hat ?
Enterprise Linux

Oracle Solaris

Oracle Java Runtime Environment (JRE) 1.7.x - 64 bit

IBM AIX B

IBM AIX Runtime, Java Technology JRE 1.7.x - 64 bit

Oracle Database Server and Client

?

?

?

Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC
with/ without partitioning option

Oracle Database Server Enterprise Edition 12¢ Release 1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC
with/ without partitioning option

Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

Oracle Client 12¢ Release 1 (12.1.0.1.0+) - 64 bit

Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)
Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)
Oracle Distribution of R version 2.15.1, 2.15.2 or 2.15.3.(Optional)
Oracle R Enterprise (Server) version 1.4. (Optional)

?

?

?

2

Note:

Ensure that the following patches are applied:

Oracle Server 12¢, v12.1.0.1 — 17082699
Oracle Server 12¢, v12.1.0.2 - 20698050

Also for latest information, refer http://support.oracle.com/, 12.1.0.2 Bundle Patches for
Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)

Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/ 12.1.0.1

OLAP
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Hardware and Software Requirements

Table 2-2 (Cont.) Configurations Supported for Java 7

Oracle Hyperion Essbase > V 11.1.2.1+ (Server and Client) with Oracle 11g Database
» V 11.1.2.3+ (Server and Client) with Oracle 12¢ Database

Oracle OLAP » V 11.2.0.3+ with Oracle 11g Database
>V 12.1.0.1+ with Oracle 12c Database

Note:

> Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of
OFSAAL For Oracle OLAP, ensure that you have configured the Oracle Database server with
OLAP option.

Web Server/ Web Application Server

Oracle Linux / Red Hat Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ IBM HTTP
Enterprise Linux/ IBM AIX Server
Oracle Solaris > Oracle WebLogic Server 12.1.2+ (64 bit)

> IBM WebSphere Application Server 8.5+ with JDK7
> Apache Tomcat 8.0.x (64 bit)

Note:

> OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle
JRockit is not supported.

Desktop Requirements

Operating System MS Windows 7/ Windows 8/ Windows 8.1
Browser » MS Internet Explorer 9, 10(Compatibility Mode) and 11
(Compatibility Mode)

Oracle Java plug-in 1.7.0+* (64- bit)

Turn off Pop-up blocker settings. For more information, refer Internet
Explorer Settings

Office Tools 2 MS Office 2007/2010/2013
? Adobe Acrobat Reader 8 or above

Screen Resolution 1024*768 or 1280%1024
Other Software
Directory Services OFSAALI is qualified on both OPEN LDAP 2.2.29+ and Oracle

Internet Directory v 11.1.1.3.0. However, it can be integrated with
other directory services software like MS Active Directory.

Note:

»  Configuration of Directory services software for OFSAALI installation is optional. For more
information on configuration, see Infrastructure LDAP Configuration.

> Open LDAP needs to be installed on MS Windows Server machine only.

Configurations supported for Java 8

Table 2-3 Configurations Supported for Java 8

Operating System

Oracle Linux / Red Hat »  Oracle Linux Server release 5.3 up to 5.10 - 64 bit

Enterprise Linux (x86-64) Oracle Linux Server release 6.0 and above - 64 bit

Note: Same versions of RHEL is supported
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Table 2-3 (Cont.) Configurations Supported for Java 8

Oracle Solaris (SPARC)/ p Oracle Solaris v5.10 Update 11 and above - 64 bit

Solaris x86 > Oracle Solaris v5.11 update 1 and above - 64 bit

IBM AIX (POWERPC) »  AIX 6.1 (TL 09 and above) - 64 bit
Shell > KORN Shell (KSH)
Note:

» Ifthe OS is IBM AIX 6.1, configure the size parameter setting for "Large File Support". Refer link
http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290 for more details.

> If the operating system is RHEL, install the package Isb_release using one of the following
commands by logging in as root user:

> yum install redhat-lsb-core

> yum install redhat-1lsb

Java Runtime Environment

Oracle Linux / Red Hat P Oracle Java Runtime Environment (JRE) 1.8.x - 64 bit
Enterprise Linux

Oracle Solaris

IBM AIX > IBM AIX Runtime, Java Technology JRE 1.8.x - 64 bit

Oracle Database Server and Client

»  Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC
with/ without partitioning option

»  Oracle Database Server Enterprise Edition 12¢ Release 1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC
with/ without partitioning option

> Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

> Oracle Client 12¢ Release 1 (12.1.0.1.0+) - 64 bit

p Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

»  Oracle 12C Release 1 (12.1.0.14) JDBC driver (Oracle thin driver)
? Oracle Distribution of R version 2.15.1, 2.15.2 or 2.15.3.(Optional)
> Oracle R Enterprise (Server) version 1.4. (Optional)

Note:

Ensure that the following patches are applied:

2 Oracle Server 12¢, v12.1.0.1 — 17082699
? Oracle Server 12¢, v12.1.0.2 - 20698050

> Also for latest information, refer http://support.oracle.com/, 12.1.0.2 Bundle Patches for
Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)

» Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/ 12.1.0.1

OLAP
Oracle Hyperion Essbase » V 11.1.2.1+ (Server and Client) with Oracle 11g Database
2 V 11.1.2.3+ (Server and Client) with Oracle 12¢ Database
Oracle OLAP >V 11.2.0.3+ with Oracle 11g Database
» V 12.1.0.1+ with Oracle 12c Database
Note:

»  Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of
OFSAAL For Oracle OLAP, ensure that you have configured the Oracle Database server with
OLAP option.
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Hardware and Software Requirements

Table 2-3 (Cont.) Configurations Supported for Java 8

Web Server/ Web Application Server

Oracle Linux / Red Hat Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ IBM HTTP
Enterprise Linux / IBM AIX Server
Oracle Solaris > Oracle WebLogic Server 12.1.3+ (64 bit)

> Apache Tomcat 8.0.x (64 bit)

Note:

IBM WebSphere 8.5.x (Full Profile) on Java 8 is not available.

Note:

» OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle
JRockit is not supported.

> For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install
patch 18729264 from http://support.oracle.com/.

Desktop Requirements

Operating System MS Windows 7/ Windows 8/ Windows 8.1
Browser > MS Internet Explorer 9, 10(Compatibility Mode) and 11
(Compatibility Mode)

Oracle Java plug-in 1.7.0+* (64- bit)

Turn off Pop-up blocker settings. For more information, refer Internet
Explorer Settings

Office Tools P MS Office 2007/2010/2013
? Adobe Acrobat Reader 8 or above

Screen Resolution 1024*768 or 1280*1024
Other Software
Directory Services OFSAALI is qualified on both OPEN LDAP 2.2.29+ and Oracle

Internet Directory v 11.1.1.3.0. However, it can be integrated with
other directory services software like MS Active Directory.

Note:

»  Configuration of Directory services software for OFSAALI installation is optional. For more
information on configuration, see Infrastructure LDAP Configuration.

» Open LDAP needs to be installed on MS Windows Server machine only.

Note: To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8, refer
Appendix O.

OFS BD Applications Pack recommends the following software combinations for deployment:

Table 2-4 Recommended Software Combinations

Web Application
Operating System | Database Server Web Server
Oracle Linux 5.3 up | Oracle Database Oracle WebLogic Server Oracle HTTP Server/
to 5.10/ 6.0 and /Apache Tomcat Server Apache HTTP Server
above
Oracle Solaris 5.10/ Oracle Database Oracle WebLogic Server Oracle HTTP Server/
5.11 /Apache Tomcat Server Apache HTTP Server
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Verifying System Environment

Table 2-4 Recommended Software Combinations

Web Application

Operating System | Database Server Web Server
IBM AIX 6.1 Oracle Database IBM WebSphere IBM HTTP Server/
Application Server Apache HTTP Server

/Apache Tomcat Server

Verifying System Environment

To verify your system environment meets the minimum requirements for the installation, a
Pre-Install Check utility is available within the Install Kit archive file. This utility can also be
obtained separately by contacting Oracle Support.

Though the system environment verification is an integral and automated part of the installation
of this software product, Oracle strongly recommends running this utility prior to beginning the
installation as part of your organization's "Installation Readiness Verification Process".

Note: For more details on download and usage of this utility, see Oracle
Financial Services Analytical Applications Infrastructure Environment Check
Utility Guide given in the Related Documents section.

Understanding the Installation Mode
The following modes of installation are available for the OFS BD Applications Pack.
> GUI Mode
> SILENT Mode

GUI Mode
This mode launches the product installation in a Graphical User Interface (GUI) Mode. Users
need to enter the required information on various panels within the Ul in a user interaction
format at various stages.
Note: For more information on configuration required for GUI Mode
installation, refer Configuration for GUI Mode Installation.
SILENT Mode

This mode mandates updating the installation configuration files with required details and
performs installation in a "Silent" non user interactive format.
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Preparing for Installation

This chapter provides necessary information to review before installing the Oracle Financial
Services Behavior Detection (OFS BD) Applications Pack v8.0.3.0.0.

This chapter includes the following topics:
> Installer and Installation Prerequisites
> Obtaining Software

> Common Installation Tasks

Installer and Installation Prerequisites

Table 3—1 mentions the list of prerequisites required before beginning the installation for OFS
BD application. The Environment Check utility notifies you if any requirements are not met.
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Installer and Installation Prerequisites

Table 3—-1

Prerequisite Information

Category

Sub-Category

Expected Value

Environment
Settings

User Permission

User to have 755 permission on the directory identified
for installation (FIC_HOME).

Note: User to have 755 permission on the .profile
file

Provide BDF_ HOME in .profile pointing to
Installation Directory (FIC_ HOME)

Java Settings

2

PATH in .profile to be set to include the Java
Runtime Environment absolute path. The path
should include java version (java 7 or java §) based
on the configuration.

Note:

2

Ensure the absolute path to JRE/bin is set at the
beginning of PATH variable.

For example,
PATH=/usr/java/jrel.7/bin:SORACLE _
HOME/bin:$SPATH

Ensure no SYMBOLIC links to JAVA installation is
being set in the PATH variable

Oracle Database
Settings

TNS_ADMIN to be set in.profile pointing to
appropriate tnsnames.ora file

ORACLE_HOME to be set in .profile pointing to
appropriate Oracle Client installation PATH in
.profile to be set to include appropriate SORACLE
HOME/bin path.

PATH in .profile to be set to include appropriate
$ORACLE_HOME/bin path

Ensure to add an entry (with SID/ SERVICE
NAME) in the tnsnames.ora file on the OFSAA
server
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Table 3—-1 (Cont.) Prerequisite Information

Category

Sub-Category

Expected Value

OS/File System
Settings

OS Level Settings

You must set your locale to UTF-8 locale (LANG, NLS
LANG to be set in.profile). Specifying a locale depends
on your data and the operating system installed on your
system.

For example,

> For Solaris OS: export LANG=en_US.UTF-8
PATH in .profile to be set to include time zone
For example: export TZ=Asia/Calcutta

2 For Linux OS: export LANG=en_ US.utf8
p For AIX: export LANG=EN_US.UTF-8

You can determine the locale on your system using the
locale -a command

export NLS_ LANG=AMERICAN _

AMERICA.AL32UTF8
File Descriptor Greater than 15000
Settings
Total Number of Greater than 4096

Process Settings

tmp space

Prior to installation, ensure that sufficient free temp space
(minimum 1 GB free) is available in /tmp directory of
unix server hosting OFSBD.

Port Settings

Default port numbers to be enabled on the system are
6500, 6501, 6505, 6507, 6509, 6510, 6666, 9999, and
10101.

Staging Area/
Metadata Repository

A directory to hold the application metadata artifacts and
additionally act as staging area.The directory should exist
on the same system as the OFSAA Infrastructure (can be
configured on different mount). However, the owner of
the installation directory mentioned above should have
RWX permissions on this folder.

Set 775 permission on this folder.

Note: This directory is also referred as FTPSHARE
folder.
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Table 3—-1 (Cont.) Prerequisite Information

Category

Sub-Category

Expected Value

Installation
Directory

A directory where the product files will be installed.

User permission is set to 755 on the installation directory.

Temporary Directory

Default temporary directory where installation files are
stored for a short period of time to support faster
installation.

e For installation on UNIX OS, your UNIX
administrator must give you the required

read-write permissions for the /tmp directory

and disable the NOEXEC option

*  Configure adequate space on the /tmp directory.
It is recommended that you allocate more than

10 GB of space.

Note: If NOEXEC is enabled, the extraction of files by

the installer into the /tmp directory is prevented and the
binaries will not execute in the directory, which will fail
the installation.

Download Directory

A directory where the product installer file will be
downloaded/ copied.

Ensure user permission is set to 755 on the Download
directory.

OS Locale

»  Linux: en US.utfs
> AIX: EN US.UTF-8
B Solaris: en US.UTF-8

To check the locale installed, execute the following
command:

locale -a | grep -i 'en US.utf'

Database Settings

Database Instance
Settings

» NLS CHARACTERSET to be AL32UTF8
» NLS_LENGTH_SEMANTICS to be BYTE

> AVAILABLE OPEN CURSORS limit to be greater
than 4096

For an Oracle Database installation, set your Oracle
NLS_LANG environment variable to an appropriate
UTF-8 character set.

For example, setenv NLS LANG AMERICAN
AMERICA.AL32UTF8

Note: For other database tunable parameters required for
OFS BD, see Tunable Database Parameters.

Ensure that the OLAP_USER role is available in the
database.
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Table 3—-1 (Cont.) Prerequisite Information

Category Sub-Category Expected Value
Web Application WebSphere/ Web Application Server should be installed and
Server WebLogic/ Tomcat  |profile/domain created.
You are prompted to enter the WebSphere Profile path,
WebLogic Domain path, or Tomcat Deployment path
during OFSAALI installation.
Note:
> Refer Appendix A for WebSphere Profile Creation
and WebLogic Domain Creation.
»  For deployment on Oracle WebLogic Server 12.1.3+
(64 bit) with Java 8, download and install patch
18729264 from http://support.oracle.com/.
Web Server Apache HTTP This is an optional requirement. HTTP Server Installation
Server/ Oracle to be present. You will be required to enter the Web
HTTP Server/ Server IP/Hostname and Port details during installation.
IBM HTTP Server. |Note: Refer Appendix A for Web Server installation.

Obtaining Software

This release of OFS BD Applications Pack v8.0.3.0.0 can be downloaded from the Oracle
Software Delivery Cloud (https://edelivery.oracle.com). You need to have a valid
Oracle account in order to download the software.

Common Installation Tasks

The following are the common pre-installation activities that you need to carry out before
installing the OFS BD Applications Pack.

This section includes the following topics:

?

?

?

?

?

Identifying the Installation Directory, Download and Metadata Repository
Download and copy OFS BD Applications Pack Installer

Configuration for GUI Mode Installation

Extracting the Software

Setting Up Web Application Server

Identifying the Installation Directory, Download and Metadata

Repository

This is typically the User home directory and requires you to copy the following files:

2

OFS BD Download Directory (Optional) - Create a download directory and copy the OFS
BD Applications Pack Installer File (Archive). This is the directory where the downloaded
installer/patches can be copied.

OFS BD Installation Directory (Mandatory) - This is the directory where the installer
would install/ copy the product files. FIC_HOME variable to be set in the .profile pointing
to this OFS BD Installation Directory.

OFS BD Staging/Metadata Directory (Mandatory) - Create a Staging/Metadata
Directory. This is the directory where you would be required to copy data loading files,
save data extracts etc. Additionally, this folder also maintains the OFSAA metadata
artifacts. This is also referred as "FTPSHARE".
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Note:
Ensure the user permission is set to 755 on the Installation and Download Directory.

Ensure the user permission is set to 775 on the Staging Directory.

Download and copy OFS BD Applications Pack Installer

To download and copy the OFS BD Applications Pack Installer, follow these steps:

1. To download the OFS BD Applications Pack, you need to login to the Oracle Software
Delivery Cloud (https://edelivery.oracle.com). You need to have a valid Oracle account in
order to download the software.

2. Copy the downloaded installer archive to the Download Directory (in Binary Mode) on the
setup identified for OFS BD installation.

Configuration for GUI Mode Installation

To install OFS BD Applications Pack in GUI mode, you need to ensure the following software
and configurations are available:

1. Install and configure any PC X Server software such as Open Text Exceed (formerly
Hummingbird Exceed) on the user desktop system from which the installation is triggered.

2. Configure the DISPLAY variable.

Ensure to set the DISPLAY variable on the system on which the OFS BD will be
installed, to point to the user desktop system where the PC X Server software has
been installed.

Syntax:
export DISPLAY=hostname:n.nl

where hostname is the IP Address/Host Name of the user desktop system and n is
the sequence number (usually 0).

For example, 10.11.12.13:0.0 or myhostname:0.0

Extracting the Software

Note:

You must be logged in to the UNIX operating system as a non-root user.

1. Download the unzip utility (OS specific) unzip <os>.Z and copy it in Binary mode to the
directory that is included in your PATH variable. If you already have the unzip utility to
extract the contents of the downloaded archive, skip to the next step.

2. Uncompress the unzip installer file using the command:

uncompress unzip <os>.Z

Note:

In case you notice an error message "uncompress: not found [No such file or
directory]" when the package is not installed, contact your UNIX
administrator.
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3. Give EXECUTE permission to the file using the command:
chmod 751 unzip <0S>
For example, chmod 751 unzip sparc

4. Extract the contents of the Oracle Financial Services Behavior Detection Applications
Pack 8.0.3.0.0 in Download Directory installer archive file using the following command:

unzip OFS BD PACK.zip

Note:

Do not rename the Applications Pack installer folder name on extraction from
the archive.

5. Navigate to the directory where the installer kit is extracted.
Give below permission to the installer folder.

chmod -R 755 OFS BD PACK

Setting Up Web Application Server

For setting up the environment based on your selected Web Application Server, refer to the
Appendix Configuring Web Application Servers.
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Installing OFS BD Pack

This chapter describes the steps to be followed to install the OFS BD pack depending on the
offline and online modes of installation.

Note: If you are installing an Applications Pack on an environment, where another
Applications Pack is already installed, you may sometimes get a warning message like Object
Already Exists. This message can be ignored.

This chapter includes the following sections:

> Schema Creator Utility

> Configuring and Executing Schema Creator Utility
> Installing the OFS BD Applications Pack

> Verifying Installation

Schema Creator Utility

Creating database users/schemas is one of the primary steps in the complete OFS BD
installation. This release of OFSAA provides a utility to quickly get started with the OFSAA
8.0.3.0.0 installation by allowing easier and faster creation of database User(s)/ Schema(s),
assign the necessary GRANT(s), and so on. Additionally, it also creates the required entities in
these schemas.

The different types of schemas available for configuration in the OFSAA instance and their use
is mentioned as follows:

> About Config Schema
> Execution Modes in Schema Creator Utility

> Execution Options in Schema Creator Utility

About Config Schema

The schema creator utility should be configured and executed mandatorily every time prior to
installation of any OFSAA Applications Pack.

The following are the types of schemas that can be configured in the OFSAA:

> CONFIG - This schema denotes the unique OFSAA setup configuration schema and holds
entities and other objects required to hold the unique OFSAA setup information.
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Note: There can be only one CONFIG schema per OFSAA instance.

> ATOMIC - This schema denotes the schema that holds the data model entities. One
ATOMIC schema is attached to one Information Domain.

Note: There can be multiple ATOMIC schemas per OFSAA Instance and an
Information Domain can have only one ATOMIC schema.

> ADDON - This schema denotes any additional schema used by the OFSAA Applications.

Execution Modes in Schema Creator Utility

Schema creator utility supports two modes of execution:

> Online Mode: In this mode, the utility connects to the database and executes the DDLs for
User, Entities, and Grants.

Note: To execute the utility in Online mode, you need to connect as "<User>
AS SYSDBA".

> Offline Mode: In this mode, the utility generates a SQL script with all the required DDLs
for User, Entities and Grants. This script needs to be executed by the DBA on the
appropriate database identified for OFSAA usage.

Note: For running the sql script generated in offline mode, the script should reside
in the same directory where the 'SQLScripts' directory is available.

Note:

1. To execute the utility in Offline mode, you need to connect as any user with the
following grants (alternatively, you can also connect as a user with SYSDBA
privileges):

? SELECT ON DBA_ROLES

> SELECT ON DBA_USERS

> SELECT ON DBA_DIRECTORIES
> SELECT ON DBA_TABLESPACES
> CREATE SESSION

2. Do not modify the OFS BD SCHEMA OUT.XML file generated after the
execution of this utility

3. Ifthere are any errors during the script execution, reconfigure the OFS_BD
SCHEMA IN.xml file and execute the utility. This regenerates the scripts with
corrected information. Refer

4. Do not keep any backup files of xml's in the download directory.
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Execution Options in Schema Creator Utility

Depending on the option selected to run the OFSAA Applications Pack Installer, you need to
select the schema creator utility execution option. To run the OFSAA Applications Pack
installer in SILENT mode, it is mandatory to execute the schema creator utility with -s option.

Note: If the schema creator utility is executed without the option -s, it is
mandatory to run the OFSAA Applications Pack Installer in GUI mode.

Configuring and Executing Schema Creator Utility

This section includes the following topics:

2

2

2

Prerequisites

Prerequisites
Configuring Schema Creator Utility
Executing the Schema Creator Utility

Verifying the Log File

Note: If you intend to use Oracle OLAP feature, execute the below grant
on all ATOMIC schema(s): grant olap user to &database username.

The following prerequisites must be satisfied before configuring the Schema Creator Utility:

?

?

?

?

You must have the Oracle User ID/Password with SYSDBA privileges.
You must have the JDBC Connection URL for RAC/Non RAC database.
The HOSTNAME/IP of the server on which OFSAA is getting installed.

TNSNames.ora should have entry for the database planning to install the Database objects.

Configuring Schema Creator Utility

This section explains the steps to configure the Schema Creator Utility.

Note: The extracted media pack folder name must not be changed.

To configure the Schema Creator Utility, follow these steps:

1.

2
3.
4

Log in to the system as non-root user.
Navigate to the following path: OFS_BD PACK/schema_creator/conf folder.
Edit the OFS_BD SCHEMA IN.xml file in a text editor.

Configure the following elements as described in the section Configuring OFS BD
SCHEMA IN.XML file:

Save the OFS_BD SCHEMA IN.xml file.
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Note: On successful execution of the utility, the entered passwords in the
OFS_AAAI SCHEMA IN.xml / OFS_AAAI SCHEMA BIGDATA IN.xml file
are nullified.

Note: While editing the OFS_BD SCHEMA IN.xml, ensure only the
values/tag attributes mentioned in must be modified and none of other tags
should be modified.

Refer to the following List of attributes that should not be modified:

. APP_PACK_ID

» ROLE.NAME

» DIRECTORY. ID

P DIRECTORY.NAME

» SCHEMA. APP_ID

? SCHEMA. DEFAULTTABLESPACE
» SCHEMA. APP_GRP

? SCHEMA.TYPE

» TABLESPACE.NAME

Executing the Schema Creator Utility

You can execute the schema creator utility either in Online Mode or Offline Mode. This section
includes the following topics:

> Executing the Schema Creator Utility in Online Mode
> Executing the Schema Creator Utility in Offline Mode
> Executing the Schema Creator Utility with -s option

> Executing the Schema Creator Utility while Installing Subsequent Applications Pack

Executing the Schema Creator Utility in Online Mode

In Online Mode, the Schema Creator Utility will create all the Schemas, Schema Objects, and
Grants in the database during the execution process.

To execute the schema creator utility while creating the schemas for the first Applications Pack,
follow these steps:

1. Log in to the system as non-root user.
2. Navigate to the following folder path: OFS_BD PACK/schema creator/bin/
3. Execute the osc. sh file using the following command:

./osc.sh

4. The following message is displayed: You have chosen ONLINE mode. Triggering the utility
in ONLINE mode will execute the DDLs directly on the Database. Do you wish to
proceed? (Y/y or N/n).

5. Enter Y/ y to proceed with the script generation.or Enter N/n to quit script creation.
6. Enter the DB Username with SYSDBA Privileges. For example: SYS as SYSDBA.

7. Enter the User Password.
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Figure 4-1 Schema Creation - Online Mode

Note: On successful execution of Schema Creator utility, the console displays the
following status message:

Schema Creator executed successfully. Please proceed with the installation.

Refer log file in OFS_BD_PACK/schema_creator/logs folder for execution
status. In case of any errors, contact Oracle Support.

Executing the Schema Creator Utility in Offline Mode

In Offline Mode, the Schema Creator Utility creates an output in the SQL file format. This
script has to be executed manually by logging as database user with SYSDBA privileges. The
SQL file contains the creation of Schemas, Schema Objects, and Roles.

Prerequisites:
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To execute the utility in Offline mode, you need to connect as any user with below grants
(Alternatively, you can also connect as a user with SYSDBA privileges):

Database user with the following privileges:
? SELECT ON DBA ROLES

? SELECT ON DBA USERS

? SELECT ON DBA DIRECTORIES

? SELECT ON DBA TABLESPACES

? CREATE SESSION

Note: Explicit Grants to the user are required. Grants assigned through Roles are
not supported

To execute the schema creator utility in the offline mode, follow these steps:
1. Log in to the system as non-root user.
2. Navigate to the following folder path: OFS_BD PACK/schema_creator/bin
3. Execute the osc.sh file using the following command:
./osc.sh -o
4. The Enter Y /y to generate the script.
or
Enter N/n to quit the schema creation.

5. The following message is displayed: You have chosen OF FLINE mode. Triggering the
utility in OFFLINE mode will generate the script. Do you wish to proceed? (Y/y or N/n).

6. Enter the DB Username with SELECT privileges.

7. Enter the User Password.

Figure 4-3 Schema Creation - Offline Mode
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8. The console runs the initial validation checks and displays the following message: You
have chosen to install this Applications Pack on <Name of the Atomic Schema>ATOMIC
schema. Do you want to proceed? (Y/N).

9. Enter Y/y to start the script generation. Or Enter N/n if you want to quit the script
generation. The following message is displayed. You have chosen to install this
Applications Pack on <Name of the Infodom>. Do you want to proceed? (Y/N)).

Note: On successful execution of schema creator utility, the console displays the
following status message:

Success. Please execute OFS_BD_PACK/schema creator/sysdba_output
scripts.sql before proceeding with the installation.

Figure 4-4 Schema Creation - Offline Mode

10. Navigate to the directory:
OFS_BD_ PACK/schema_creator

11. Login to SQLPLUS with a user having SYSDBA Privileges.

Figure 4-5 Schema Creator - Offline Mode
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12. Execute the sysdba_output_scripts.sql file using the following command:

SQL>@sysdba_output scripts.sql

Alternatively, you can copy the sysdba_output scripts.sgl file and SQLScripts
folder to a remote server and execute sysdba_output scripts.sqgl file.

Note: Refer log sysdba output scripts.log file for execution status.
In case of any errors, contact Oracle Support.

SQL Scripts folder and SQI file should reside in the same folder.

13. Once the above file gets executed, a warning is displayed as shown in the above screen.

14. Run the below script in config schema:

1.

2
3.
4

Navigate to the <OFS_BD PACK>/schema creator/SQLScripts/oracle folder.
Connect to the config schema through sqlplus
Execute the @compile objects.sqgl command.

Commit the change.

Executing the Schema Creator Utility with -s option

If you want to run the OFS BD Applications Pack Installer in SILENT mode, it is mandatory to
execute the schema creator utility with -s option.

To execute the utility with -s option, follow these steps:

1. Edit the file OFS_BD PACK/schema_creator/conf/OFS BD SCHEMA IN.xml in text
editor.

2. Set the value for attribute "INFODOM" of <SCHEMA> tag(s) to specify a specific
Information Domain name. By default, the value is empty and the utility will derive the
Information Domain name. If the attribute value is set, the utility/ installer will configure
the Information Domain against this <SCHEMA>.

Note: The infodom name and schema name should be same for all the
below APP_ID:

. OFS_FATCA
. OFS_FRAUD

. OFS_AML
. OFS TC

. OFS_ECTC
. OFS_PTA

. OFS TB

. OFS_BC

. OFS_IPE

»  OFS_FRAUD_EE

3. Execute the utility with -s option.

For Example . /osc.sh -s
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Note: If the utility is executed without the - option, it is mandatory to
launch the OFSAA Applications Pack Installer in GUI mode.

Note: To execute the utility in OFFLINE mode with SILENT option, type
./osc.sh -o -s

Executing the Schema Creator Utility while Installing Subsequent
Applications Pack

While executing the schema creator utility for subsequent Applications Pack, you can choose to
install the pack either on the same Information Domain/Atomic Schema or on a new

Information Domain/Atomic Schema. You can execute the Schema Creator Ultility either in
Online or Offline Mode.

Note: OFS BD Pack needs to be installed on a separate information domain.

To execute the schema creator utility while installing OFS BD Pack over an existing
Applications Pack, follow these steps:

1. Perform the steps 1 to 5 from the Executing the Schema Creator Utility section.

Note: On successful execution of Schema Creator utility, the console displays the
following status message:

Success. Please proceed with the installation.

Refer log file in OFS_BD_PACK/schema_creator/logs folder for execution
status, if scripts are executed in online mode.

Refer log sysdba output scripts.log file for execution status, if
executed in offline mode.

In case of any errors, contact Oracle Support.

Verifying the Log File
You can verify the log files for any errors faced during the schema creation process in the
following location: OFS_BD PACK/schema_ creator/logs.

Installing the OFS BD Applications Pack

Follow the instructions in this section to install the OFS BD Applications Pack depending on
the mode of installation.

? SILENT Mode Installation
2 GUI Mode Installation

SILENT Mode Installation

In the Silent Mode Installation you must configure the product xml files and follow the
instructions in command prompt.
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Configuring OFSAAI_InstallConfig.xml

Follow these instructions to configure OFSAA InstallConfig.xml file:

1.
2.

Log in to the system as non-root user.

Identify a directory for installation and set the same in the user .profile file as the
following:

FIC HOME=< OFSAA Installation Directory »>

export FIC_HOME

Execute the user .profile.

Navigate to the file: OFS_BD_ PACK/OFS_AAI/conf/OFSAAI InstallConfig.xml

Configure the OFSAAI InstallConfig.xml as mentioned in the section Configuring
OFSAAI InstallConfig.xml file. You need to manually set the Interaction Variable
parameter values as mentioned in the table. If a value is not applicable, enter NA and
ensure that the value is not entered as NULL.

Navigate to the file: OFS_BD_ PACK/conf/OFS_BD PACK.xml and select the applications to
be enabled.

Note: Enter YES in ENABLE tag to enable application.

Configuring InstallConfig.xml
To configure the InstallConfig.xml file, follow these steps:

1.
2,

Navigate to the file: OFS_BD PACK/OFS BD/conf/InstallConfig.xml

Enter the details mentioned in the tags (<!-- Start: User input required for silent installer.
--> and <!-- End: User input required for silent installer. -->) as mentioned in the following
table.

Table 4-1 InstallConfig.xml Parameters

Placeholder Name

Significance and Expected Value Mandatory

##OFS_AML_BASE_

ISO country code to use during data ingestion to record Yes

COUNTRY## institution-derived geography risk on parties on transactions that are
internal to the OFSBD client.
For example: base country=US
base country=US
##OFS_AML Jurisdiction to assign the derived entities and derived addresses. Yes
DEFAULT_ For example:
JURISDICTION## xampie:

default jurisdiction=AMEA

##OFS_AML_SMTP_
HOST##

Hostname of the e-mail gateway to be used by the application for e-mail | Yes
notifications.

For example:
smtp_host=mailhost.domain.com

smtp host=mailhost.domain.com
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Table 4-1 (Cont.) InstallConfig.xml Parameters

Placeholder Name Significance and Expected Value Mandatory
##OFS_AML ADMIN  |Admin Tools Web application Context. Yes
TOOLS CONTXT## .
- For Example: admin_tools

Note: During deployment the ear file needs to be deployed with same

name
##OFS_AML Format of the date used in specifying partition dates. Yes
PARTITION DATE_
FORMAT #4 Allowed values are DD-MON-YYYY/DD-MM-YYYY
##OFS_AML WEEK > Flagused to derive partition dates based on Week end holiday Yes
END_HOLIDAY _ pattern.
PATTERN## 2 Allowed values are: Saturday, Sunday/Friday
##OFS_AML Enter the date of the business day for which the data to be loaded. Yes
DataDumpDt_minus_O0%% |y 1, 114 be in dd/mm/yyyy format.

For Example: 10/12/2009
##OFS_AML Enter the date of the Saturday of the next business week with respectto | Yes
EndThisWeek minus_ the date for which the data is loaded.
007 It should be in dd/mm/yyyy format.

For Example: 19/12/2009
##OFS_AML Enter the first business day of the next month with respect to the data Yes
StartNxtMnth_minus_ load date.
007 Tt should be in dd/mm/yyyy format.

For Example:01/01/2010
##OFS_AML Name of the Analyst Data source used for Admin Tools Configurations. |Yes
g’gg’g{gg;;DATA— For example: Create a data source with name ANALYST
##OFS_AML MINER  [Name of the Miner Data source used for Admin Tools Configurations Yes
DATA_SOURCE## For example: Create a data source with name MINER
##OFS_AML WEB Web service user for Post Alert Services. Yes
SERVICE USER##
##OFS_AML WEB Web service password for Post Alert Services. Yes
SERVICE
PASSWORD##
##OFS_AML _NLS_ ##OFS_AML_NLS_LENGTH_SEMANTICS##NLS_LENGTH Yes
LENGTH _ SEMANTICS database variable for executing the DDL scripts.
SEMANTICS## Applicable values are CHAR/BYTE.

Note: Recommendation to go with CHAR.
##OFS_AML Mention flag as ‘1” to configure OBIEE URL. Yes
CONFIGURE_ OBIEE## . . s

- Otherwise mention as ‘0

##OFS_AML OBIEE In case ##0FS_AML_CONFIGURE OBIEE URL## mentioned as Yes
URL## ‘1’...provide the URL in the pattern

Running the installer in Silent Mode

To install the OFSAA Infrastructure in Silent mode for java 7 and java 8, follow these steps:
1. Navigate to the OFS_BD_ PACK/bin folder.

2. Execute the command in the console:
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./setup.sh SILENT

Completing the installation in Silent Mode

On launching the installer in silent mode, the environment check utility is executed. Enter the
required information to execute the utility as explained:

Note: The above table item is asked if environment check utility is executed
in the standalone mode.
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Note:

> Enter the Infrastructure FTP/SFTP password value, when prompted at the
command prompt.

> Enter Always, when prompted to add host key fingerprint.
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Table 4-2 Webserver start up options

Console Prompts User Inputs

Enter Infrastructure FTP/SFTP password Enter the password to access Product Staging/Metadata repository directory in the
application server.

1. The OFSAAI License Agreement is displayed as shown in the figure:

Figure 4-6 OFSAAI License Agreement Page

Appli

nnot he di

2. Enter Y/y to accept the License Agreement.
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Note: SYSADMN and SYSAUTH are the two default OFSAAI
administrative users created.

# ofss2010Lineracle.com - PuTTY

n of it, way
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and criminal penalties

Launching install

aring SILENT

Installacion Complete
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Note: The installation process continues on the console. Do not close the
console until the installation process is complete.

Execute .profile from user home directory after the installation is
completed.

3. Perform steps mentioned in the Post Installation Configuration section.

GUI Mode Installation

Note: Ensure you have followed the steps as mentioned in the Configuration
for GUI Mode Installation section prior to proceeding with the next steps.

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as the
following:

FIC HOME=<OFSBD Installation Directory>
export FIC HOME
3. Execute the user .profile.

4. Execute ./setup.sh GUI in the console.

Note: If the Precheck is successful, the installation begins. Else the
installation aborts.
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Figure 4-7 License Agreement

License Agreemen!

Welcome to the OFSAA Application Pack Installation

[0 Prelnstall Setup This program will quide you through the installation of OFSAA Application Pack.
(D Installation

Copyright © 19393, 20186, Cracle and J or its affiliates. Al rights reserved
() Install Complete

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual
property laws, Except as expresshy permitted inyour license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license,
transmit, distribute, exhibit, perform, publish or display amy part, in amy form, or by any means. Eewerse engineering, disassembly, or decompilation of this
software, unless required by law for interoperability is prohibited.

The information contained herein is subject to change without notice and is not warranted 1o be error-free. If wou find amy errors, please report them to us in writing.

If this software or related documentation is delivered to the U.5. Government ar anyane licensing it on biehalf of the U.S. Government, the following notice is
applicable

.5, GOYERNMENT EMD USERS: Oracle programs, including any operating system, integrated software, amy programs installed on the harchware, and/or
documentation, delivered 1o U.S. Government end users are "commercial computer software" pursuant to the applicable Federal Acquisition Regulation and
agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system,
integrated software, any programs installed on the hardware, and/or documentation, shall be subject 1o license terms and license restrictions applicable to the
programs. Mo other rights are granted to the U5 Cowernment,

This software or hardware is developed for general use in & variety of information management applications. It is not deweloped or intended for use in any
inherently dangerous applications, including applications that may create a risk of personal injury. If wou use this software or hardware in dangerous applications,
then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates
disclaim any liability for any damages caused by use of this software or harcware in dangerous applications.

This software or hardware and documentation may provice access 1o or infarmation on content, products, and services from third parties. Oracle Corparation and
its affiliates are not responsible for and expressly disclaim all warranties of amy kind with respect 1o third-party content, products, and services. Oracle Corporation
and its affiliates will not be responsible for amy loss, costs, or damages incurred due 1o your access to or use of third-party content, products, or services.

ORACLE
FIVANCIAL SERVCES

) 1 acceptthe terms of the License Agresment

@) | do NOT accept the terms of the License Agreem ent

5. Select I accept the terms if the License Agreement option.
6. Click Next.

The Financial Services Behavior Detection Applications Pack details are displayed.
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Figure 4-8 Applications Pack Details

Financial Services Behavior Detection Applications Pack

Application Pack ID : OFS_BD_PACK

Preinstall Setup
KD Installation
(O Install Cormplete

ORACLE

FINANCIAL SERVICES
ANALYTICAL APPLICATIONS

Application Pack Name :  Financial Services Behavior Detection Applications Pack
Application Pack Version :  8.0.3.0.0
The following products are available in this application pack:

Financial Services Analytical Applications Infrastructure

Financial Services Inline Processing Engine
Financial Services Anti Money Laundering
Financial Services Fraud

Financial Services Fraud Enterprise Edition
Financial Services Trader Compliance
Financial Services Trade Elotter

Financial Services Personal Trading Approval

Financial Services Broker Compliance

Financial Services Energy and Commodity Trading Compliance
Financial Services Enterprise Case Management

Financial Services Know Your Customer

Financial Services Currency Transaction Reporting

Financial Services Foreign Account Tax Compliance Act Management

Financial Services Common Reporting Standard

ORACLE
FIANCIAL SERVICES

Notes:
1.Select the product(s) you have licensed and click “Next” to proceed

2. Product Analytical Applications Infrastructure does not need to be selected explicitly. This product is the base infrastructure and gets installed automatically.

3. Product Enterprise Modeling Option would get enabled / installed automatically if other productis) has dependent license

Note: Financial Services Analytical Applications Infrastructure is selected
by default.

7. Select the product to enable for which you have already obtained license.

8. Click Next. The License Agreement page is displayed.
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Figure 4-9 License Agreement page

Financial Services Behavior Detection Applications Pack License Agreement

Installation and use of Financial Services Behavior Detection Applications Pack Installer requires acceptance of the following license agreement:
OFSAA APPLICATION PACK LICEMSE AGREEMENT

|3 Preinstal Setup
[D Installation
[ Install Complete

Oracle Financial Services Anahtical Applications (OFSAL) application packs are groups of OFSAAL products packaged together into a single installer. Each application
pack contains OFSAA applications that address specific functional domains

Ewery application pack also includes the following OFSAA infrastructure application options which are automatically installed by every application pack installer:
1. Oracle Financial Services Anahtical Applications Infrastructure

2. Oracle Financial Services Enterprise Modeling

3. Oracle Financial Services In-line Processing Engine

4. Oracle Financial Services Big Data Processing
Oracle Financial Services Anahtical Applications Infrastructure (OFS AAl is the base infrastructure for all OFSAA applications and is therefore automaticalby installed
and enabled by the application pack installer,

The application pack installer always installs Oracle Financial Senvices Enterprise Modeling, Oracle Financial Services In-line Processing Engine and Oracle Financial
Services Big Data Processing application options along with the application pack applications, but enables them only if amy application that reguires their functionality
is enabled.

Ay OFSA& application that is enakled must be licensed for use. Oracle Financial Services Analytical Applications Infrastructure, Oracle Financial Services Enterprise
Modeling, Oracle Financial Services In-line Processing Engine and Oracle Financial Services Big Data Processing are individually licensable application options

Application products once enabled cannot be disabled. Application products not enabled on installation, may later be enabled using the "Manage OFSAA Product
Licenseds)" feature of the platform.

ORACLE
FIVANCIAL SERVCES

() | acceptthe terms of the License Agresment

) 1 do NOT accept the terms of the License Agreement

9. Select I accept the terms of the License Agreement option.
10. Click Next.

The Manage Information Domain page is displayed.
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= Prelnstall Setup
(D Installation
(D) Install Complete

ORACLE
FIVANCIAL SERVCES

Figure 4-10 Manage Information Domain page

Please review the following before continuing:

Pre Installation Summary

Application Pack ID
OFS_BD_PACK

Application Pack Name
Financial Services Behavior Detection Applications Pack

Application Pack Version
8.0.3.0.0

Below products are selected to be enabled:

Financial Services Analytical Applications Infrastructure
Financial Services Inline Processing Engine

Financial Services Anti Money Laundering

Financial Services Fraud

Financial Services Fraud Enterprise Edition

Financial Services Trader Compliance

Financial Services Trade Blotter

Financial Services Personal Trading Approval

Financial Services Broker Compliance

Financial Services Energy and Coemmodity Trading Cempliance

Financial Services Enterprise Caze Managemsnt
Financial Services Know Your Custormer
Financial Services Currency Transaction Reporting

Financial Services Foreign Account Tax Compliance Act Managemsnt

Financial Services Commen Reporting Standard

PBrewious MNext

Note: Refer to Table 4-3 and provide appropriate values in the screen. All fields are mandatory.
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11. Edit the Information Domain Name if it is a new Information domain or if you want to
change the name of the information domain name.

Note: In case of subsequent Applications Pack installation on the same
Information Domain, you cannot edit the name Permissible length is 16
characters and only alphanumeric characters allowed. No special characters

allowed.
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Figure 4-11 Pre-Panel Template

Pre-Pack Panel Template

Enter Base Country
&) Prelnstall Setup
(2 Installation

() Install Complete

Enter Default Jurisidiction

Enter SMTF Host
7596

Enter Adrmin Tools Cantext
atonls

Belect Partition Date Format
DD-M OR-7Y

Configure OBIEE server URL{Select 1 for YesfO for Mo} .

Enter OBIEE Server UrliEx: <protocol>:f/ <ipaddress>: <port>)

Gelect MLS_LENGTH_SEMANTICS
ENTE

Select Week End Holiday Pattern
Baturday; Sunday

Enter Current Business Day OR Initial Business Day For Data To Load(n dd/mm format, Ex. 10 /12 /2004
ty ry in dd/mmfyyy f1zy ) 10/12/2009

Enter Date OF Saturday After Friday OF Current Business Week OR Initial Business Week For Data To Be Loacecin ddfrmrm sy
armnat, Ex. 19/ 12/2003)

Enter Date of Mext Business Month (in ddfmm fyasy Tormat, Ex. 017012010}

19122009

0170172010

Enter the Analyst Data source name
anaalyst

Enter the Miner Data source name )
minner

Enter the User Id for Services
st

Enter the Password for Servces

ORACLE
FIANCIAL SERVICES

Install re

12. Click Next. The License Agreement window is displayed.

Figure 4-12 License Agreement Window

License Agreament

=¥ License
() Prelnstall Setup
() Installation..

() Install Camplete

ORACLE’
FINANCIAL SERVICES

Installdy I

Welcome to the OF5AAI Installation

This program will guide vou through the installation
of OF5AA Infrastructure,

Copyright © 1993, 2015, Cracle and J orits
affiliates, All rights reserved.

This software and related documentation are
provided under a license agreement containing
restrictions on use and disclosure and are protected
by intellectual property laws, Except as expressly
permittad in wour license agreement or allowed by
law, you may not use, copy, reproduce, translate,
broadeast, moedify, license, transmit, distribute,

@ | accept the terms of the Licenze Agreement

D | do MOT accept the terms of the License Agreement

Previous
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13. Select I accept the terms of the License Agreement option.

14. Click Next. The License Details page is displayed.

Figure 4-13 License Details Page

License Details

Product Name:
Installation OFSAAInfrastructure

Install Complete

Version
8.0.3.0.0

Operating System
Linux

Relational Database
Oracle

Licensed Locale

ORACLE’ en_US
FINANCIAL SERVICES

Installamywhere

15. Click Next. The User Installation Directory window is displayed.

Figure 4-14 User Installation Directory

User Installation Directory

o License User Installation Directory
S Preinstall Setup fscratchjofsaadbf OFS A4

() Installation..
(L) Install Complete

ORACLE
FINANCIAL SERVICES

Note: The User Installation Directory path is auto-populated from the path
you have set in the user .profile file in step 2.
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16. Click Next. The OFSAA Infrastructure Server Details window is displayed.
Figure 4-15 OFSAA Infrastructure Server Details

OF5AA Infrastructurea Server Details

) Licensze Enter requested infarmation
=¥ Prelnstall Setup

SR Mate: If the JDBC_URL is of RAC tyioe then DB Server [P/fHosthame
; field name should be Ma
() Install Completa

OFSAAl Server IP / Hosthame :

Database Server IP / Hosthame :

ORACLE’
FINANCIAL SERVICES

Previous

17. Enter the IP address or hostname of the OFSAAI server and Database server.

18. Click Next. The Web Application Server window is displayed.
Figure 4-16 Web Application Server

Web Application Server

f) License Choose the Web Application Server type
=¥ Prelnstall Setup

() Installation..
() Install Camplete

0 Tomcat
® [WebSphere
) Wehlogic

ORACLE’
FINANCIAL SERVICES

BIE

19. Select the appropriate Web Application server type. The options are Tomcat, WebSphere,
and WebLogic.

20. Click Next. Based on the selection, corresponding screens are displayed.
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For WebSphere: The WebSphere Setup Details window is displayed.

Figure 4-17 WebSphere Setup Details

WebSphere Setup Details

# License Enter WehSphere installation Path up to the Hast name directaory
=¥ Prelnstall Setup Far Ex:- jdataz ftestf webhSpherefappserverfarofiles)f < Profile_Ma
G |neraliation.. me = finstalledappsf <cellMame >

() Install Complete

,fscratchjwas?,leM;WEbSphere,prpServer,fprufiles;Prufsa?B3|

ORACLE’
FINANCIAL SERVICES

21. Enter the installation path (up to the host name directory) of the WebSphere. The format is
WebSphere path <WebSphere profile
directory>/installedApps/<NodeCellName>.

For Tomcat: The Absolute Tomcat Path window is displayed.

Figure 4-18 Absolute Tomcat Path

Absolute Tomcat Path

d) License Enter absolute Tomeat Installation path where Oracle Financial
=¥ Prelnstall Setup Senvices Anakgical Applications Infrastructure is 1o be deploved.
) Installation.. Example - fhomejfdatal/tomcat-7.0. 19 webapps

Install Caomplete

ORACLE
FINANCIAL SERVICES

Ins Wi
Cancel Help Prewious
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22. Enter the Tomcat installation path (till/webapps) where OFSAAI will be deployed.
For WebLogic: The Weblogic Home window is displayed.

Figure 4-19 Weblogic Home

Weblogic Home

Enter Weblogic Home
=¥ Prelnstall Setup For Ex: fhome/weblogic/beajweblogic 10.3.5.0

(2 Installation

Install Complete

ORACLE"
FINANCIAL SERVICES

Installanywhere

T T

23. Enter the WebLogic home directory path.

Figure 4-20 Weblogic Setup Details

Weblogic Setup Details

d License Enter Weblogic Domain Home
53 Prelnstall Setup For Ex: Jfhomefweblogicflheajuser_projectsfdomainsfrmydomain

Installation..
() Install Complete

ORACLE’
FINANCIAL SERVICES

Installamawher

8
Cancel Help Prewious

24. Enter the path of the Weblogic domain home directory and click Next. The OLAP Details
window is displayed.
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Figure 4-21 OLAP Details

OLAP Daeatails

d Licenze Mote :

=¥ Prelnstall Setup 1 = Enabled 0 =Disabled
If walue is 1 then ARBOREPATH, HYPERION_HOME & ESSBASERPATH

Instalfation.. wariahles should be set in . profile before installation.
(L) Install Complete

CONFIGURE OFS5AAI OLAP FEATURE :
0

ORACLE’
FINANCIAL SERVICES

Installamawhere

25. OFSAAI OLAP feature should be set to 0.

26. Click Next. The Web Server Details window is displayed.
Figure 4-22 Web Server Details

Web Server Details

b License Mate © Context narne will be used in your Application URL
=¥ Prelnstall Setup http: ff<webServerlP = <5erdet port = f<contextname = flogin. jsp
G [r=taiiion Example: - http: ff 10,8050, 206 3080 frmyapp flogin. jsp

1stall ]
() Install Complete [ ] ENABLE HTTPS

WEE SERVER PORT
| 9061

WEE APP SERVER IP
| 11.12.13.14

Context name for deployment
| Profsar33

ORACLE’

WEE LOCAL PATH
FRIANCIAL SERVIGES |,rscrat:nmnspnerempsnare

Installanyanber

27. Select Enable HTTPS checkbox to configure HTTPS, if required, and enter the Web
Server (HTTP Server) Port, Context name for deployment, and Local path to any folder on
the Web Application Server (Tomcat/Websphere/Weblogic).

28. Click Next. The Database Details window is displayed.
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Figure 4-23 Database Details

Database Details

@ License MOTE:

=¥ Prelnstall Setup Specify the Database user name which is the user created for
s configuration database schema. For example: configuser

sl ” Specify the Database driver path as < ORACLE_HOME fjdbcflib
Install Complete where <ORACLE_ HOME> should be replaced with ORAZLE HOME
walue.

The ABSQLUTE DRIVER. PATH refers to the |DEC driver files path.

ORACLE SID / SERVICE_NAME :
| OFSQADE

JDEC URL:

| jdhcaracle:thin @ 11.12.13.14.1516: 0F5 QA0E

CONFIG SCHEMA USER ID :
| DOCT23CONF

Oracle Configuration Schema Password

ORACLE’
FINANCIAL SERVICES

ABSOLUTE DRIVER PATH :
|,fscratchjnraclE,fapp,fnracle,fprnduct,fll.2.0ft|ient_ljjdbu:,flib |

FEestore Default H Choose. .. |
: :

29. Enter Oracle SID/Service Name.

Note:

p The JDBC URL, Configuration Schema User ID, Oracle Configuration Schema
Password, and Absolute Driver Path are auto-populated.

> Absolute Driver Path can be the path where Oracle DB client is installed or
JDBC driver is installed. For example,
/scratch/oracle/app/oracle/product/11.2.0/client
1/jdbc/1ib

30. Click Next. The Ports Configuration window is displayed.

Installing OFS BD Pack 4-47



Installing the OFS BD Applications Pack

Figure 4-24 Ports Configuration

Ports Configuration

) License Enter required infarmation :
-

=¥ Prelnstall Setup Mote: Ports must have unigue value.

() Installation..

() Install Complete Java Port
| 9933

Mative Port
66585

Agent Port
6510

ICC Server Port

ORACLE 6507

FINANCIAL SERVICES |ICC Native Port
5509

Previous

Note: The Port, Native Port, Agent Port, ICC Server Port, and ICC
Native Ports are auto-populated. You can also configure the Ports
settings.:

31. Click Next. The Ports Configuration window is displayed.

Figure 4-25 Ports Configuration

Ports Configuration

License Enter required information :
o

=¥ Prelnstall Setup Mote: Ports must have unigue value.

() Installation..
() Install Complete Java Port
| 9933

Mative Port
66585

Agent Port
6510

ICC Server Port

ORACLE 6507

FINANCIAL SERVICES |ICC Native Port
5509

Previous
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Note: The OLAP Port, Message Server Port, Router Port, and AM Port
details are auto-populated. You can also configure the Ports settings.

32. Click Next. The Default Infrastructure Administrator and Authorizer User Password
window is displayed.

Figure 4-26 Default Infrastructure Administrator and Authorizer User Password

Default Infrastructure Administrator and Authorizer User Password

f) License Enter requested information
=¥ Prelnstall setup

() Installation.. Please enter password for default Infrastructure
administrator user SYSADMN :

Install Complete

Please re-enter password for default Infrastructure
administrator user SYSADMMN :

Please enter password for default Infrastructure authorizer
user SYSAUTH :

ORACLE Please re-enter password for default Infrastructure
authorizer user SYSAUTH :

FINANCIAL SERVICES

Install Anat

33. Enter the passwords for default System Administrator and System Authorizer users.

34. Click Next. The SFTP Details window is displayed.
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Figure 4-27 SFTP Details

& License
o

Installatian.
(L) Install Completa

ORACLE’

=3 Prelnstall Setup For enable SFTP : If value is 1 then SFTP will be enabled . If value is

SFTP Details

Mate

O then FTP will be enabled

ENABLE SFTP
[1

FILE TRANSFER PORT :
[22

FINANCIAL SERVICES

Installamavhere

Note:

»  Enable SFTP and File Transfer Port details are auto-populated.

»  Ensure that the system, on which the OFSAA Infrastructure is being installed,
has either FTP/SFTP enabled.

35. Click Next. The OFSAAI Post Install Details window is displayed.

36. Enter the FTPSHARE Path. This is same as the OFSAA Staging/ Metadata Repository

Directory.

37. Enter the FTP/SFTP User ID and Password for FTPSHARE Directory access.

Note: The transfer of data (files) between the OFSAAI Server and the Web
Application Server happens over FTP/SFTP. Ensure the necessary host
configurations are made for a successful handshake.

38. Click Next. The Pre Installation Summary window is displayed.
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Figure 4-28 Pre Installation Summary

Pre-installation Summary

o) License Please review the following before continuing:

2 Prelnstall Setup
() Installatian, Product Name:

B OFSAAInfrastructurs
[} Install Complete

Yersion
8.0.3.00

Installation Folder
feeratchfofsaadb,/ OF5AAI

Required Space
930 MeagaBytes

ORACLE Availahle Space
57843 MegaBytes
FINAMCIAL SERVICES

Selarted L arale

39. Click Install. The Installing OFSAA Infrastructure window is displayed.

Figure 4-29 Installing OFSAA Infrastructure

Installing OFSAAInfrastructure

) License

¥ Freinstall Setup
& nstallation.,

(O Install Complete

&

ORACLE Installation is in progress...

This process may take several minutes. Please Wail.
FINANCIAL SERVICES

Installing... Execute Script/Batch file: AdminConf

Install&mawhere

Cancel

Anytime during the installation you can click Cancel to stop the installation. Once
completed, the Installation Summary window is displayed.
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Figure 4-30 Installation Summary

INSTALLATION SUMMARY

[IMST ALLATION SUMMARY:

o Prelnstall Setup
@ Installation. . -0
=¥ Install Complete #OEBUG STATEMENTS. 666

HNFORMATIONS == === 283
HWARNINGS ¥

Please see the installation log under

fscratchfofsaaapp/OFs_AAAl PACK/OFS_adlflogs fOFSAAIE log and
Jscratchfofsaaapp/AAAIPACK fOFSAAINTrastructure_Install.log for
rmore details.

Click on Mext to continue,

ORACLE
FINANCIAL SERVICES

The Summary window displays the number of Fatal Errors, Errors, Debug Statements,
Informations, and Warnings along with the location of log files.

40. Click Next. The Installation Complete window is displayed.

Figure 4-31 Installation Complete

Installation Complete

d License Congratulations! Oracle Financial Services Anahtical Applications
@ Preinstall Setup Infrastructure has been successfully installed.

W Installation.. Click on "Done” to exit the installer. Please do not close the
= Install Complete consaole, Post Install activites will be performed in console.,

ORACLE
FINANCIAL SERVICES

Installanmywhere

Note: If the installation is successful with some warnings, you can navigate
to the installation log for more details and address them.

41. Click Done. The following message is displayed: Please wait, pack install is being
configured for your system. This may take a moment.
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Figure 4-32 Checking OFSAAI Services

Please Wait

& Preinstall Setup
kD Installation.
O install complete

Please w s Checking OFSAA Sence... ur system. This may take 2 moment..

EESSRSSRRRwWY

ORACLE
FIANCIL SERUCES

In

Figure 4-33 Installation Complete

@ Preinstall Setup Click on "Dane” ta exit the installer. Please do not close the console. Past Install actiites will be perfarmed in cansole

& Install Complete

ORACLE
FIVANCIAL SERVICES

o]
42. Click Done.

Note: The installation process continues on the console. Do not close the
console until the installation process is complete.

43. Perform steps mentioned in the Post Installation Configuration section.
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Verifying Installation

»  Verify the Pack_install.log file in the folder: /OFS_BD PACK/logs
»  Verify the OFSAA logs under /OFS_BD PACK/OFS_AAI/logs

»  Verify the BD_log files located in the folder: /OFS_BD PACK/OFS_BD/logs for OFS BD
Applications Pack Installation log file.

Note: If there are any errors, do not proceed with further installation and
contact Oracle Support.

Note: If BD and FSDF are in different Infodom, follow these steps:

1. Run the following scripts in FSDF schema present in the path <download
dir>/OFS_BD PACK/OFS_BD: FSDFAlterTimezone.sql

2. Run the following script in BD schema after replacing placeholder ##FSDF
USER## with FSDF User name:
INGESTUSERSYNONYMFORFSDFSTGSCHEMAOWNER. sql .

3.  Run the following script in FSDF schema after replacing placeholder #DATA
LOADER## with Data Loader Role: Fsdf StgSchemaOwnergrant . sql
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Post Installation Configuration

On successful installation of the Oracle Financial Services Behavior Detection Applications
Pack, refer the following post installation sections:

This chapter includes the following sections:

> Creating and Deploying the Applications Pack Web Archive
> Installing Scenario Manager

> Deploying Analytic Reports and Threshold Analyzer

> Configuring Resource Reference

> Configuring Web Application Server

> Configurations for Java 8

Note: Ensure to clear the application cache prior to the deployment of Applications
Pack Web Archive. This is applicable to all Web Servers (WebSphere, WebLogic, and
Tomcat). For more information, refer to the Clearing Application Cache section.

Creating and Deploying the Applications Pack Web Archive
> OFSBD Applications Pack Deployment
> Admin Tools Deployment
> Scenario Wizard Configuration and Deployment

Services Configuration and Deployment

OFSBD Applications Pack Deployment

To create and deploy the Applications Pack web archive, follow these steps:
1. Navigate to the $FIC_WEB_HOME directory.
2. Execute the command:

./ant.sh

3. This will trigger the creation of EAR/WAR file - <contextname>.<extn>. Here
<contextname> is the context name given during installation.

Note: Creating ear/war files are done by the installer automatically. If the
files are not created, user can execute these steps.
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4. On completion of the EAR/WAR files creation, the "BUILD SUCCESSFUL" and "Time
Taken" message is displayed and you are returned to the prompt.

5. The EAR/WAR file - <contextname>.<extn> - is created under "SFIC_WEB HOME"
directory.

Note: This process overwrites any existing version of EAR/WAR file in the path. If
the web application server is Apache Tomecat, the file created would be
<contextname>.war.

6. Deploy the generated EAR/WAR file on to the web application server. For detailed
information, refer Deploying EAR/WAR File.

Admin Tools Deployment

The following deployment steps must be performed if installed applications are
AML/FR/TC/BC/ECTC/Fraud-EE/TB.

To deploy Admin Tools, follow these steps:

1. Create two data sources, one each for Analyst and Miner. The name of these data sources
should match with the ones entered during the installation.

2. Goto $FIC HOME/ficweb/AM installed directory and run the script file . /ant.sh

3. Deploy the <admin tool context-name>.war (for example, admin_tools.war)
available at $FIC_HOME/AM directory, as an application on your Web Application
Server.

Note:

»  While deploying war file, keep same context name as updated against variable
ADMIN CONTEXT NAME in InstallConfig.xml File located at <download
dir>/ OFS_BD_ PACK/OFS_BD/conf.

> Refer to Post Deployment Configuration for more details.

4. Following are the additional configurations for Tomcat 8 and above:
maxTotal="100"
maxIdle="30"

maxWaitMillis="10000"/>

Scenario Wizard Configuration and Deployment

The Scenario Wizard Configuration and Deployment must be performed if the following
applications are installed

» AML

»  FR

> Trade Compliance
> Broker Compliance

»  Fraud-EE
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2

2

ECTC
TB

To configure and deploy Scenario Wizard, follow these steps:

1.
2.

P @ N

Navigate to SFIC_HOME/ficweb/SCENARIO WIZARD

Execute . /install.sh. When prompted for password, enter the KDD MNR Schema
password.

Deploy the <context-name>.war file (for example SMLiteWeb.war) available at SFIC
HOME/ficweb/SCENARIO WIZARD as an application on your Web Application Server.
While deploying war file, keep context name as SMLiteWeb.

Note Only one instance of Scenario Wizard will run on one Application
server at a time. While launching the Scenario Wizard if you find any excep-
tion pop-up saying java.rmi.bind exception or java.rmi.unknownhost excep-
tion, follow these steps:

1. Stop the SMLiteWeb.war

2. Navigate to <deployed area>SMLiteWeb\WEB-INF\classes\conf\mantas
cfg\install.cfg

In install.cfg change the token to some other port which is not occupied.
4. Define rmiPort. By default keep it 1099
rmiPort=1099

5. Restart the server.

Log Details.
a. Log file name- smlite.log

b. Log path - Navigate to <deployed
area>SMLiteWeb\WEB-INF\classes\logs\smlite.log

To customize the Log path/log file name, follow the following steps
a. Goto <deployed area>\SMLiteWeb\WEB-INF\classes\log4j.properties file
b. Change the value of the property log4j.appender.file.File="Your log file path"

c. Restart the SMLiteWeb.war

To configure and deploy Scenario Wizard on Websphere, follow these steps:
Ensure that port 1099 is free and available.
Deploy the SMLiteWeb.war
Change the class loader.

Navigate to Applications > Application Types > WebSphere enterprise applications >
SMLiteWeb.war > Manage Modules.

Click on Module Apache-Axis and select Class loaded with local class loader first
(parent last) under Class loader order.

Click Apply and then Save.

Start the application. If the application is not accessible, stop and start the application again
from the Websphere console.
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Note: Refer to Post Deployment Configuration for more details.

1. For Front-end access, the following settings must be changed on the client side
for the Scenario Wizard to work on Windows XP/Windows 7.

a. Navigate to Java Control Panel.

b. Under the General tab ensure the following two
settings:

c. Navigate to Network Settings and change the
Network Proxy Settings to Direct Connection.

d. Navigate to Settings under Temporary Internet
Files and perform the following steps:

e. Check the option to keep temporary files on my
computer.

5. Click Delete Files to clear the Java cache.

To configure Scenario Wizard on Tomcat 8 and above before deploying the war file, follow
these steps:

1. Remove the following text from context .xml at <deployed area>/conf/:
AbandonedOnBorrow="true"
AbandonedOnMaintenance="true"
AbandonedTimeout="60"
logAbandoned="true"/>
2. Replace with the following text:
maxTotal="100"
maxIdle="30"
maxWaitMillis="10000"/>
3. All resources have been moved to Context .xml from server.xml.
4. Change the following text:
<Context path =
/admin_tools" docBase="<deployed area>/webapps
admin tools" debug="0" reloadable="true"
crossContext="true">
to

<Context>

Services Configuration and Deployment
You must configure and deploy Services if the following applications are installed:
»  AML
»  FR

> Trader Compliance
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2

2

Broker Compliance
ECTC

Fraud-EE

TB

KYC

Note: Either Watchlist Services or Post Alert Services can be run, but not both simultaneously, as these services
both use the variable FIC_HOME.
JDK is required for creation of Watchlist WAR and can be removed once services deployment is successful.

Watchlist Deployment Service

To configure and deploy Services, follow these steps:

1.

Create the WAR file by changing to the FIC HOME/ingestion manager/scripts
directory and and executing createWatchListWAR. sh. This will create the
mantas.war file which contains the watch list service.

Deploy the mantas . war file to the web application server. Any context path can be used,
but the KYC application expects it to be at /mantas. The full path leading to the exploded
WAR file will be referred to as <Service Deployed Directory> below.

Modify the following file: <Service Deployed Directory>/WEB-INF/fuzzy
match/mantas cfg/install.cfg and change the path in the fuzzy
name.B.stopword file and fuzzy name.P.stopword file properties from: <FIC
HOME>/ingestion manager to: <Service Deployed Directorys/WEB-INF

Modify the following file: <Service Deployed
Directory>/WEB-INF/config/install.cfg and change the Creating and Deploying
the Applications Pack Web Archive Post Installation Configuration path in the
log.message.library,log.categories.file.path, and log4j.config.file
properties as specified in step3.

Modify the /u01/app/oracle/product/wlsl2c/user projects/domains/ofsaa_
domain/bin/setDomainEnv.sh

WL HOME="/u01/app/oracle/product/wlsl2c/wlserver":
## OFSA CUSTOM CONFIGURATION START

FIC HOME=/u0l/app/oracle/product/wlsl2c/user projects/domains/ofsaa
domain/app

lications/mantas.war

ORACLE HOME=/u01l/app/oracle/product/12.1.0/dbhome 1
export FIC HOME ORACLE HOME

KDD_PRODUCT HOME=${FIC HOME}/WEB-INF/fuzzy match
export KDD PRODUCT HOME

JAVA LIB HOME=${KDD PRODUCT HOME}/lib/kddcore.jar:${KDD_ PRODUCT
HOME}/1ib/log4

j-1.2.12.jar
export JAVA LIB HOME

LD LIBRARY PATH=${KDD PRODUCT HOME}/1lib:${ORACLE HOME}/1lib:${LD
LIBRARY PATH}
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export LD LIBRARY PATH

SERVICES ROOT=/u01/app/oracle/product/wlsl2c/user
projects/domains/ofsaa_domai

n/applications/mantasServ.war/solution/services
export TNS ADMIN=SORACLE HOME/network/admin
MINHEAP=32m

export LD LIBRARY PATH=$SERVICES ROOT/lib:$ORACLE HOME/lib:$LD LIBRARY
PATH

PLATFORM="uname -i°

if [ "SPLATFORM" = "x86 64" ]; then
MAXHEAP=10000m

else
MAXHEAP=1800m

fi

export MINHEAP MAXHEAP

export KDD_ PRODUCT HOME=$SERVICES ROOT

export KDD HOME=$SERVICES ROOT

## OFSA CUSTOM CONFIGURATION END

For Tomcat, this file is <Tomcat Directorys>/bin/setenv.sh.
For WebLogic, this file is <WebLogic
Directory>/user projects/domains/<user domains/bin/setDomainEnv.sh.

6. Modify the script from step5, replacing <Service Deployed Directorys and <Oracle
Home> with their respective values.

7. Restart the web application server.
Create the Post Alert Service .war file by following the steps provided below.
To configure and deploy Services, follow these steps:

1. Create PostAlertService war
Trigger the ant.sh under the <INSTALLED AREA>/services/ to create mantasServ.war.

Add -Doracle.jdbc.autoCommitSpecCompliant=false in the web server
profile to pass as a JVM argument

For Tomcat:
2. Deploy the mantasServ.war.

3. Restart the weblogic server and install the mantasServ.war application.
Replace the Path for "kdd.xml.catalog" and "log.mantaslog.location" in the install.cfg file
located under <Service Deployed Area>/solution/services/mantas cfg.

» kdd.xml.catalog=<Service Deployed
Area>/solution/services/share/xml/catalog.xml

» log.mantaslog.location=<Service Deployed
Area/solution/services/logs
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Create file setenv.sh under <TOMCAT INSTALLED AREA>/bin/ and copy the below
contents after replacing the place holders (<Service Deployed Areas>, <Oracle Home>
and <TNS_Admin Home>) and save.

SERVICES ROOT=<Service Deployed Area>/solution/services
export TNS ADMIN=<TNS Admin Home>

export ORACLE HOME=<Oracle Home>

export FIC HOME=<Service Deployed Area>

MINHEAP=32m

export LD LIBRARY PATH=$SERVICES ROOT/lib:$ORACLE HOME/lib:$LD LIBRARY
PATH

PLATFORM="uname -i°

if [ "SPLATFORM" = "x86 64" ]; then
MAXHEAP=10000m

else

MAXHEAP=1800m

fi

export MINHEAP MAXHEAP

export KDD_ PRODUCT HOME=$SERVICES ROOT
export KDD HOME=$SERVICES ROOT

Restart the tomcat server.

For Weblogic:
Explode the mantasServ.war under the desired weblogic Domain.

Restart the weblogic server and install the mantasServ.war application.
Replace the Path for "kdd.xml.catalog" and "log.mantaslog.location" in the install.cfg file
located under <Service Deployed Area>/solution/services/mantas cfg.

»  kdd.xml.catalog=<Service Deployed
Area>/solution/services/share/xml/catalog.xml

»  log.mantaslog.location=<Service Deployed
Area/solution/services/logs

Copy the below contents into the setDomainEnv.sh located under SWL_HOME/user
projects/domains/<user domain>/bin/setDomainEnv.sh after replacing the place
holders (<Service Deployed Area>, <Oracle Home> and <TNS Admin Homes).

SERVICES ROOT=<Service Deployed Area>/solution/services
export TNS ADMIN=<TNS Admin Home>

export ORACLE HOME=<Oracle Home>

export FIC HOME=<Service Deployed Area>

MINHEAP=32m

export LD LIBRARY PATH=$SERVICES ROOT/lib:$ORACLE HOME/lib:$LD LIBRARY
PATH
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PLATFORM="uname -i°

if [ "SPLATFORM" = "x86 64" ]; then
MAXHEAP=10000m

else

MAXHEAP=1800m

fi

export MINHEAP MAXHEAP

export KDD_ PRODUCT HOME=$SERVICES ROOT

export KDD HOME=$SERVICES ROOT

4. Restart the weblogic server and install the mantasServ.war application.

For Websphere:
1. Deploy mantasServ.war in the websphere server. Do not start the mantasServ application.

2. Inthe IBM console, navigate to Enterprise Applications > mantasServ_war > Manage
modules > mantasServ.war. Set the Class Loader Order to "Classes loaded with local class
loader first (parent last)"

3. Replace the Path for "kdd.xml.catalog" and "log.mantaslog.location" in the install.cfg file
located under <Service Deployed Areas>/solution/services/mantas cfg.

»  kdd.xml.catalog=<Service Deployed
Area>/solution/services/share/xml/catalog.xml

» log.mantaslog.location=<Service Deployed Area>/solution/services/logs

4. Copy the following contents into the .profile file (create a .profile file if it is not already
existing) of the user after replacing the place holders (<Service Deployed Areas, <TNS
Admin Home> and <Oracle Home>).

SERVICES ROOT=<Service Deployed Area>/solution/services
export TNS ADMIN=<TNS Admin Home>

export ORACLE_HOME=<Oracle Home>

export FIC HOME=<Service Deployed Area>

MINHEAP=32m

export LD LIBRARY PATH=$SERVICES ROOT/lib:$ORACLE HOME/lib:$LD LIBRARY
PATH

PLATFORM="uname -i°

MAXHEAP=10000m

export MINHEAP MAXHEAP

export KDD PRODUCT HOME=$SERVICES ROOT
export KDD HOME=$SERVICES ROOT

5. Shutdown the Websphere server and exit the putty.

6. Execute the .profile.
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7. Start the Websphere server.

8. Start the mantasServ application (if not started automatically).

To access the Post Alert Service, please use the URL:
<protocol>://<Server>:<port>/mantasServ/services/AlertManagementService

Installing Scenario Manager

This section provides the general steps to install the OFS BD Scenario Manager software, along
with a reference to the specific section and page where the tasks are explained.

Installing the Scenario Manager involves the following procedures:
> Verifying the Pre-installation Requirements

> Installing the Scenario Manager on the Workstation

> Cancelling the Scenario Manager Installation Program

> Accessing the Scenario Manager

> Configuring JAVA HOME and JDBC URL

Verifying the Pre-installation Requirements

Before you install the OFSBD Scenario Manager on the Windows workstation, verify the
following information:

> Verifying Prerequisite Third-Party Software Installation

> Verifying Values for the Scenario Manager Installation Program

Note: Install and configure OFS BD application completely before you
install the Scenario Manager software.

Verifying Prerequisite Third-Party Software Installation

Before installing the OFS BD Scenario Manager, verify that the third-party software defined in
Table 5-1 is installed and configured on the workstation.

OFS BD application supports the third-party software identified in following table.

Table 5-1 Prerequisite Third-Party Software Products for the Scenario Manager

Workstation
Component Product Version Vendor
Operating System Windows XP, Vista Microsoft
Java JRE, Standard Edition with 1.7 Sun
HotSpot

Verifying Values for the Scenario Manager Installation Program

To prepare for the OFS BD Scenario Manager installation program’s requests for information,
use the pre-installation checklist in Table 5-2 to verify the database connection information, as
well as user and owner names you must provide to the Scenario Manager Installation Program.
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Table 5-2 Scenario Manager Pre-installation Checklist

Item Description Example Value Your Value
OFS BD Installation Directory on the workstation | C:\Oracle Scenario Microsoft
Directory where you want to install the | Manager
Scenario Manager.
Database Client Oracle Client 11g Release 2 N/A N/A
(11.2.0.3.0+) - 64 bit
Oracle Client 12¢ Release 1
(12.1.0.1.0+) - 64 bit
Service Name/ SID Service Name/ SID for the ORA_PROD Sun

instance. This is often the
same as the database name.

KDD Schema Database
Owner

KDD Schema Database
owner's name.

Value for kdd
schema_owner

Alert Management
Schema Database
Owner Name

Mantas Schema Database
owner's name.

Value for mantas
schema_owner

Database server name

Name of the server that the
database resides on.

prod_server

KDD Miner User Name

KDD Miner user's name.

Value for tools_user

JRE Home

Directory name of your JRE
1.7 server installation

C:\apps\jrel.7

Maximum Java Virtual
Machine Memory

UsageMaximum amount of
Java Virtual Machine (JVM)
memory available for the
Scenario Manager.

64

Program Group Name

Name of the Windows
Program Group where you
want to install the Scenario
Manager.

Financial Crime and
Compliance
Management
Scenario Manager

Note:

for example, C:\Program Files\JRE 1.7.

Any path that includes spaces should be entered with double quotes,

Installing the Scenario Manager on the Workstation

The OFS BD Scenario Manager Installation program installs the Scenario Manager using a
series of screens that prompt you for the information relevant to local installation and interface

with the other subsystems of OFS BD application.

The following procedures group the installation program into high-level categories:

?

Starting the Installation

Completing the Pre-installation Questions

Completing the Database Information

Completing the Environment Information

Completing the Installation
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Note: You can cancel the installation from any screen in the installation
program. Refer to Cancelling the Scenario Manager Installation Program, for
more information.

Starting the Installation
To start the OFS BD Scenario Manager installation, follow these steps:

1.

Copy the ScenarioManager.exe file from OFS_ BD PACK/OFS BD/bin to the windows
machine.

Locate file through Windows Explorer and double-click the ScenarioManager.exe file. The
Scenario Manager Installation program opens and displays the Introductory screen.

Proceed to the Completing the Pre-installation Questions.

Completing the Pre-installation Questions
To complete the pre-installation questions, follow these steps:

1.

From the Introductory screen, select the desired language from the Language drop-down
list.

Note: The OFS BD Installation Program executes in the selected language.
The default language is English.
Click OK.

The Introduction screen is displayed.

Note: This screen serves as a reminder that you must have the appropriate
version of Windows installed prior to the execution of the Scenario Manager
Installation program.

Click Next.

The OFS BD Scenario Manager Installation Directory screen displays.

Do one of the following:

a. Click Next to accept the default destination for OFS BD software installation.

The Database Type screen displays. Proceed to the Completing the Database
Information.

b. Click Choose to select an installation directory different from the displayed default
location, and select the directory to which you want to install the Scenario Manager.

Click Next.

a. If'you do not have write permission to the chosen installation folder, an installation
error message displays.

Click OK. You return to the OFS BD Scenario Manager Installation Directory screen
and do one of the following:

a.  Give the path of different installation directory which have write permission.
b.  Give the write permission to the given installation directory.

b. If you have write permission to the selected directory, the Database Type screen
displays.
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6.

Proceed to the Completing the Database Information.

Completing the Database Information

To complete the database information, follow these steps:

1.
2.
3.

5.

Click Oracle in the Database Type screen.
Click Next.

Enter the Oracle database connection string for OFS BD application in the text box of the
Oracle Database Connection String screen.

Click Next.

Then enter the Name of Server that Oracle Database Resides On screen displays.

Note: By default, Scenario Manager installer assumes the default database
port as 1521. This port can be changed by editing install.cfg file under
the path: <Scenario Manager Installer
Directory>\behavior detection\toolkit\mantas cfg

Type the following in their respective text boxes:

Table 5-3 Prerequisite Third-Party Software Products for the Scenario Manager

Workstation
Component ProductVersion Vendor <enter user name for (kdd schema owner)>
The Firm Schema database owner's name. <enter user name for (mantas_schema_owner)>
The KDD Miner user's name. <enter user name for (tools_user)>

Note: Refer to the file OFS BD SCHEMA OUTPUT.XML located at
<OFS BD Installed Directory>/schema_creator folder for schema names
written against the variables provided in brackets of respective schema.
Click Next.
The Java Runtime Environment Home screen displays.

Proceed to Completing the Environment Information, procedure.

Completing the Environment Information
To complete the user information, follow these steps:

1.

From the Java Runtime Environment home screen, type the home directory of your JRE
installation in the text box, or click Choose to browse for the home directory.

Click Next.
The Maximum Java Virtual Machine Memory Usage screen displays.

Select the option that represents the maximum JVM memory available for use by the
Scenario Manager.

Click Next.
The Program Group Name screen displays.

Type the Program Name: the name of the Windows Program Group where you want to
install the Scenario Manager.
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6. Click Next.
The Pre-installation Summary screen displays.

Proceed to Completing the Installation.

Completing the Installation

To complete the installation, follow these steps:
1. Click Install in the Pre-installation Summary screen.
The Installing screen displays; the Installation Complete screen follows.

2. Click Done to complete the installation of the Scenario Manager.

Cancelling the Scenario Manager Installation Program

You can cancel the installation of Scenario Manager at any time from any screen in the
OFSBDP installation program. However, canceling the installation program results in partial
installation of the OFSBDP components, depending on when you cancel the installation.

Use these conditions to help you determine when to cancel the OFSBDP Scenario Manager
installation:

> Ifyou click Cancel before or on the Installing screen, you do not leave a partial OFSBDP
installation. You can execute the installation program again as though you are installing for
the first time.

> Ifyou click Cancel during the installation of components, when the software is placed on
the workstation, a partial installation results. You must manually remove all files from the
file system in the OFSBDP installation directory chosen during installation.

To cancel the OFSBDP Scenario Manager installation, follow these steps:
1. Click Cancel.
The Cancel Installation screen displays.

2. Click Quit.

Accessing the Scenario Manager

After the installation is successfully completed you can access Scenario Manager.
To access Scenario Manager through the Windows Start menu, follow these steps:

1. Click Start, point to Programs, and then click the OFSBDP Scenario Manager menu
option.

2. Click the Scenario Manager option.
The Scenario Manager application launches and the Login dialog box displays.

3. Enter your user ID and password into the appropriate fields. This userID and password are
same as OFS BD atomic schema's userID and password.

4. Click Login.

Configuring JAVA HOME and JDBC URL
To configure JAVA HOME, follow these steps:

1.  Open the folder where the Scenario Manager is installed on the desktop and navigate to the
path:
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<INSTALLED DIRECTORY>\behavior detection\toolkit\bin
2. Set JAVA HOME as ur JRE path in the kddstart.bat file.
For example, set JAVA HOME="C:\Program Files\Java 7\jrel.7.0 65"
To update the JDBC URL,

1. Navigate to the path: <INSTALLED DIRECTORY>\behavior
detection\toolkit\mantas cfg

2. Openthe file install.cfg
3. Update the JDBC URL if the existing one is incorrect.

Deploying Analytic Reports and Threshold Analyzer

This section explains how to deploy Analytics on Oracle Business Intelligence Enterprise
Edition (OBIEE) and integrate Analytic Reports and Threshold Analyzer in the OFSECM UI.

This section includes the following topics:

> Installing OBIEE Server

> Installing OBIEE Windows Administration Client
> Disabling the Cache Feature in OBIEE Server

> Change Default Repository Password

> Configuring OBIEE Connection Pool

> Deploying OFS BD Report Analytics

> Post Installation Steps

> Accessing Reports through OFS BD Application

Installing OBIEE Server

To install the Oracle Business Intelligence Enterprise Edition (OBIEE) server, refer to Oracle®
Fusion Middleware Installation Guide for Oracle Business Intelligencellg Release 1
(11.1.1.7.1). After installation, get the Enterprise Manager URL, Username, Password, and
OBIEE installed directory from the system administrator.

Installing OBIEE Windows Administration Client

To install the OBIEE repository administration client for Windows machine, refer to Oracle®
Fusion Middleware Installation Guide for Oracle Business Intelligencellg Release 1
(11.1.1.7.1).

The OBIEE repository administration client can be downloaded from running OBIEE setup
from the following URL:

<protocol>://<OBIEE Server Name>:<OBIEE Analytics port>/analytics
From LHS menu, click Get Started and select Download BI Desktop Tools.

Disabling the Cache Feature in OBIEE Server

Login to the Enterprise Manager and perform the following steps:

1. Click Business Intelligence folder from the left hand side menu and select coreapplicaiton.
For more information, refer Figure 1.
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Click Capacity Management and then select the Performance tab.
Click Lock and Edit Configuration tab.

To disable the Cache, uncheck the Cache Enabled Option.

Click Apply and Activate Changes.

Click Restart to apply recent changes.

Change Default Repository Password

Copy OBI 8.0.rpd from SFIC HOME/OBIEE/Repository to the Windows machine where
the OBIEE Windows administration client is installed.

To change the default password for the repository follow these steps:

1.

2,

Open the Repository using the OBIEE Windows administration client from Windows
machine. From the File menu, select Open and click Offline. Browse to the Repository on
Windows machine. The Oracle BI Administration Tool - OBI_8.0.rpd windows is
displayed.

Enter default Repository password: Mantas61

To change the default password, follow these steps:

1.
2.

From File menu, choose Change Password.

Enter the new password and click OK.

Configuring OBIEE Connection Pool

To configure the Connection Pool of the repository, follow these steps:

1.

© © N o o

Open the same Repository (as in the previous step) on the Windows machine. The Oracle
BI Administration Tool - OBI_8.0.rpd windows is displayed.

Expand the D4010S10 folder in the Physical section.
Double-click Connection Pool to open the Connection Pool Properties window.

Enter the following in the Data Source Name text box of the Connection Pool Properties
window after modifying <Database Server Host Name> and <Database Name> Data
Source Name = (DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database
Server HostName>)(PORT=1521))(CONNECT DATA=(SERVER=DEDICATED)
(SERVICE_NAME=<Database Name>)))

Enter the Atomic Schema user in the User name text box.

Enter the Atomic Schema user password in the Password text box.

Click OK.

Expand the folder and test connection for any one table name by Right Click > view data.

Perform similar changes in the Connection Pools for all remaining folders in the Physical
Layer by providing the following schema details for all Connection Pools:

2 D4010S10 > Atomic Schema

> D5011S10 > Atomic Schema (refer report_user in <OFSBDP Installed
Directory>/database/db_tools/mantas_cfg/db_variables.cfg file. For more details, refer
to the Installation Guide - Stage 1).

> Fraud Analytics > Atomic Schema

> KYCI1.1DEV-179 >Atomic Schema
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10.

1.

12.

> Initial block and connection pool: both should point towards the atomic schema.
> MNTS583 > Atomic Schema

> RD > CaseMng connection pool > Atomic Schema

> RD > Security connection pool->Atomic Schema

> UIC_73 > CaseMng connection pool ->Atomic Schema

> UIC_73 > Security connection pool->Atomic Schema

> TA> Atomic Schema

> CTRBI-> Atomic Schema

> ORCL->Atomic Schema

Select Save option from the File menu. The following message is displayed: Do you want
to check global consistency?,

Click Yes. The following message is displayed: Consistency check didn’t find any errors,
warning or best practices violations.

Click OK.

Deploying OFS BD Report Analytics
To deploy Analytic Reports, follow these steps:

1.

© N o o

10.

1.

Stop Oracle Process Manager and Notification Server (OPMN) services by executing the
following command from <OBIEE Installed Directory>/instances/instancel/bin

Jopmnctl stopall

Change the value in Ngsconfig.ini file located at <FMW _
HOME>/instances/instance 1/config/OracleBIServerComponent/coreapplication_obis1/
directory

From EVALUATE SUPPORT LEVEL = 0;
To EVALUATE _SUPPORT LEVEL =2;

Copy ANALYTICS_REPORT folder from $FIC_HOME/OBIEE and place under <OBIEE
Installed
Directory>/instances/instance1/bifoundation/OracleBIPresentationServicesComponent/cor
eapplication_obipsl/catalog.

Login into Enterprise Manager, click the Business Intelligence folder at left hand side and
select coreapplication, and then click on Deployment tab.

Click the Repository tab.
Click on Lock and Edit Configuration tab.
Click Close on the Confirmation pop-up window.

In the Upload BI Server Repository Section, browse the repository file from the Windows
machine.

Enter the new repository password in the Repository Password and Confirm Password text
boxes.

In BI Presentation Catalog section, provide the Catalog Location as <OBIEE Installed
Directory>/instances/instance1/bifoundation/OracleBIPresentationServicesComponent/cor
eapplication_obipsl/catalog/ANALYTICS REPORT

Click Apply.
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12. Click Activate Changes and close the activate changes pop-up window.

13. Click Close on the Confirmation pop-up window.

14. Modify <OBIEE Installer Directory>

15.
16.

/instances/instancel/config/OracleBIPresentationServicesComponent/coreapplication_
obips1/instanceconfig.xml as the following

From
<Security>

<!--This Configuration setting is managed by Oracle Enterprise Manager
Fusion Middleware Control-->

<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
</Security>

To

<Security>

<!--This Configuration setting is managed by Oracle Enterprise Manager
Fusion Middleware Control--»>

<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<InIFrameRenderingMode>allow</InIFrameRenderingMode>
</Security>

Restart OBIEE server.

Start the Oracle Process Manager and Notification Server (OPMN) services by executing
the following command from <OBIEE Installed
Directory>/instances/instancel/bin

Jopmnctl startall

Post Installation Steps
After installing the OBIEE server, follow these steps:

1.

Log in as OFS BD Admin User with valid username and password. The OFS BD Home
page is displayed.

Click FCCM and then click the Administration Menu and select the Manage Parameters
and click Manage Common Parameters.

Choose Parameter Category as Ul and Parameter Name as OBIEE.
Set Attribute 2 Value = <PROTOCOL>://<OBIEE_SERVER NAME>:<PORT>

Note: <PROTOCOL> is the web page access PROTOCOL (http or https)
and <OBIEE_SERVER NAME> is the FQN (fully qualified name)/host
name of the server, where OBIEE is installed.

<PORT> is the PORT number used in OBIEE installation. It may change based on the
OBIEE version. Enter the correct PORT number if it is not 9704.

Placeholder variables are mentioned between angle brackets. Update the placeholders with
actual value.
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5. Verify Attribute 4 Value. It must be the OFS BD application URL. If the same OFS BD
application is deployed on different machines, then modify the OFS BD Application URL
in Attribute 4 Value appropriately.

Accessing Reports through OFS BD Application

For more information on Accessing Reports, refer to the Alert Management User Guide.

Note: For Bug 13713131: An error displays when a user clicks on the pie
chart or tries to access the Threshold Analyzer reports.

This is an issue with Solaris OS. Apply Solaris patch #13055819 to solve this issue

Configuring Resource Reference

This section describes the details for configuring the resource reference in WebSphere,
Weblogic, and Tomcat Application Servers. For detailed information, refer to Configuring
Resource Reference.

Configuring Web Application Server

This section describes the details to configure the different web application servers for OFSAA
Infrastructure deployment namely, IBM Websphere, Oracle Weblogic, and Apache Tomcat
Servers. For detailed information, refer to Configuring Web Application Servers.

Configurations for Java 8
Refer to the following instructions to extract and apply the patch.
1. Follow the instructions given in the Readme to apply the patch.

2. Ifthe Oracle Database version is 12¢, copy ojdbc7.jar from $SORACLE HOME/jdbc/lib
to the following locations:

»  $FIC_HOME/utility/OFSAAGenerateRepository/lib/

? SFIC HOME/realtime processing/WebContent/WEB-INF/lib/
»  $FIC_HOME/ficdb/lib/

»  $FIC_HOME/ficapp/icc/lib/

? SFIC_HOME/ficapp/common/FICServer/lib/

? SFIC_HOME/FMStandalone/FormsManager/WEB-INF/1lib/

? SFIC_HOME/ficweb/webroot/WEB-INF/lib/

Note: If ojdbc6.jar is already present in any of the aforementioned folders,
you need to remove it.

1. If the Oracle Database version is 11g, copy ojdbcé . jar from SORACLE HOME/jdbc/lib
to the following locations:

? SFIC HOME/utility/OFSAAGenerateRepository/lib/

? SFIC HOME/realtime processing/WebContent/WEB-INF/1lib/
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,  $FIC_HOME/ficdb/lib/

? SFIC HOME/ficapp/icc/lib/

? SFIC HOME/ficapp/common/FICServer/lib/

? SFIC_HOME/FMStandalone/FormsManager/WEB-INF/1ib/

? SFIC_HOME/ficweb/webroot/WEB-INF/lib/

To install OFS BD Applications Pack for Java 7 and Java 8 follow these steps:
Java 7:

> Navigate to the OFS_BD PACK/bin folder.

> Execute . /setup.sh GUI in the console.

Java 8:

> Navigate to the OFS_BD PACK/bin folder

> Execute . /setup.sh GUI in the console.
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Post Deployment Configuration

This section provides detailed information about the Post Deployment Configurations. lists the
various configurations to be completed before you use the OFSAA Applications.

2

2

2

Creating Users

Mapping the User to User Group

Performing Administrative activities for OFS BD

Performing Configurations for OFS BD

Performing Administrative activities for KYC

Setting OFS BD UI as Home Page of OFSAALI for a Particular User

Modifying Additional Configuration Files

Configurations if FSDF pack installed after OFSBD Applications Pack

Changing ICC Batch Ownership

Creating Users

Create the application users in the OFSAA setup prior to use.

Note:

This step may not be required if you have already setup users in the
OFSAA setup.

For more information refer user creation section from the Oracle Financial
Services Analytical Applications Infrastructure User Guide.

Mapping the User to User Group

Starting the OFSAA 8.0 release, with installation of every OFSAA Applications Pack,
pre-configured application user groups are seeded. These user groups are unique to every
OFSAA Applications Pack and have application roles pre-configured.

User Groups seeded with the OFS BD Applications Pack are listed in the table.

Table 6—-1 Seeded User Groups

Name

Description

Modeler Group

User mapped to this group will have access to all the menu items for
Enterprise modeling but will not have authorization rights for sandbox
population, model deployment and modeling technique authorization.
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Performing Administrative activities for OFS BD

Table 6—-1 Seeded User Groups

Name

Description

Modeling Administrator
Group

User mapped to this group will have access to all the menu items for
Enterprise modeling and will be have authorization rights for sandbox
population, model deployment and modeling technique authorization.

Inline Processing Admin
Group

User mapped to this group will have access to all the menu items and
actions for Inline Processing module.

Business Administrator

User mapped to this group will have access to all the menu items and
actions for advanced operations of metadata objects.

Business Authorizer

User mapped to this group will have access to all the menu items and
actions for authorization of changes to metadata objects.

Business Owner

User mapped to this group will have access to all the menu items and
actions for read and write of metadata objects

Business User

User mapped to this group will have access to all the menu items and
actions for access and read of metadata objects.

Identity Administrator

User mapped to this group will have access to all the menu items for
managing User entitlements, User Group Entitlements and Access
Management configurations.

Identity Authorizer

User mapped to this group will have access to all the menu items for
authorizing User entitlements, User Group Entitlements and Access
Management configurations.

System Administrator

User mapped to this group will have access to all menu items for
managing the setup configurations.

Object Administrator

User mapped to this group will have access to all menu items for
managing object migration and metadata traceability using metadata
browser.

Guest Group

User mapped to this group will have access to certain menu items with
only access privileges.

Map the application user(s) to the respective Application User Group(s) and subsequently
authorize the entitlements by logging in as SYSAUTH (System Authorizer) user.

For more information refer Mapping/Unmapping Users section from the Oracle Financial
Services Analytical Applications Infrastructure User Guide.

Performing Administrative activities for OFS BD

Access the OFS BD UI as BDAP Administrator and perform all the steps given in the
following sections of the Administration Guide.

?

About Configuring Access Control Metadata

Mapping Users To Access Control Metadata

About Scenario Manager Login Accounts

About Changing Passwords for System Accounts

About Configuring File Type Extensions

About Configuring File Size

About Configuring Status To User Role Table

6-76 Oracle Financial Services Behavior Detection Application Pack



http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm

Modifying Additional Configuration Files

Note: Once Security Attributes mapping is completed for the BDAP
Administrator user, restart OFSAAI and Web Application servers before
accessing the Admin Tools application.

Performing Configurations for OFS BD

Access the OFS BD UI as BDAP Administrator and perform all the steps given in the
following sections of Configuration Guide.

?

?

?

Configuring the Base Time Zone

Configuring the Default Currency Code

Configuring E-mail

Configuring XML Export

Configuring Organization Relationships for Trade Blotter
Configuring Search Criteria Population Options for Trade Blotter
Configuring Case Correlation Owner

Configuring Default Case Owner

Configuring Default Alert Owner

Configuring the Alert/Case Auto Assignment Web Service

Performing Administrative activities for KYC

You must perform the Administrative activities if OFSKYC application is installed.

Access the OFSBD Ul as a KYC Administrator and perform all the steps given in the KYC
Administration Guide.

Note: Appendix H and I should be performed for successful KYC
installation.

Setting OFS BD Ul as Home Page of OFSAAI for a Particular

User

To set OFS BD UI as home page of OFSAALI follow these steps:

?

?

?

?

?

Log in as an ECM Administrator/Supervisor user.
Navigate to Home page.

Click on logged in user name in the right top corner
Click on Preference and it will open new page

Select Enterprise Case Management as your default page and click Save

Modifying Additional Configuration Files

You can modify the following additional configuration files (although it is not a requirement
that you modify them to run the system):
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Note: This step is optional.

> Datalngest.properties: The Datalngest.properties file (located in the ingestion
manager/config subdirectory) contains the variable values you specified in the silent
properties file, including information about database configuration values, and schema
specifications. For more information on configuring this file, refer to the Oracle Financial
Services Behavior Detection Applications Pack Administration Guide.

> Datalngest.xml: The Datalngest.xml file (which resides in the /<OFS BD Installed
Directory>/ingestion_manager/config sub-directory) contains configuration settings that
are required to configure each Ingestion Management runtime component, for example,
setting up and configuring the number of threads used by each component. For more
information on configuring this file, refer to the Oracle Financial Services Behavior
Detection Applications Pack Administration Guide.

Configurations if FSDF pack installed after OFSBD
Applications Pack

FSDF Staging Schema (BD Pack) needs to be dropped, Apply Patch for SR 3-9830680021(Bug
20066387) contact Oracle support for assistance.

Changing ICC Batch Ownership

This section is not applicable for OFS BD Applications Pack.
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Configuring Web Server

This section covers the following topics:
> Configuring Web Server
> Configuring Web Application Servers

Configuring Web Server
This step assumes an installation of a Web Server exists as per the prerequisites.

Refer the product specific installation guide to install and configure the Web Server. If an
installation already exists, skip and proceed to the next step.

Note:

> Make a note of the [P Address/ Hostname and Port of the web server.
This information is required during the installation process.

? Add umask 0027 in the .profile of the UNIX account which manages the
WEB server to ensure restricted access permissions

> Refer Oracle Financial Services Analytical Applications Infrastructure
Security Guide mentioned in the Related Documents section for additional
information on securely configuring your Web Server.

Configuring Web Application Servers

This step assumes an installation of a web application server exists as per the prerequisites. To
configure the Web Application Server for OFSAA Deployment refer the following sections.

This section includes the following topics:
> Configuring WebSphere Application Server for Application Deployment
> Configuring WebLogic for Application Deployment

> Configuring Apache Tomcat Server for Application Deployment
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Note:

> Make a note of the IP Address/ Hostname and Port of the web
application server. This information is required during the installation
process (required if Web Server is not configured).

> Refer OFSAA Secure Configuration Guide/ Security Guide mentioned in
the Related Documents section for additional information on securely
configuring your Web Server.

Configuring WebSphere Application Server for Application Deployment

You can deploy multiple OFSAA applications on different profiles of a stand-alone WebSphere
application server. To create multiple WebSphere "Profiles" in a stand-alone server, use the
command line option as explained in the following section. A profile is the set of files that
define the runtime environment. At least one profile must exist to run WebSphere Application
Server.

This section covers the following topics:

> Creation of New Profile in WebSphere
> Manage Applications in WebSphere

> Delete WebSphere Profiles

> WebSphere HTTPS Configuration

> WebSphere Memory Settings

Creation of New Profile in WebSphere

The Profile is created in WebSphere through command line using the manageprofiles.sh which
resides in <WebSphere Install directory>/AppServer/bin.

The command to create a profile without admin security through command line is as follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile
path> -templatePath <template path> -nodeName <node name> -cellName <cell
name> -hostName <host name>"

Example:

$usr/home>. /manageprofiles.sh -create -profileName mockaix
-profilePath/websphere/webs64/Appserver/profiles/mockaix
-templatePath/websphere/webs64/Appserver/profileTemplates/default
-nodeName ipa020dorNode04 - cellName ipa020dorNode04Cell -hostName
ipa020dor

The command to create a profile with admin security through command line is as follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile
path> -templatePath <template path> -nodeName <node name> -cellName <cell
name> -hostName <host name> -enableAdminSecurity true -adminUserName
<Admin User Name> -adminPassword < Admin User Passwords> -samplespassword
<sample User Password>"

Example:

$usr/home>. /manageprofiles.sh -create -profileName mockaix
-profilePath/websphere/webs64/Appserver/profiles/mockaix
-templatePath/websphere/webs64/Appserver/profileTemplates/default
-nodeName ipa020dorNode04 -cellName ipa020dorNode04Cell -hostName
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ipa020dor -enableAdminSecurity true -adminUserName ofsaai -adminPassword
ofsaail -samplespassword ofsaai"

Note: While using the manageprofiles.sh command to create a New
Profile in WebSphere, you can also use "-validatePorts" to validate if the
specified ports are not reserved or in use. Additionally, you can specify new
ports with "-startingPort <base ports" which specifies the starting port
number to generate and assign all ports for the profile. For more information

on using these ports, refer WebSphere manageprofiles command.

Manage Applications in WebSphere

To manage the installed applications in WebSphere, follow these steps:
1. Open the administrator console using the following URL:
http://<ipaddress>:<Administrative Console Ports>/ibm/console

Example: http://10.111.222.333:9003/ibm/console (https if SSL is enabled)

Note: Administrative Console Port value is available in serverindex.xml
file within <WebSphere Profile Directorys/config/cells/<Node
Cell>/nodes/<Node Name> directory.

The Integrated Solutions Console Login window is displayed.

Figure 6-1 Integrated Solutions Console Login

Integrated Solutions Console

Log in to the console.
User ID:

upgs73

Password:

LR L]

Log in l
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Log on with the User ID provided with the admin rights.

From the LHS menu, expand the Applications > Application Type> WebSphere
Enterprise Applications.

The Enterprise Applications screen is displayed.

Figure 6-2 Enterprise Applications
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This Enterprise Applications screen helps you to:

> Install new application
> Uninstall existing applications

> Start or Stop the installed applications

Delete WebSphere Profiles
To delete a WebSphere profile, follow these steps:

1.
2,
3.

Select the checkbox adjacent to the required application and click Stop.
Stop the WebSphere profile to be deleted.

Navigate to WebSphere directory:

<WebSphere Installation Directorys/AppServer/bin/
Execute the command:

manageprofiles.sh -delete -profileName <profile name>
Delete profile folder.

Example: <WebSphere Installation Directorys/AppServer/profiles/<profile
name>

Execute the command:

manageprofiles.sh -validateAndUpdateRegistry
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WebSphere HTTPS Configuration
To configure an HTTPS Transport on WebSphere, follow these steps:

1. Create a profile using the Profile Creation Wizard in WebSphere.

Note: Note down the https port specified during this process and use the
same as servlet port or web server port during OFSAATI installation.

2. To enable https configuration on Infrastructure, assign value 1 to "HTTPS _ENABLE" in
OFSAAI InstallConfig.xml for Silent mode OFSAAI installation.

WebSphere Memory Settings
To configure the WebSphere Memory Settings, follow these steps:

1. Navigate to Websphere applications server > Application servers > serverl
> Process definition > Java Virtual Machine.

2. Change the memory setting for Java Heap:
Initial heap size = 512

Maximum heap size =3072

Configuring WebLogic for Application Deployment

You can deploy multiple Infrastructure applications on different domains of a stand-alone
weblogic application server. To create multiple WebLogic "Domains" in a stand-alone server
you can use the Domain Creation wizard. A domain is the set of files that define the runtime
environment. At least one domain must exist to run WebLogic Application Server.

Note: For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8,
download and install patch 18729264.

This section covers the following topics:

> Creating Domain in WebLogic Server
> Delete Domain in WebLogic

> WebLogic Memory Settings

Creating Domain in WebLogic Server

To create a new domain using Configuration Wizard in WebLogic, follow these steps:

1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the
command:

./config.sh

The Welcome window of the Configuration Wizard is displayed.
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Figure 6-3 Welcome

n Fusion Middleware Configuration Wizard HHE

Walcome

oRrRACLE’

® Create a new WeblLogic domain

Create a YyebLogic domaln in your projects directory.

O Extend an existing WebLogic domain

Use this option to add new components 1o an existing domain and modify configuration setings.

[ ea |[ oo | [ereveus | [ nen ]

2. Seclect Create a new WebLogic domain option and click Next.

The Select Domain Source window is displayed.

Figure 6—4 Select Domain Source

Select Domain Source

ORACLE’

@ Generate a domain configured automatically to support the following products:

)

O Base this domain on an existing template

[Eronee |

B2 || uep | | Brevious | [ bt |
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3. Seclect the Generate a domain configured automatically to support the following
products option and click Next.

The Specify Domain Name and Location window is displayed.

Figure 6-5 Specify Domain Name and Location

) Fusion Middleware Configuration Wizard !in
Specify Domain Name and Location
ORACLE
Enter the name and location for the domain:
Domain name: | MockSol |
Darsain ocation: .Memognmemmmamef_projectsmmam | Browse |

4. Enter the Domain Name and Location. Click Browse to navigate and specify the location.

Click Next.

The Configure Administrator Username and Password window is displayed.

Figure 6—-6 Configure Administrator Username and Password

l] Fusion Middleware Configuration Wizard Hlm
Configure Administrater User Name and Password
.
ORACLE
. Disgard Changes
"Lzer rame:
"User password
*Confirm user password [ |
Description: | This wser is the defaut administrator
et |[ tew | | erevious | [ et ]

5. Enter the User name and User password to be assigned to the Administrator. Ensure that

the password is of minimum 8 characters in length.

6. Re-enter the password for confirmation and add a brief Description. Click Next.
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The Configure Server Start Mode and JDK window is displayed.

Figure 6-7 Configure Server Start Mode and JDK

) Fusion Middleware Configuration Wizard !Iﬁ

Configure Server Start Mode and JDK
ORACLE’

Before putting your domain info production, make sure that the production enmvironment is secure. For more information, see the topic "Securing &
Production Environment’ in the YWeblLogc Server documentation,

T use Weblogic JRockit in production, Cracle recommends developing and festing your applications with WebLogic JRockit early in the project cycle,
For information about WebLogic JRockE, see the WebLogic JROCKR documentation.

VWabLogic Domain Startup Mode JOK, Selection
@ Development Mode (@) Awailable JOKs
Utlize koot properties for usermame and hnSDlﬁ.B.Il_ﬂﬂw.BD_lB

password and poll for applications to deploy.
Sun JOK recommended for better startup
perionmance during terative development,

O Production Mode
Require the entry of a usermame and password
andd do not poll 1o appications 1o deplay,
WiebLogic JRockit JOK recommended for better L
rurtime performance and management. Location

| ea bel Previous | [ next |

7. Select the following options:

In the WebLogic Domain Startup Mode section, select the required mode (Development
Mode or Production Mode).

In the JDK Selection section, select Other JDK. Click Browse and navigate to the JDK
location. Click Next.

The Select Optional Configuration window is displayed.
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Figure 6—-8 Select Optional Configuration

E) Fusion Middieware Configuration Wizard

Select Optional Configuration

ORACLE’

Administration Server
Modity Setlings
[ Managed Servers, Clusters and Machines
Add or Delets
Modity Settings
] RDBMS Security Store
Modity Settings

Ext tex

8. Select Administration Server. A WebLogic Server domain must have an Administration
Server. You can also select Manages Servers, Clusters and Machines and RDBMS Security

Store if required. Click Next.

The Configure the Administration Server window is displayed.
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Figure 6-9 Configure the Administration Server

[ Fusion Middleware Configuration Wizard !IE

Configure the Administration Server
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7 Disgard Changes

"Name: | AdminServer
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Listen port: | 7007]
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9. Enter Administration Server details such as the Name, Listen address, Listen Port, SSL
listen port, and SSL enabled (for secure login using https) check box. Click Next.

The Configuration Summary window is displayed.

Note: Make a note of the Listen Port or SSL Listen Port value (ex: 7007),
since the same has to be re-entered in the Servlet port field during
Infrastructure installation.

A-10 Oracle Financial Services Behavior Detection Application Pack



Configuring Web Application Servers

Figure 6—-10 Configure Server Start Mode and JDK
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10. Verify the configuration details of the WebLogic domain and click Create.

The Creating Domain window is displayed with the status indication of the domain
creation process.
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Figure 6—11 Configure Server Start Mode and JDK

Creating Domain

B Fusion Middleware Configuration Wizard

ORACLE

Progress:
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ORACLE"

Extracting Domain Contends .,

Creating Domain Security Information...
Saving the Domain Information...
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Doman Created Successiullyl
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11. Click Done when complete. The domain server is created enabling the deployment of

multiple Infrastructure applications on a single WebLogic.

Note:

?

Note down the HTTPS port specified during this process and use the
same as servlet port or web server port during OFSAAI Installation.

To enable https configuration on Infrastructure, assign value 1 to "HTTPS
ENABLE" in OFSAAI InstallConfig.xml for silent mode OFSAAI
installation

12. Add a java option entry -DUseSunHttpHandler=true in WLS_ HOME/bin/
"setDomainEnv.sh" file (Required only if self signed certificate is used).

Delete Domain in WebLogic
To delete a domain in WebLogic, follow these steps:

1. Navigate to the following directory:

<WebLogic Installation directorys/user projects/domains/<domain

name>/bin

2. Execute stopWebLogic.sh to stop the Weblogic domain.

3. Delete the Weblogic domain.
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WebLogic Memory Settings
To configure the WebLogic Memory Settings, follow these steps:

1.

Change the memory setting for Java Heap to -Xms512m -Xmx3072m in setDomainEnv.sh
file, which resides in the folder <DOMAIN HOME>/bin and in CommEnv.sh file which
resides in the folder common/bin.

Edit this file for customizing memory settings and garbage collector settings depending on
the available hardware configuration.

Example 1:

if [ "${JAVA VENDOR}" = "Sun" ] ; then
WLS_MEM ARGS 64BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 64BIT
WLS_MEM ARGS 32BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 32BIT

else
WLS_MEM ARGS 64BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 64BIT
WLS_MEM ARGS 32BIT="-Xms512m -Xmx1024m"

export WLS MEM ARGS 32BIT

Example 2:

JAVA_ VM=

MEM_ARGS="-Xms256m -Xmx1024m"

Configuring Apache Tomcat Server for Application Deployment
This section is applicable only when the Web Application Server type is Tomcat.

This section includes the following topics:

?

?

Tomcat User Administration

Configure Tomcat to use JAVA 64 bit Executables
Configure Servlet Port

SSL Port Configuration

Apache Tomcat Memory Settings

Configuration for Axis API

Uninstalling WAR Files in Tomcat

Tomcat User Administration

The Tomcat administration and manager application does not provide a default login. You are
required to edit "$CATALINA HOME/conf/tomcat-users.xml" as instructed below.

This file contains an XML <user> for each individual user, which will display the username
and password used by admin to log on to Tomcat, and the role names to which the admin user
is associated with. For example, <user name="admin" password="admin"

roles

"

standard,manager" />
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Add the manager role to any one of the existing username/password combination as shown
in the example above.

Use the same username/password to which the manager role has been assigned to access
the Tomcat Application Manager.

If the Tomcat server is already running, it requires a re-start after the above configuration is
done.

Configure Tomcat to use JAVA 64 bit Executables

To configure Tomcat to use JAVA 64 bit, follow these steps:

1.
2.
3.

Navigate to the "SCATALINA HOME/bin" folder.

Edit the setclasspath.sh as explained below:

Replace the following block of text

# Set standard commands for invoking Java.
_RUNJAVA="$JRE_HOME"/bin/java

if [ "$0s400" != "true" ]; then
_RUNJDB:“$JAVA_HOME"/bin/jdb

With:

# Set standard commands for invoking Java.
_RUNJAVA="$JAVA_BIN"/java

if [ "$0s400" != "true" ]; then
_RUNJDB=“$JAVA_BIN"/jdb

If the Tomcat server is already running, it requires a re-start after the above configuration is
done.

Note: In case tomcat is installed under different Unix profile, set JAVA
BIN environment variable in .profile to include the Java Runtime
Environment absolute path.

For example:
export JAVA BIN /usr/javaé_64/jre/bin

export JAVA BIN = /usr/javaé_64/jre/bin//sparcv9 for Solaris
Sparc

Configure Servlet Port

The default servlet port configured for the Tomcat installation is 8080. Ignore this section if
you need to use the default port.

If you need to use a different port number, you must first configure the port in the "server.xml"
in the "conf" directory of Tomcat Installation directory.

To configure the Servlet Port, follow these steps:

1.
2,

Navigate to SCATALINA HOME/conf. Open server.xml and locate the tag:

"Define a non-SSL HTTP/1.1 Connector on port 8080 "
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3. Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this value to
the new port number that was used during the Infrastructure installation process.

4. Save your changes in "server.xml".

Note: Make a note of the servlet port configured. This information is
required during the installation of OFSAA Applications Pack.

SSL Port Configuration

If you need to configure and access your OFSAA setup for HTTPS access, ensure that the
following connect tag under Define a SSL HTTP/1/1 Connector on port 8443 in <Tomcat
installation folder>/conf/server.xml file is uncommented for SSL Configuration. (By
default, it is commented).

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
maxThreads="150" scheme="https" secure="true"

clientAuth="false" sslProtocol="TLS"

Note:

> Make a note of the servlet port configured. This information would be
required during the installation of OFSAA Applications Pack.

> To enable https configuration on Infrastructure, assign value 1 to
"HTTPS_ENABLE" in OFSAAI InstallConfig.xml for SILENT mode
OFSAALI installation.

For more information related to SSL Configuration on Tomcat, refer to
http://tomcat.apache.org/.

Apache Tomcat Memory Settings
To configure the Apache Tomcat Memory Settings, follow these steps:

1. Locate the file catalina.sh which resides in the folder <CATALINA HOME>/bin

2. Edit this file for customizing the memory settings and garbage collector settings depending
on the available hardware configuration.

3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m.

4. For example:
if [ -z "$LOGGING MANAGER" ]; then
JAVA OPTS="S$JAVA OPTS -Xms512m -Xmx1024m
-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager"
else
JAVA OPTS="S$JAVA OPTS -Xms512m -Xmx1024m $LOGGING MANAGER"

fi
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Configuration for Axis API

Copy the jaxrpc.jar from the <OFSAA Installation Directorys/axis-1_
4 /webapps/axis/WEB-INF/1ib and place it in under <Tomcat Installation
Directory>/1ib and restart the Tomcat Server.

Uninstalling WAR Files in Tomcat
To uninstall WAR files in tomcat, refer Uninstalling WAR Files in Tomcat.
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Configuring Resource Reference in Web
Application Servers

This section covers the following topics:
> Configuring Resource Reference in WebSphere Application Server
> Configuring Resource Reference in Weblogic Application Server

> Configuring Resource Reference in Tomcat Application Server

Configuring Resource Reference in WebSphere Application
Server

This section is applicable only when the Web Application Server type is WebSphere.

This section covers the following topics:

> Creating JDBC Provider

> Create Data Source

> J2C Authentication Details

> JDBC Connection Pooling

Creating JDBC Provider

1. Open the WebSphere admin console in the browser window:
http://<ipaddress>:<administrative console ports>/ibm/console. (https if
SSL is enabled). The Login window is displayed.

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers. The
JDBC Providers window is displayed.
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Figure 6—-12 JDBC Providers

JDBC providers T=

JDBC providers

Use this page to adit properties of a JDBC provider, The JDBC provider object encapsulates the specific JDBC driver
implementation class for ao 5 to the specific vendor database of your environment. Learn mare about this task in a
i ivity. & guided activity provides a list of task steps and more general information about the togic.

Bl Scope: Cell=GXS150REV-ZonelNodedSCell Node=GXS150REV-Zone2Nodels, Server=serverl

Scope specifies the leval at which the rescurce definition s visible. For detalled
information on what scope is and how it works, see the scope settings help,

| Node=GX5150REV-2ZoneZiodeld, Serverssarverl _'ll“i

E EPreferences
l l] Dalata
R

ESthﬂE Hame ™ Scope ™ Description O

w | W

| You can administer the fellewing resources;

| ey 3 Provider HodemGNS150REV- Derby embedded non-Xa JDEC
Zoneilocdelds, Sarvar=sarvarl Provider

i@ FICMASTER NodewGXS150REV- Cracle JDBC Driver
Zonellodals, Server=sarvarl

D r ] ivar Hode=GXS1S0REV- Cracle JDEC Drivar
ZonaZiodall, Sarver=sarvarl

O RORFFW Hode=GXS150REV- RORFFW
Zona2Nodals, Sarver=sarvarl

O RORPNG hode=GX5150REV- RORPHC
Zone2Nodals5, Servearssarverl

O UBGSOFT Hode=GX5150REV- UPGSEFT
Zane2Nodels, Serverssaryarl

H UPGEROR Hode=GXS150REV- UPGSROR

ZaneZliodels, Servarssarvarl

D 2 AN Node=GX5150REV- UPGSSAND
Zane2hodels, Servarssarvarl

4. Seclect the Scope from the drop-down list. Scope specifies the level at which the resource
definition is visible.

5. Click New to add new JDBC Provider under the Preferences section. The Create new
JDBC provider window is displayed.
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Figure 6—-13 Create a new JDBC Provider

Create a new JDBC Provider -

Create a naw JOBEC Provider

Step 1: Create new
JDBC provider

2 Sat the basic configuration values of a JDBC provider, which encapsulates the specific
Stap 2: Enter vendsr JOBC drver implementation classes that sre required ta Becass the database,

database class path The wizard fills in the name and the description fields, but vou can type differant
information valuas,

Step 3: Summary Scope

cells1GXS150REV-
ZonelNodel5Cellinodes:GXS150REV-
Zone2NodelSisarvarsisarvarl

* Database type
| Cracle Ll

* Provider type .

| oracle 108C Driver %l
+* implementation type

| Connection pocl data source | ¥

+ Hama
[oracle JOBE Griver

Cescription
Oracle JOBC Driver [:l

I Cdnce.i I

6. Enter the following details:

Table B-1 Fields and their description

Field Description

Database Type Oracle

Provider Type Oracle JDBC Driver

Implementation Type Connection pool data source

Name The required display name for the resource
Description The optional description for the resource

7. Click Next.
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Figure 6—14 Enter database class path information

ate a new IDBC Provider -

Create a new JDBC Provider

Step 1: Create new Enter database class path information |

JDBT provider

Set the envirenment variables that represent the JOBC driver class files, which
WebSphere(R) Application Server uses to define your JDBE provider. This wizard page
displays the fila names: you supply only the directory locations of the files. Use
cemplete directory paths whan you type the JDBC driver file locations. For eaxample:
Ci\SQLLIE\java on Windovs({R) or /home/dbZinstl/sqllib/java an Linux[TM]}.

Step 2: Enter
database class path
information

Step 3: Summary

If & value iz specified for you, you may click Next to accept the value,

Class path:

=
E

Directory location for "cjdbes.jar” whith is saved as WebSphaere variable
5{ORACLE JDEC_DRIVER_PATH}
|." eracle/crajdbc/app/orajdbe/ product/11.2.0/ cient_1/jdbe/lib

| ﬁrevi;:us_] Nexr|| Cancel I

8. Specify the directory location for "ojdbc<versions.jar" file. Ensure that you do not use
the trailing slash file separators.

The Oracle JDBC driver can be downloaded from the following Oracle Download site:
»  Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers
»  Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers

Once downloaded, you need to copy the file in the required folder on the server.

Note: Refer Appendix N for identifying the correct ojdbc<versions>.jar
version to be copied.

9. Click Next. The Summary window is displayed.
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Figure 6—-15 Summary

Create & new JDBC Provider -

Create 8 new JOEC Brovider

Step 11 Create new Summary |
JDEC providaer el

Summary of actions:

Step 2! Enter

database dass path I Options [ U..h‘] |
information I T

| tcopa | callsrGXS150REV-Zone2Node05Cellinodes GXS1SOREY-
Step 3: Summary | Zonea2fodelS sarvarscsarvarl
JDBC provider name Cracle JDEC Driver
Cescrigtion | Cracls 108 oriver
i Class path : S{ORACLE_J}DBC_DRIVER_PATH}/ ojdbcs. jar

| S{ORACLE_JOBC_DRIVER_PATH} | foracle/crajdbe/app/orajdbe/ product/11.2.0/client_1/jdbe/lib |

Implamantation class nama oracde.jdbc. pocl.OradeConnectionPooiDataSource

| Previous [ .Firtist‘_!ll_, Cano_el]

10. Verify the details and click Finish to create the JDBC Provider.

11. The options to Save and Review are displayed. Click Save.

Create Data Source
The steps given below are applicable for both config and atomic data source creation.

1. Open this URL in the browser window: http://<ipaddress>:<administrative
console ports>/ibm/console. (https if SSL is enabled). The Login window is displayed.

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > Data sources option.
The Data sources page is displayed.
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Figure B-1 Data Sources

Create a data source =

Create & data source

Sat the basic configuration values of 3 datasource for asseciation with your JOBC
3 = grovider. A datasource supplies the physzical connections between the application
ep 21 Select JDBC sarvar and the database.

Reguiremant: Use the Datasources (WebSphera{R} Application Server V4] conscle
pages if your spplications are based on the Enterprise JavaBesns[TM) (EIE) 1.0
specification or the Java(TM) Serviet 2.2 specification.

Seana

cells:GXS150REY-
Zone2NodelSCallinodes:GXS130REY-
Zone2ModelSisarvers:sarvarl

Step 51 Summany # Data source name
[atemT |

# JHDI name
[iebe/oRYMOCK

4. Select the Scope from the drop down list. Scope specifies the level at which the resource
definition is visible.

5. Click New. The Create a Data Source window is displayed.
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Figure B-2 Create Data Source

Crante s data source

Step 1: Enter basic
data source
information

Step 2: Select IDBC
providar

Stap 3: Enter
database specific
proparties for the
data source

Enter basic data source information

Sat the basic configuration values of a datasource for asscciation with your JDBEC
provider. A datasource supplies the physical connections between the application
5 and tha database.

Requiremant: Use the Datasources (WebSphara(R)} Application Server V4) conscle
oages if your sapplications are based on the Enterprise JavaBesnz{TM) (EIB] 1.0
specification or the Java(TM) Serviet 2.2 specification.

Seope

cells: GXS15OREV-
Zone2iodedSCallinodes:GXS1 30REY-
Zona2lodelSisarvars isarvarl

Step 4: Satup
sacurity aliases

Step 3@ Summary 4+ Data source name

|-¢-.tu-mT

# JNOI name
ligse/DRYMOCK

6. Specify the Data Source name and JNDI name for the new "Data Source".

The JNDI and Data Source name are case sensitive and ensure that JNDI name is same as
the "Information Domain" name.

7. Click Next. The Select JDBC provider window is displayed.

Figure B-3 Select JDBC provider

Creats & data sourca

Step 11 Enter basic
data source
infarmation

Spacify 8 JDEC provider to support the datasource. If you choose to create a naw
JOBC provider. it will be created at tha same scope as the datasource. If you are
zelecting an existing JOBC provider, only thoze providers at the current scope are
available from the list,

Step 2: Select IDBC
provider

Step 31 Enter
database specific
proparties for the
data source

O Craate naw JDBC provider

'@' Select an axisting JDBC provider

Step 4: Satup
security aliases

| Oracle JDBC Oriver (¥

Step 51 Summary

| Previous |  Next| Cancel |

8. Select the option Select an Existing JDBC Provider and select the required JDBC
provider from the drop-down list. Click Next.

Configuring Resource Reference in Web Application Servers B-25



Configuring Resource Reference in WebSphere Application Server

Figure B-4 Enter database specific properties

Create 3 data source

Step 11 Enter basic Select IDBC provider
data sourca rllaL e
information

Spaecify a JDEC provider to support the datasource. If you choose to create a new
- g JOBC provider. it will be created at the same scope as the datasource. If you are
Step I: Select JOBC zelecting an existing JDBC provider, only thoze providers at the current scope are
provider availatla from the list,

Step 31 Enter
database specific
properties for the
data source

{0 Craate new IDBC pravidar

@ Select an axisting JDEC provider
Step 4: Setup

R Sk [Oracls JOEC Oriver (¥

Step 51 Summary

' [Frevious ] | ext|  Cancel |

9. Specify the database connection URL.
For example: jdbc:oracle:thin:@<DB_SEREVER IP>:<DB SERVER PORT>:<SID>

10. Select Data Store Helper Class Name from the drop-down list and ensure that the
checkbox Use this data source in container managed persistence (CMP) is selected.

Note: For RAC configuration, provide the RAC url specified during
installation.

Example: jdbc:oracle:thin:@(DESCRIPTION= (ADDRESS

LIST= (ADDRESS= (PROTOCOL=TCP) (HOST=10.11.12.13) (port=1521)) (ADDRESS=(PRO
TOCOL=TCP) (HOST=10.11.12.14) (PORT=1521)) (LOAD_

BALANCE=no) (FAILOVER=yes) ) (CONNECT DATA=(SERVICE NAME=pgadb)))

11. Click Next.

Figure B-5 Enter Database specific properties

Create a dats source =

Creste a data source

Step 1: Enter basic mmm\lpudﬁﬂ R FRIGRITA P
data source ) specific properties the data ]
Infarmation

Seak these database-specific properties, which are reguired by the database vender

b
Stap 2: Selact JDBEC JOBEC driver to support the connections that are managed through the datasource.

provider

Step 3: Enter Name | Valus
database specific # URL

| [fo-184.108.91 1521 0rcl11g]

properties for the
dats source

Stap 4: Setup
sacurity aliases

:_Drich“.lg data stora halper VI

Stap 5: Summary [¥] Use thiz data source in container managed persistance (CMP)

| Previous I .:' Mext I | Cancel I
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12. Map the J2C authentication alias, if already created. If not, you can create a new J2C
authentication alias by accessing the link given (Global J2C authentication alias) or you
can continue with the data source creation by clicking Next and then Finish.

Figure B-6 Summary

Craate a data source

Stap 1t Enter basic Summary
data source 2

information =
Summary of actions:

Step 2: Select JDBC I ﬂpﬂaﬂi \f-.|-u.;
prowider

cells:GX5130REV-ZoneZNodedSCell:nodes GXS1SOREV-

Step 3: Enter Scope ZoneZNodelS:servars:sarverl
H ifi |

ﬁ:::ﬁﬁ;::ﬂ.ﬁﬁ: Data scurce name | AtarmT

data source JNDI name | jese/orRYMOCK

Stap 41 Satup Select an _axisting Oracle JIDBEC Driver

security aliases JDEC provider N

=3 Step 5: Summary :_‘T:_‘l:m.ﬂhﬁgﬂ class | oracle.jdbe.pool.CracleConnectionPeolbataSource

URL | jdbcioracla:thini@10.184,108.91:152110rcl11gr2

Data store helper class

S com.ibm.websphere.rsadapter.Oraclel OgDataStoreHelpar

Usze thiz datas zourze in
centainer managed true
persistence (CMP)
Component-managed

authentication alias (none)

Mapping-configuration

alias i

Centainer-managed
authaentication alias

I {nens)
]

You can also create and map J2C authentication alias after creating the data source.

13. You must create another Data source by following the above procedure with
jdbc/FICMASTER as JNDI name pointing to the "configuration schema" of Infrastructure.

J2C Authentication Details

The steps given below are applicable for creating both config and atomic J2C Authentication.
To create J2C Authentication details:

1. Select the newly created Data Source and click JAAS - J2C authentication data link
under Related Items.

JAAS- J2C authentication data
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Figure B-7 JAAS- J2C authentication data

Data sources > Default Datasource > JAAS - J2C authentication data

Specifies a list of user identities and passwords for Java{TM) 2 connecter security to use.

Prafix new alias names with the node name of the cell (for compatibility with earlier releasas)

[ Apply
B Praferances

. _m] Dalata

e
L=l mlles
| Salact| Alias = |Usar D 2 | Description &
| You can administer the following resources:
[ | @xsisoRew | upgscenf FICMASTER
Zone2Node0S5/FICMASTER |
[] |SXSLS0REV-ZonedNoded S/ RORFFV | rorffu
D EXE}:ES EI-ZQQ:ZHQQ:QE'EQSM'; | FErgNG
D GMSiS0REV-ZongZNodel S/ USGSEFT iupg:nﬂ' upgspft
GXS1SOREY- upgsprod upgsprod
= aeneNodglS/LIRGSEROD |
O 3% REWV- | upgsror upgsror
Zon Jup _
[0 |SxSL30REW- upgssand upgssand
ngah LB &N
D GXS150REV-Zone2Hode S VASTEST | upgsconf upgsconf
Tetal &

2. Click New under the Preferences section.

Figure 6—-16 JAAS- J2C authentication data- New

Data sources > Default Datasource > JAAS - 13C authentication data > New

Specifies a list of user identities and passweords for Java(TM) 2 connector security to use.
General Properties

* zlisz
[atm

* Usar ID
||,|p§i‘-"3

* Password
|I.‘l.. L]

Descrigtion
|;f¢mi: IAstance

Iipnlyl ;Cilfl Ronll Cancel I

3. Enter the Alias, User ID, Password, and Description. Ensure the following:

> User ID is the Oracle user ID created for the respective CONFIG and ATOMIC
Schema for the "Information Domain".
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> Specify the CONFIG database user ID and password information for the
jdbc/FICMASTER data source, and specify the ATOMIC database user ID and
password information for the ATOMIC schema data source that you created earlier.

4. Click Apply and save the details.

JDBC Connection Pooling
To define the JDBC connection pooling ensure that you have created JDBC Provider and Data
source to access the data from the database.

1. Expand the Resources option in the LHS menu and click JDBC > Data sources option.
The Data sources page is displayed.

2. Click the newly created Data Source $SDATA_SOURCES and navigate to the path Data
sources>$DATA SOURCE$>Connection pools.

Figure B-8 Connection pools

Data sources. =

Dats sources > GAFUSION DATA SOURLE > ConnectHon pools

Use this page to set properties that impact the timing of connedion management tasks, which can affect
the parformance of your application, Considar the default values carafully; vour application requiramants
right warrant changing these values,

Configuration

Lensral Properties

Additional Properties

Scope
calls:ipaZédarodeniCellinodes ipaZbdarNodalsarvers: sarverl Eﬁ-‘”"—f‘iﬂ -
sonnaction pool
* Connection timeout properbies
"J saconds Cconneckion pool

Ftorm propa
* Meximum Ssnhacbions

|1D0 connactions

* Minirmurm connactions

|r:|.l:l connactions
*Ruaplrd

|120 seconds
* Unused timeout

1800 seconds

* Aged timeout
o saconds

Purga policy .
EntirePool i_’|

npply] ﬂ Rt:n| Gam:ul|

3. Set the values for Connection timeout to 0 seconds, Maximum connections to 100
connections, and Minimum connections to 10 connections as shown in the above figure.
You can also define Reap Time, Unused Timeout, and Aged Timeout as required.

Configuring Resource Reference in Weblogic Application
Server

This section is applicable only when the Web Application Server type is WebLogic.This section
includes the following topics:

2 Create Data Source
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2

2

2

2

Create GridLink Data Source
Configure Multi Data Sources
Advanced Settings for Data Source

JDBC Connection Pooling

In WebLogic, you can create "Data Source" in the following ways:

2

"For a Non RAC Database instance, Generic Data Source has to be created. See Create
Data Source.

"For a RAC Database instance, Gridlink Data Source has to be created. See Create
GridLink Data Source.

"When Load Balancing/Fail over is required, Multi Data Source has to be created. See
Configure Multi Data Sources.

Create Data Source

The steps given below are applicable for both config and atomic data source creation.

1.

Open the following URL in the browser window:
http://<ipaddress>:<administrative console ports>/console. (https if SSLis
enabled). The Welcome window is displayed.

Login with the Administrator Username and Password.

Figure B-9 Welcome

ORACLE
WebLogic Server® 11g

Administration Console

3.

Welcome

oG It ek vt S WeBLome Sarver diman
Username:
Passward:

From the LHS menu (Domain Structure), click Services > Data Sources. The Summary of
JDBC Data Sources window is displayed.
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Figure B-10 Summary of JDBC Data Sources

ORACL E Weblogic Server® jumsin ation Conscle

Changa Conter Al Fome Lot Predererces (] Recond He kY Wrrkoeme, managrr Correched b Mockial
S SN, R
Configue wion dting is ansbied, Fuburs Summary of 080 Dats Serces

canges well st omacu sy be activaied s vou
wacty, sdd or desiets ibave in e domaen.

B 00 deta souroe i an chinct bound o e TNDE Boe that provides detabune connectivity through apod of T08C connections. Sooi atire can ook i o dista sounce on th 3900 tree and thee
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MockSal |
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Foregrn INCH Proveddeny
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Sy e S abis
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4. Click New and select Generic Data Source option. The Create a New JDBC Data Source
window is displayed.

You can also select GridLink Data Source or Multi Data Source while creating a Data
Source. For more information, see Create Data Sourceor Configure Multi Data Sources.

Figure 6-17 Create a New JDBC Data Source

Create a Mew JDBC Data Source

et | Cancet

JDBC Data Source Properties
The: followeng propertes wil be used to idenbfy your new JOBC da'lta source.

Enicates requarid feids

‘What would you like to name your new JOBC data source?
o] * Mame: ATOMSTSOL

What JND% name would you ikt 10 sssign 1o your new J0BC Data Source?

5] INDT Name:
b/ KTSTSOL

‘What database type would you lke to select?
Database Type: Oracle -

bt | Cancel

5. Enter JDBC data source Name, JNDI Name, and select the Database Type from the
drop-down list. Click Next.
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Ensure the following:
> The JNDI Name field should be in the format "jdbc/informationdomain”

> Same steps needs to be followed to create a mandatory data source pointing to the
"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name.

> JNDI Name is the same as mentioned in web.xml file of OFSAAI Application.
> Required "Database Type" and "Database Driver" should be selected.

Figure B-11 JDBC Data Source Properties

Create a New JDBC Multi Data Source
Back  Mext | cance:

Select Data Sourde Type

Flease selert type (KA or Moa-AY of da1a source yau would B ta acd 1o yeur new J0SC MUt Data Source
) XA Driver

(&) Mon-XA Driver

Sack  Phaxd | Cancal

6. Select the Database Driver from the drop-down list. You need to select the Database
Driver depending on database setup, that is, with or without RAC. Click Next.

Figure B-12 Transaction Options

Create & New JDBC Data Source
Back | | higsd Cancei

Transaction Options

ol Fde salastad fon-NA I0BC drver i reale AAtahass Aanreshin N your ney DAL S5ris

DOBs s Ca18 S0UNCE SuPDOrt JI0OM ransaItons ! 1f yes, pleage choose She ransacton protocol for this dats souroe.
[¥] Supports Global Transactions

Salact this cotion f you want to enable non-X& J0BC connections from the data source io parbooate n global ransactions Leng the Loppng Last Aesouree (LLR) tranesction cotmizabon,
Recomménded in plaoe of Emylate TworPhase Commit.

) Logging Last Resource

Seiect this opbion If you want to enable non-XA JOBC connections from fhe data source fo emulale parbopaton in giobal ransbcbons usng JTA, Sefect thes cption only i your apphsation can
Ioerale e CONGROnS.

) Emulate Two-Phase Commit

5 spvoc i you WAt i Enable fon-XA J0BC oonnectons from the data sturce to pArBIDAtE i Global ransactiond uSng the one-phise conmimt MARSACHHN Procassng, Wish this cotion, no
oher resources Can partopate n the ;:m- ftransaction.

& One-Phase Commit

Back | Nexd Cangel
I

7. Select the Supports Global Transactions checkbox and the One-Phase Commit option.

8. Click Next. The Connection Properties window is displayed.
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Creabe a liew JDBC Data Source

Cannection Properties

Define Connecton Properties.
What e Bhe name of the databiss you would BE B Sornect iB?
Database Mame:

VWhats the nams or [P sddreds of the datsbase serer?

Hosk Hame: 10 184 .74 80

What s the port on the CMADRCE SETVET LS 10 Connect 1o e databage?

What databass scooUnt user Name da you want i e o oreabs databass oormecions?

Database User Rame:

Whatis the database actount password 1o use to create database conmections?

Fassword: sEEREE

Confirm Password:

Figure B-13 Connection Properties

heat| | | Canced

faghu

1521

saatom

sennns

Neat | | | Cancel

9. Enter the required details such as the Database Name, Host Name, Port, Oracle User
Name, and Password.

10. Click Next. The Test Database Connection window is displayed.
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Figure B-14 Test Database Connection

Create a New JDBC Data Souroe
Test Confguration | | Back | fiext | | Finish | | Cancal

Test Database Connection

Test the databicce svadshiity andl the connection propertes you pronded.

wihat s the fl package name of IDBC drvver dasd ued to reate databass SHMMeCHond N e Cornecton pool?

Diriver Class Name: oracle jdbe OracleDrmar
What i the URL of the databade to tonnect in? The format of She LRL vares by X0BC driver.
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Database User Name: saatom
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Password: FEERRERBRERERRR RN

Confirm Password: sEAEBRRERRRR RN

What are the properbes to pass to the JIDEC drover when créatng database connechons?

Properties:

uamI~asatem |
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11. Verify the details and click Test Configuration and test the configuration settings.
A confirmation message is displayed stating "Connection test succeeded."

12. Click Finish. The created "Data Source" is displayed in the list of Data Sources.
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Note:

> "User ID" is the Oracle user ID that is created for the respective
"Information Domain".

> "User ID" to be specified for data source with "FICMASTER" as "JNDI"
name should be the Oracle user ID created for the "configuration
schema".

13. Select the new Data Source and click the Targets tab.

Figure B-15 Select Targets

Create a New JDBC Data Source
Sack Finish | | Cancsd
Select Targets

Wil CAN SAICT e O mOne BArgats Bo deplay your nevw JOBC clats sourcs, If you don't salact & targat, the date scurce will be created but ot deploped. You wil reed 1o deploy the data sturee
&b B laher bme.

Servers

[ Adminserver

Back Fmisn Cancel

14. Select the AdminServer option and click Finish.

Create GridLink Data Source

If you have selected the option, New > GridLink Data Source while creating the "Data
Source", you can directly specify the JDBC URL as indicated.
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Figure 6-18 Create a New JDBC GridLinkData Source

Create a New JOBC Gridiink Data Source
Back Toeut Cancel
Connection Properties
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Comphete 1080 URL:
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Password:

Confirm Password:

Back | leaxt Cancel

1. Enter Data Source Name, and JNDI Name.

Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and the XA
Driver checkbox is not selected. Click Next.

Figure 6-19 JDBC GridLinkData Source- Connection Properties

Create a Bew JDEC Gridiink Data Source
Next | | Cancal

JDBC Gridlink Data Source PFroperties

The foliowing properties vl be Lsad to dentfy your new JDBC Griclink dats source
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A = =
.q-] Hame: ¥YT

ihas FOL rame wioakd you e 10 33500 10 your new JDEC Gradlink clats sounce?

-!:—-J JNDT lRame:
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Database Type: Crade
Is Thes XA driver?

[[] xA Drver

e | | Cancel
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2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The
created "Data Source" is displayed in the list of Data Sources.

Configure Multi Data Sources

A JDBC multi data source is an abstraction around a group of data sources that provides load
balancing and failover between data sources. As with data sources, multi data sources are also
bound to the JNDI tree. Applications can look up a multi data source on the JNDI tree and then
reserve a database connection from a data source. The multi data source determines from which
data source to provide the connection.

When the database used is Oracle RAC (Real Application Clusters) which allows Oracle
Database to run across a set of clustered servers, then group of data sources can be created for
instances running on a set of clustered servers and a JDBC multi data source can be created so
that applications can look up a multi data source on the JNDI tree to reserve database
connection. If a clustered server fails, Oracle continues running on the remaining servers.

1. Open WebLogic Admin Console in the browser window:
http://<ipaddress>:<administrative console port>/console. (https if SSL is
enabled). The Login window is displayed.

2. Login with the "User ID" that has admin rights.

3. Inthe LHS menu (Domain Structure), select Services > JDBC > Multi Data Sources. The
Summary of JDBC Multi Data Sources window is displayed.

Figure 6-20 Summary of JDBC Multi Data Sources
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Sourde it prirAde e Cornecion.
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P Customize this tabis
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[ |rosos Koo ROARHELOT Loag Caaning Admenbarver
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4. Click New. The New JDBC Multi Data Source screen is displayed.

Note: Ensure that the Data Sources which needs to be added to new JDBC
Multi Data Source has been created.
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Figure 6-21 Configure the Multi Data Source

Create a New J06C Mults Data Source
Fig] Cange:
Configure the Multi Data Source
The faloving propertiss wil be used t dentify your new JDBC st GRS sduroe

Vit wiouid you Boe fo nevme your new JDBC Uit OBt sowrTe?
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What slgorithn type for this JOBC Mol Data Source veould you o (o select?
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5. Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from the
drop-down list. Click Next.

Note:
> The JNDI Name has to be specified in the format jdbc/infodomname.

2 JNDI Name of the Data Sources that will be added to new JDBC Multi
data source should be different from the JNDI name specified during
Multi Data Source.

> Same steps needs to be followed to create a mandatory data source
pointing to the "configuration schema" of infrastructure with
jdbc/FICMASTER as JNDI name for Data Source.

> JNDI Name provided in multi data source should be the same name that
will be mentioned in the web.xml file of OFSAAI Application.

> You can select the Algorithm Type as Load-Balancing.

Figure 6-22 Select Targets

Create & New JDBC Multi Data Source
Eagk | W cancal
Select Targets

Vit S SeC Ot 7 MONE 187 QR 0S L SRR Y your new JODC MUt Dats Founce,

SErvers

[ AdminServer

Back || haxd Cancal
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6. Select the AdminServer check box and click Next.

Figure 6-23 Select Data Source Type

Create a New JDBC Multi Data Source
Back  Phent | Camce

Select Data Source Type

Fiease select fype (XA or Mon<A) of data souroe you veould le to acd to your new J08C MUy Data Source
) XA Driver
{5} Mon-XA Driver
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7.  Select the type of data source which will be added to new JDBC Multi Data Source. Click
Next.

Figure 6-24 Add Data Sources

Create a New J08L Hulti Data Source

Back Frh Cancel

Add Data Seurces

vhat JOBC Data Sources woudd you B 1o a0 o vour new JOBC Myl Da'p Source?
Dats Sources:

Available Chosen

8. Map the required Data Source from the Available Data Sources. Click Finish.
The New JDBC Multi Data Source is created with added data sources.

Advanced Settings for Data Source

1. Click the new Data Source from the Summary of JDBC Data Sources window. The
Settings for <Data Source Name> window is displayed.

2. Select the Connection Pooling tab given under Configuration.

3. Go to the Advanced option at the bottom of the page, and check the Test Connection of
Reserve checkbox (Enables Weblogic Server to test a connection before giving it to a
client).

To verify if the data source is valid, select "Data Source name". For example,
FICMASTER.
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Figure 6-25 Settings for <Data Source Name>

Settings for FICMASTER
Configuration | Targets | Monitoring | Contral | Security | Netes

Statstcs  Testing
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4. Select the server and click Test Data Source.
A message is displayed indicating that the test was successful.

5.  Once the "Data Source" is created successfully, the following messages are displayed:
> All changes have been activated. No restart is necessary.
> Settings updated successfully.

If not, follow the steps given above to recreate the data source.

JDBC Connection Pooling

To define the JDBC connection pooling, ensure that you have created JDBC Provider and Data
source to access the data from the database.

1. Click the newly created Data Source $DATA SOURCES and navigate to the path Home
>Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC Data
Source-<INFODDOM NAME>

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity
Increment by 1, Statement Cache Type to LRU, and Statement Cache Size to 10.

3. Click Save.

Configuring Resource Reference in Tomcat Application
Server
This section is applicable only when the Web Application Server type is Tomcat.
This section covers the following topics:
> Create Data Source
> JDBC Connection Pooling
> Class Loader Configuration for Apache Tomcat

Copy the Oracle JDBC driver file, "ojdbc<version>.jar" from <Oracle Home>/jdbc/1lib and
place it in <Tomcat Home>/lib.
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Note: Refer Appendix N for identifying the correct ojdbc<versions.jar
version to be copied.

Create Data Source

To create "data source" for Infrastructure application, navigate to <Tomcat Homes>/conf and
edit the following block of text by replacing the actual values in server.xml.

Note: The User-IDs for configuration/ atomic schemas have the prefix of
setupinfo depending on the value set for PREFIX SCHEMA NAME in
<<APP Pack>> SCHEMA IN.XML file of Schema Creator Utility.

For example: if the value set for PREFIX SCHEMA NAME is DEV and
the schema name was mentioned as ofsaaconf, then the actual schema created
in the database would be DEV_ofsaaconf.

<Context path ="/<context name>" docBase="<Tomcat Installation
Directory>/webapps/<context name>" debug="0" reloadable="true"
crossContext="true">

<Resource auth="Container"
name="jdbc/FICMASTER"
type="javax.sqgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the configuration schemas"
password="<password for the above user id>"
url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxActive="100"
maxIdle="30"
maxWait="10000"/>
<Resource auth="Container"
name:"jdbc/< INFORMATION DOMAIN NAME >"
type="javax.sqgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the atomic schemas>"
password="<password for the above user id>"
url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxActive="100"
maxIdle="30"
maxWait="10000"/>

</Context>
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Note:

> The <Resource> tag must be repeated for each Information Domain
created.

> After the above configuration, the "WAR" file has to be created and
deployed in Tomcat.

JDBC Connection Pooling

To define the JDBC connection pooling, do the following:

1. Copy $ORACLE HOME/jdbc/lib/ojdbc<version>.jar to the path STOMCAT
DIRECTORY/1ib/.

Note: Refer Appendix N for identifying the correct ojdbc<versions.jar
version to be copied.

2. Editthe server.xml present under the path STOMCAT DIRECTORY/conf/ with the below
changes, which is required for connection pooling.

<Context path=“/ SCONTEXTNAMES" docBase=" $APP_DEPLOYED_PATH$ " debug="0"
reloadable="true" crossContext="true">

<Resource auth="Container"
name="jdbc/ $INFODOM NAMES"
type="javax.sql.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username=" $ATOMICSCHEMA USERNAMES"
password="$SATOMICSCHEMA PASSWORDS"
url="$JDBC_ CONNECTION URL"
maxActive="100"
maxIdle="30"
maxWait="10000"
removeAbandoned="true" removeAbandonedTimeout="60"
logAbandoned="true"/>

</Context>

Note the following:
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Note:

»

SAPP DEPLOYED PATHS should be replaced by OFSAALI application
deployed path.

$INFODOM_NAMES should be replaced by Infodom Name.

SATOMICSCHEMA USERNAMES should be replaced by Atomic schema
database user name.

SATOMICSCHEMA PASSWORDS should be replaced by Atomic schema
database password.

$JDBC_CONNECTION URL should be replaced by JDBC connection string
jdbc:Oracle:thin:<IP>:<PORT>:<SID>. For example,
jdbc:oracle:thin 10.80.50.53:1521:s0luint

The User-1Ds for configuration/ atomic schemas have the prefix of setupinfo
depending on the value set for PREFIX SCHEMA NAME in <<APP Pack>>
SCHEMA_IN.XML file of Schema Creator Utility.

For example: if the value set for PREFIX SCHEMA NAME is DEV and the
schema name was mentioned as ofsaaconf, then the actual schema created in the
database would be DEV_ofsaaconf.

Class Loader Configuration for Apache Tomcat
Edit the server.xml available in $STOMCAT HOME/conf/ folder.

1.
2.

Add tag <Loader delegate="true" /> withinthe <Context> tag, above the
<Resource> tag. This is applicable only when the web application server is Apache Tomcat

8.

Note: This configuration is required if Apache Tomcat version is 8.
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Creating and Deploying EAR/ WAR File

This section covers the following topics:
> Creating EAR/WAR File
> Deploying EAR/WAR File

Creating EAR/WAR File
To create EAR/WAR File, follow these steps:
1. Navigate to the SFIC_WEB_HOME directory on the OFSAA Installed server.
2. Execute ./ant.sh to trigger the creation of EAR/ WAR file.

3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time taken"
message is displayed and you will be returned to the prompt.

Figure C-1 Creating EAR/ WAR File

4. The EAR/ WAR file - <contextname>.ear/ .war - is created.

Creating and Deploying EAR/ WAR File C-45



Deploying EAR/WAR File

Note: The <contextname> is the name given during installation. This
process overwrites any existing version of EAR file that exists in the path.

In case of OFSAA configured on Tomcat installation, <contextname>.war is
created.

Deploying EAR/WAR File
This section covers the following topics:
> Deploying EAR/WAR Files on WebSphere
> Deploying EAR/WAR files for WebLogic
> Deploying Tomcat WAR Files on Tomcat

Note: Ensure to clear the application cache prior to the deployment of
Applications Pack Web Archive. This is applicable to all Web Servers
(WebSphere, WebLogic, and Tomcat). For more information, refer Clearing
Application Cache section.

Deploying EAR/WAR Files on WebSphere
To deploy Infrastructure application in WebSphere:

1. Start WebSphere Profile by navigating to the path "/<Websphere Installation
Directory>/IBM/WebSphere/AppServer/profiles/<Profile Name>/bin/" and
execute the command:

./startServer.sh serverl

2. Open the following URL in the browser: http://<ipaddress>:<Administrative
Console Ports>/ibm/console. (https if SSL is enabled). The login screen is displayed.
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Figure C-2 Login Window

. . WebSphere Integrated
Solutions Console

User ID:

admin

Password:

l..l.|
&

Licensed Materials - Property of IBM (c) Copyright IBM Carp. 1997, 2011 All Rights Reserved.
1BM, the IBM logo, ibm.com and WebSphere are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide. Other
product and service names might be trademarks of IBM or other companies. A current list of
1BM trademarks iz available on the Web at Copyright and trademark information.

[om]|
rlll
I

®

3. Enter the user credentials which has administrator rights and click Log In.

4. From the LHS menu, select Applications and click New Application. The New
Application window is displayed.

Figure C-3 New Application

MNew Applicatian

New Application

This page provides links to create new applications of different types,

Install a New Application

-
Mew Enterprise Applicatien

% Mew Business Level Application

W —

-l -

5. Click New Enterprise Application. The Preparing for the application installation window
is displayed.
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Figure C-4 Preparing for the application installation

Preparing for the application installation

Specify the EAR, WAR, JAR, or SAR medule to upload and install,

Path to the new application

) Local file system

@ Remote file system

Full path

M Cancel

6. Select Remote File System and click Browse. Select the EAR file generated for OFSAAI
to upload and install. Click Next.

Figure C-5 Installation Options

Preparing for the application installation

How do you want to install the application?

@ Fast Path - Prompt anly when additianal infarmation is required.

) Detailed - Show all installation options and parameters,

& Choose to generate default bindings and mappings

Previous I NE-CI:| Cancel |

7. Select the Fast Path option and click Next. The Install New Application window is
displayed.
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Figure C-6 Install New Application
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8. Enter the required information and click Next. The Map Modules to Servers window is
displayed.
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Figure C-7 Map Modules to Servers
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9. Select the Web Application and click Next. The Map Resource References to Resources
window is displayed.

Figure C-8 Map Resource References to Resources
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10. Map ecach resource defined in the application to a resource JNDI name defined earlier.

11. Click Modify Resource Authentication Method and specify the authentication method
created earlier.
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You can specify "config" for FICMASTER resource or "atomic" for atomic resource as the
authentication method.

12. Select the OFSAAI Web Application check box and click Next. The Map Virtual hosts
for Web Modules window is displayed.

Figure C-9 Map Virtual host for Web Modules

Install New Application T
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13. Select the Web Application check box and click Next. The Summary page is displayed.
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Figure C-10 Summary
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14. Click Finish and deploy the Infrastructure Application on WebSphere.

On successful installation, a message is displayed.

15. Click Save and save the master file configuration. The details are displayed in the Master
File Configuration window.

Start the Application
To start the application, follow these steps:

1. Expand Applications > Application Type > WebSphere enterprise applications. The
Enterprise Applications window is displayed.

C-52 Oracle Financial Services Behavior Detection Application Pack



Deploying EAR/WAR File

Figure C-11 Enterprise Application
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2. Select the installed application and click Start.

Note:

> <profile name> is the profile name given while creating the WebSphere
profile.

> <cell name > is the cell name given during profile creation.

? <contextname> is the context name given during installation.

Deploying EAR/WAR files for WebLogic

Following are the steps for deploying Infrastructure application that would be created during
installation:

1. Navigate to the path "<WebLogic Installation directory>/user_projects/domains/<domain
name>/bin" in the machine in which WebLogic is installed.

2. Start WebLogic by executing the command:
/startWebLogic.sh -d64 file

3. Open the URL in the browser window: http://<ipaddress>:<admin server port>/console.
(https if SSL is enabled). The Sign in window of the WebLogic Server Administration
Console is displayed.

Note: Ensure that you have started Infrastructure Server by executing
"./startofsaai.sh" as mentioned in Starting Infrastructure Services section.

4. Logon to the WebLogic Server by entering the user credentials having privileges to deploy
the EAR file.

5. From the Domain Structure LHS menu, click Deployments. The Summary of
Deployments window is displayed.
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Figure C-12 Summary of Deployments
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O | veme & State | Health | Type DeHioymecar
How do L.. * B i
O | ® Pupg72rz actve |0k [E "w::fn 100
System Status 2
| | Install | Y Y Showing 1to 1of 1 Previous | Next

Click Install. The Install Application Assistant window is displayed.

Select the Exploded EAR directory after browsing to the directory where it is saved and
click Next.

Explode EAR File
To explode EAR, follow these steps:

1.

Create the "applications" folder under domain name. For example, "/Bea/user
projects/domains/ <Domain name>/applications".

Create <context name>.ear folder under "applications" folder.

Copy the <$FIC_WEB HOME/<context name>.ear file to <WEBLOGIC INSTALL
DIR>/Bea/user projects/domains/<DOMAIN NAME>/applications/<context
names.ear.

Explode the <context names.ear file by executing the command:
jar -xvf <context names.ear

Delete the <context>.ear and < context »>.war files (recently created) <WEBLOGIC
INSTALL DIR>/Bea/user projects/domains/<DOMAIN
NAME>/applications/<context names.ear.

Create a directory <context name>.war under <WEBLOGIC INSTALL DIR>/Bea/user_
projects/domains/<DOMAIN NAME>/applications/<context names.ear.

Copy <SFIC_WEB HOME/<context name>.war file to <WEBLOGIC INSTALL
DIR>/Bea/user projects/domains/<DOMAIN NAME>/applications/<context
name>. ear/<context_name> .war.

Explode the <context name>.war file by executing the following command to get the
directory structure:

jar -xvf <context name>.war
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Install Application
To install Application, follow these steps:

1. Open the Install Application Assistant.

Figure C-13 Install Application Assistant

Install Application Assistant

et Cancel
Locate deployment te install and prepare for deployment
Selact the fie path that represents the appbcation root drectary, archive fie, exploded archive directory, or appbcation module descnptor that you want to instal. You can also enter the path of
the application directory or file in the Path field,

Mote: Only vaid fie paths are displayed below, If you cannot find your deplayment fies, upload your fle(s) andfor confirm that your applization contans the requred deployment desarptors,

Path: foradata2ivwd1035/0racle/Middleware/user_projectaidomains/upg? 27 3/applications
Recently Used Paths: foradata2 v 1035/Orace Mddieware fuser_projects/domains/upg 7273 appiications
Current Location: 100184, 134.147 [ oradata2 [ wil035 [ Oracs f Middieware [user_projects [ domans [ upg 7273 [ appications

© L0 upg7273.ear (open drectory)

Neat | | Cancel

2. Click Next.

Figure C-14 Install Application Assistant

Install Application Assistant

Back | | Nexd | cancel

Choose targeting style
Targets are the servers, dusters, and virtual hasts on which this deployment will run. There are several ways you can target an appication.

@ 1nstall this deployment as an application
The spplicatian &nd its components will be targeted to the same lacations, This i the most common wsage.

() Install this deployment as a library
Appkcation libranes are deployments that are avadabls for ather deployments to share, Libraries shauld be available on 8l of the targets running ther referencng applications

Back | | Next | | Cancei
— }

3. From the Choose targeting style section, select the Install this deployment as an
application option and click Next.

The Optional Settings window is displayed.
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Figure C-15 Optional Settings

Install Application Assistant
Back | | Hext | | Finish l Cancel

Optional Settings
You can modify thase settings or accept the defadlts
General

What do you want to name this deployment?

Hame: upa7273

Security

Vihat sacunity moded 0o you want 1 use with ths apphoation?

(%) DD Only: Use only roles and policies that are defined in the deployment descriptors.

() Custom Roles: Use roles that are defined in the Administration Consale; use policies that are defined in the deployment
descriptor.

) custom Roles and Policies: Use only roles and policies that are defined in the Administration Console.

(3 Advanced: Use a custom model that you have configured on the realm’s configuration page.

Source accessibility

Hiw shiud the source fles be made accesshie?
(&) Use the defaults defined by the deployment’s targets

Recommended seleiton.
) Copy this apphcation ento every target for me

During dapinyment, the fles will be coped automancally to the managed servers ta which the apphoaton i targated.
O 1will make the deployment accessible from the following location

Location: foradata2iwl 1035/ 0racleMiddlewara/user_projects/domail

Frovide the location from where all targats wil access ths applicabon’s flles. This is often a shared directory. You must ensure the application files most n thes location and that each target can
readh the location.

Back | | ket | | Fiisn |r,‘anc¢.

4. Enter a Name for the deployment if required.

5. Under the Security section, select the DD only option to specify that only roles and
policies that are defined in the deployment descriptors should be used.

6. Select the I will make the deployment available from the following location option
under the Source accessibility section.

7. Click Next to continue.

The Deployment Summary window is displayed.
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Figure C-16 Deployment Summary

Install Application Assistant
Back Finish | | Cancel

Review your choices and click Finish
Chick Firish to complete the deployment, This may take a few moments to complete.
Additional configuration
In order to work succassfully, this application may require additional configuration. Do you want to review this appbcation's configuration after compieting this assistant?

(&) Yes, take me to the deployment's configuration screen.

() Mo, Twill review the configuration later.

— Summary
Deployment: foradatadfvd1035/Crace Modewane juser_projects/domans upg 7273 /applications fupg 7273.ear
Hame: T k]

Staging mode: Use the defaults defined by the chosen targets
Security Model: D0Only: Use only robes and polices that are defined in the deployment descriptors,
Target Summary
Components < Targets
upg7273.mar AdminGenyer
Back i Finish C.mcet_

8. Select the Yes, take me to the deployment's configuration screen option and click
Finish.

The Settings for <Deployment Name> window is displayed.
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Figure C-17 Settings for <Deployment Name>

Settings for upg?273

Overview | DepiaymentPlan | Configuration | Seqwrity | Tarpets | Control | Testng | Monitoring | Motes

Save

Uise this page to visw the gensral configuration of an Enterprise applcation, such as its name, the physical path to the appication fies, the assocated deployment pian, and so on. The table at
the end of the page ksts the madules (such as Web applications and EJBs) that are contared in the Entesprise application. Chik on the name of the module to view and update its configuration.

Hame: upg72T3 The name of this Enterprice Application.  More Info...
Path: [ oradatalf w1035/ Orade Mddleware usar_projects) domains/ upg 7273/ The path to the source of the deployable unit on the Administration
appications! Upg 7273, ear Server, More Info...
Deployment Plan: {no plan specfied) The path to the deployment plan document on Administration Server.  More
Info...
Staging Mode: (ot specified) les are copied from a

Se

ver's staging area

Security Model: DOOnly The security modal that is used to secure a deployed module.  More Info..,

#F] Deployment Order: 100 An nteger value that indcates when it 5 deployed, relative to other
deployable unts on & sarver, during 5% More Info...

.19 Deployment Principal A siring value that indicates what prinopal should be used whan deploying

Name: the file or archive during startup and shutdown. This iprincipal will be vised to

et the current sub) caling out nto appication code for interfaces
such a5 Apphcationif tenar. If mo principal name i specified, then
the anonymous principal will be used.  More Info...

Save
Hodules and Components
Showing 140 1of 1 Previous | Mext
Hame o Type
= Enterprise
Elungrzrz Agpikcation
EEks
(5 StateLassCacheBaanBean B
= Modules
)hesars Acpkcation
{Cjbeancache.jar £18
B web Services
Hone to dsplay

Showing 110 10f 1 Previous | Mext

9. Review the general configuration details of the deployment. You can also update the
configuration of the deployment in this window. In the Overview tab, you can view the
complete deployment configuration.

10. Click Save to update the changes, if any.
11. From the LHS menu, click Deployments.

The Summary of Deployments window is displayed.
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Figure C-18 Summary of Deployments

Summary of Deployments

Control | Maonitading

This page displays 8 ist of Java EE appications and stand-sione appication modules that hawve been mstalied to this doman, Instaled applicabons and modules can be started, stopped, updated
{redeployed), or deleted from the domain by first selecting the appication name and using the controls on this page.

To install & new application or module for deplayment to targats in this domain, dick the Install button,

W Customize this table
Deployments.

| Jnatal | | Update _E:elm Stari~ | Stop ¥ Showing 1to 10f 1 Previous | Mext

Servicing all requests

Senaang only adminstr 8500 reguests Skare. Heality L ey LS

Hame «

= | @ Pupgrzm

Active o oK Enterprisa Applcation 100

instat | | Upgate | Deiste | | Start~ | Stopv

Showing 1to 1of 1 Previous | Next

12. Select the newly deployed Infrastructure application and click Start > Servicing all
requests. Ensure that the Infrastructure server is up and running.

Figure C-19 Summary of Deployments

Messages
& Start requests have besn sent to the salectad Depioyments
Summary of Deployments

Control  Monitoring

Thes page displays 2 kst of Java EE appications and stand-glone appication modules that have been nstaled to this domain. Instalied apphcations and modules can be started, stopped, updated
{receployed), or deleted from the domain by first selecting the application name and using the controls on this page,

To install » new application or modute for deplayment to tarngets in this domain, dick the Instal button.,

P Customize this table
Deployments
| dmsted Shaving 110 16F1 Previous | Mext
[ | Hame & State | Health | Type Deployment Order
O | 8 Pugmzm Active ¥ or Enterprise Application 100

Showing 1to 1of 1 Previous | Mext

13. The State of the deployed application will be displayed as Active if started successfully.

Deploying Tomcat WAR Files on Tomcat

Before deploying the WAR files, ensure that the previously deployed applications of
Infrastructure are uninstalled. See Uninstalling Previously Deployed WAR Files in Tomcat for
the procedure to uninstall the previously deployed Infrastructure war files.

On the machine that hosts Tomcat, follow these steps to deploy Infrastructure application:

1. Copy the <context-name>.war from $FIC WEB HOME/<context-name.war> to
<Tomcat Installation Directorys/webapps/ directory.
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Figure C-20 Tomcat Home Page

Heme Deocumentation Configuration Wiki Mailing Lists Find Help

Apache Tomcat/7.0.19 R, o

http:/fwww.apache.org/

Recommended Reading:

Server Status
Security Considerations HOW-TO
Manager App
Manager Application HOW-TO Vrnesiter sl 2P -
Clustering/Session Replication HOW-TO Host Manage

Developer Quick Start

Tomeat Sowp Realms & AAA Serelet Examples Servlet Specifications
Elrst Web Application JREC Data Sources JSP Examples Tomcai Verslons
Managing Tomcat Documentation Getting Help
For security. access 1o the manager webapo is Tomeat 7.0 Documentation FAQ
restricied. Users are gefined in
Tomeat 7.0 Configuration Mailing Lists
SCATALINA_HOME(cenf/comeac-users. =l Tomcat Wiki The folicwing mailing ists are availabie
in Tomcat 7 0 access to the managsr Find addtional mportant configuration
applcalion is spil between different users, Infamation n Impartant nlnsu;u;q-mmﬂn, rﬂm::'?-:, socuity
wlperability notificatons, (Lo vohsme).
Bead mgie SCATALINR HOME/RINNING.txt
usgrs@lomeal apache org
Release Notes Developers may be interested in User support and discussion
Changelog Tomeal 7.0 Bua Database tagibs-umergrmeat snache org
Migration Guide Uiser support and discussson for Apactve Taglibs
Migration Lulde
Tomeat 7.0 Javaliocs
Secuy Updates dEvitomealagachs. o
Tomeal 7.0 SVN Repassars Drgverapament mailing kel inciuding commit

MESSFJE5

2. Click Manager App. The Connect to dialog box is displayed.

3. Enter the User Id and Password that has admin rights and click OK. (For user creation in
tomcat, see Tomcat User Administration. The Tomcat Web Application Manager window
is displayed with the list of all the applications deployed.
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Figure C-21 Tomcat Web Application Manager

- ==
[ with idle = 30 minutes
Star
withigle= 30 minutes
Star Undeploy
-w;l\ idle = 30 minutes.

Start Stop Reload Undeploy
None specified Tomeat Manager Application true k| [ = 5
Imanager wihidle=30  minutes

idocs | None specified Tomcat Documentation true )

lexamples. None specified Sendet and JSP Examples tue [}

| most-manager | None specified Tomeat Host Manager Application true 0

Deploy directory or WAR file located on server
Context Path (required): fofsaai

XML Configuration file URL:
WAR or Directory URL: 5aawebMCCKBOHOMEMowebiofsaaiwar
| WAR file to deploy
Select WAR flle o upload

Check toseeita a stop,
Findleaks This diagnostic check will trigger a full garbage collection. Use it with extreme caution on production systems.
| Tomcat Version JVM Version SV Vendor 05 Hame 05 Version 05 Architecture Hostname 1P Addre|
Apache Tomcal7 0.57 | 1.6.0_45-006 Sun Microsystems Inc. ‘ Linw: | 26,39-400.211.1.el6uek xB5_64 [ amas4 | 015£220354.in oracle com 10.184.13

Copynght © 1999-2014, Apache Software Foundabion

4. In the Deploy section, enter the Context Path provided during the installation as
"/<context-name>".

5. Enter the path where the <context-name>.war file resides (by default "$SFIC WEB_
HOME/<context -name.wars") in the WAR or Directory URL field and click Deploy.

6. On successful application deployment, a confirmation message is displayed.

Start the Tomcat server. Refer Starting Infrastructure Services for more details.
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Starting / Stopping Infrastructure Services

This section details about how to start and stop Infrastructure services. This appendix covers
the following topics:

> Starting Infrastructure Services

> Stopping Infrastructure Services

> Cleaning up the environment

Starting Infrastructure Services

Once the installation of Infrastructure has been completed successfully and the post-installation
steps are completed, the servers must be started. Log on to each machine and run the .profile
file. All servers mentioned must be started from the same shell encoding. The following servers
mentioned are dependent on each other. It is mandatory to maintain the order in which the
servers are started. Allow each of the servers to initialize completely before starting the next

SCrver.

1. On the machine in which Infrastructure Application components have been installed,
navigate to SFIC_APP HOME/common/FICServer/bin and execute the following
command to start the Infrastructure Server.

./startofsaai.sh

Note: You can also start the Infrastructure Server by executing the
command "nohup ./ startofsaai.sh &". Starting the process using "nohup" and
"&" will return the command prompt without having to wait till the process
completes. However, this command cannot be used when you are starting the
server for the first time or starting after changing user password in the
configuration database schema.

2. Start ICC server:

2

On the machine in which Infrastructure default Application components have been
installed, navigate to $SFIC_HOME/ficapp/icc/bin

Execute the command:

./iccserver.sh

Note: Only Infrastructure Default Application Server would hold ICC
component.
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3. Start Back-end Services:

> On the machine on which Infrastructure Database components have been installed,
navigate to SFIC_DB_HOME/bin and execute the command to start "Agent server":

./agentstartup.sh
Or
> Start Back-end services using the command:

nohup ./agentstartup.sh &

Note: This agent internally starts the Router, Message Server, OLAP data
server and AM services:

Starting Web Application Servers

Start the Web Application Server depending on the type from the following table.

Table D-1 Webserver start up options

Start up Option Description

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to
[Webshpere Install Directory]
/BAppServer/<profiles>/<profile name>/bin and execute the
command: ./startServer.sh serverl

Starting WebLogic Domain On the machine in which WebLogic is installed, navigate to
<WebLogic Installation directorys/user_
projects/domains/<domain name>/bin and execute the command:
startWebLogic.sh -dé64

Note: If WebLogic is already running, access the WebLogic Admin
Console. Stop and start the application <context name>.ear

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to <Tomcat
Install_ Directory>/bin and execute the command:
./catalina.sh run

Stopping Infrastructure Services
To stop Infrastructure services, follow these steps:

1. On the machine in which Infrastructure Application components have been installed,
navigate to SFIC_APP HOME/common/FICServer/bin and execute the command:.

./stopofsaai.sh

2. To stop ICC server, on the machine in which Infrastructure default Application
components have been installed, navigate to $SFIC_HOME/ficapp/icc/bin and execute
the command:

./iccservershutdown.sh

Note: Only Infrastructure Default Application Server would hold ICC
component.

3. To stop Back-end server, on the machine in which Infrastructure database components
have been installed, navigate to $FIC_DB HOME/bin and execute the command:
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. /agentshutdown.sh

Cleaning up the environment
To clean up the environment, follow these steps:
1. Navigate to SFIC_HOME
Execute . /Uninstall.sh.
When prompted, enter OFSAAI configuration schema password.
This will delete $FIC_HOME and drop all the objects from configuration schema
Navigate to ftpshare folder.

Delete the infodom folders $ rm -rf <INFODOM>.

N o o 2 0N

Drop configuration and atomic schemas from the database
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Accessing OFSAA Application

This section gives details the steps to be performed to access OFSAA Application.

Access the OFSAA Application

1. From your desktop, open the browser and enter the URL in the following format:
<scheme>://<IP address/ hostname>:<port>/<context-name>/login.jsp
For example, https://111.222.333.444:5555/ofsaa/login.jsp
The OFSAA login screen is displayed.

Figure E-1 OFSAA Login Window

Language US-English v
User ID |
Password

& -
[LLoon | ORACLE"

2. With installation of every OFSAA Applications Pack, there are two seeded user profiles
configured in the system:

"SYSADMN - System Administrator
"SYSAUTH - System Authorizer
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Note: For SYSADMN and SYSAUTH, the default password is password0.

1.  Login to the application using the "SYSADMN" User ID. (Note that, there is no "I" in the
SYSADMN login USER ID). Enter the password that was provided during installation. On
the first login, you will be prompted to change the password.
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Cloning OFSAA Instance

There is a consistent need for a faster and effective approach of replicating an existing OFSAA
instance for further project developments, that is, setting up OFSAA instances that are exact
copies of the current OFSAA instance. For more information on cloning, refer OFSAA Cloning
Reference Guide.
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OFSAA Landing Page

This section includes the following topics:
> OFSAA Landing Page

> Enabling a Product within an Applications Pack

OFSAA Landing Page

On successful authentication, the OFSAA 8.0 Landing Page is displayed. This is a common
landing page for all users until a preferred application landing page is set by the user in his
preferences.

The landing page includes multiple tabs and each tab has specific links to OFSAA
Infrastructure and/or Application modules. The tabs and links are displayed based on the
OFSAA Application accessed and the access roles mapped to the logged in user.

Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link (s) to modules in a
tree structure. The RHS Menu holds link(s) to modules in a navigational panel format.

The following tabs are available in the Landing Page:

> Applications Tab

> Sandbox Tab

> Object Administration Tab

> System Configuration and Identity Management Tab
> Inbox Tab

Applications Tab

This tab lists the various OFSAA Applications that are installed in the setup.

The "<Select Application>" dropdown lists the OFSAA Applications based on the user logged
in and User Group(s) mapped to OFSAA Application. Selecting an Application from the drop
down refreshes the menus/ links.

Sandbox Tab

This tab lists the various OFSAA Sandboxes created in the setup.

The "<Select Sandbox>" dropdown lists the OFSAA Sandboxes based on the user logged in
and User Group(s) mapped to OFSAA Application.

Selecting a Sandbox from the drop down would refresh the menus/ links.
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Object Administration Tab

This tab lists the various OFSAA Information Domains created in the setup.

The "<Select Information Domain>" dropdown lists the OFSAA Information Domains based
on the user logged in and User Group(s) mapped to OFSAA Application.

Selecting an Information Domain from the drop down refreshes the menus/ links.

System Configuration and Identity Management Tab

This tab lists the OFSAA Infrastructure System Configuration and Identity Management
modules. These modules work across Applications/ Information Domains and hence there are
no Application/ Information Domain dropdown list in this tab.

Note: NOTE: Refer the User Manual for more details on how to operate on
each tab.

Inbox Tab

This tab is not used for OFS BD applications. To hide this tab from the Landing Page, execute
the following script in the Config Schema:

update aai menu b tl set tl.v_access code='INBOXLINK' where
tl.v_menu id='OFS_ INBOX MYTASK'

Enabling a Product within an Applications Pack

You can also enable a product/ application within an Applications Pack post installation at any
point of time.

To enable a product through the application UI, follow these steps:

1. Login to the application as SYSADMN user or any user with System Administrator
privileges.

2. Navigate to System Configurations & Identity Management tab and expand Financial
Services Analytical Applications Infrastructure >> Administration and Configuration >>
System Configuration.

3. Click Manage OFSAA Product License(s)

4. The Manage OFSAA Product License(s) page is displayed as below.
This page includes the following sections:
> INSTALLED Applications PackS
> PRODUCTS IN THE Applications Pack
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Figure G-1 Manage OFSAA Product License(s) Page

Financial Services n and Configuration > System Ct > Manage OFSAA Product License(s)
» INSTALLED APPLICATION PACKS

APPLICATION PACK ID APPLICATION PACK NAME DESCRIPTION INSTALL DATE

@ OFS_AAALPACK Financial Services Advanced Analytics Infrastructure Pack ;fﬁ::f:ﬁgﬂ,’:;‘ig“"m Analytics using Oracie R, Modeling & Stress Testing Framework and Inline 5.4 1> 45 14.22:33.0
; 5 Apphcaions for Basel Basic, IRB & Analylic, Operational Risk Economic Capital & Analylc and Retail .
OFS_CAP_ADQ_PACK Financial Services Capital Adequacy Applications Pack Portiolio Risk Models and Pooling in Banking and Financial Services Domain 2014-12.02 17:59:58.0
» PRODUCTS IN THE APPLICATION PACK

ENABLE | PRODUCT ID PRODUCT HAME DESCRIPTION ENABLE DATE

OFS_AAAI Financial Services Enterprise Modeling Base Infrastructure for Advanced Analytical Applications 2014-12-0214:22:33.0
v, OFS_IPE Financial Services Inline Processing Engine Framework for Inline Processing Engine
| | RESET

5. The following fields are displayed in the INSTALLED Applications PackS section:

Table G—1 Installed Applications Pack - Field Description

Field Description
Applications Pack ID Displays a unique Applications Pack ID related to the Applications
Pack.

Select the appropriate Pack id using the radio button. The Products in
the Applications Pack will be displayed below in the PRODUCTS IN
THE Applications PackS section.

Applications Pack Name Displays the name of the Applications Pack.
Description Displays the description of the Applications Pack.
Install Date Displays the date when the Applications Pack was installed.

6. The following fields are displayed in the PRODUCTS IN THE Applications Pack section:

Table G-2 products in the Applications Pack - Field Description

Field Description

Enable Select the checkbox to enable a product within an Applications Pack.
Product ID Displays a unique product id for the product.

Product Name Displays the name of the Product.

Description Displays the description of the product.

Enable Date Displays the date when the product was enabled.

7. Select an Applications Pack by clicking the radio button next to the Applications Pack ID
field.

8. Selecting an Applications Pack will display below the products within the Applications
Pack.
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9. Products which were enabled at the time of installation will have the checkbox “ENABLE”
disabled. You can enable any product within the selected Applications Pack by clicking the
“ENABLE” checkbox against the respective Product ID.

10. Click on RESET button to cancel the operation and refresh the screen.
11. Click VIEW LICENSE AGREEMENT button.

The License Agreement section is displayed.

Figure G-2 License Agreement

» LICENSE AGREEMENT
Oracle Financial Services Enterpnse Modeling Option (OFS AAAI) product is a separately licensable product and would not be enabled unless it has been licensed. Oracle .
Financial Services Enterprise Modeling Option (OFS AAAI) product is only part of the Oracle Financial Services Advanced Analytics Infrastructure Pack and specific OFSAA
Application Packs that require the advanced analytical features of this product. Oracle Financial Services Enterprise Modeling Option (OFS AAAI) product gets pre-selected
automatically on selecting any of the ofsaa products within a specific Application Pack that require this product to be enabled and configured
Multiple products being grouped together under a Application Pack, mandate installation and configuralion of these products by default. However, during the Application Pack
instaliation, based on the products that are being selected, it would get enabled and would be licensed for. It is important to note that products once selected (enabled) cannot be
disabled at a later stage. However, products can only be enabled at any later stage using the OFSAA Infrastructure "Manage Application Pack License” feature.

Enabling a product within a Application Pack automatically implies you agree with this license agreement and the respective terms and conditions.

@) | ACCEPT THE LICENSE AGREEMENT
1 DO NOT ACCEPT THE LICENSE AGREEMENT

ENABLE

12. Select the option |l ACCEPT THE LICENSE AGREEMENT.
13. Click ENABLE.

14. An appropriate pop-up message confirmation is displayed showing that the product is
enabled for the pack.

Note: To use the newly enabled product, you need to map your application
users to the appropriate product specific User Group(s) and subsequently,
authorize the actions by logging in as System Authorizer.

Note:

> For more information refer to Mapping/Unmapping Users section in the
Oracle Financial Services Analytical Applications Infrastructure User
Guide 8.0.

> To identify the newly enabled product specific UserGroups/ Applications
Pack specific User Groups, refer to the respective Applications Pack
specific Installation and Configuration Guide/ User Manual.
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Additional Configuration

This section gives detailed information about the Additional Configuration regarding OFSAA
Installation.

Additional Configuration

This section covers the following topics:

?

?

?

FTP/SFTP Configuration for File Transfer
Configure Infrastructure Server Memory
Internet Explorer Settings

OLAP Data Server Configuration

Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance
OFSAALI Setup Information Fetching Tool
Encryption Changer

Infrastructure LDAP Configuration

Configure OFSAAI Web Services

Deploy OFSAAI Web Services

Configure Message Details in Forms Designer
Clearing Application Cache

Configuring Passwords Changes

Configure Internal Service (Document Upload/ Download)

FTP/SFTP Configuration for File Transfer

In OFSAA, certain modules require transfer of files from the web application server to the
OFSAA server over SSH.

Follow these steps to ensure the OFSAA server recognizes the web application server during
file transfers.

1.
2.
3.

Login to the web application server.
Type sftp <user>@<OFSAA Servers>

Specify Yes when prompted for permission.

Are you sure you want to continue connecting (Yes/No)?
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4. This will add an entry into the "known_hosts" file.
5. A confirmation message is displayed:

Permanently added <OFSAA Server> RSA) to the list of known hosts.

Configure Infrastructure Server Memory

The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and WebLogic
can be edited for customizing memory settings and garbage collector settings depending on the
available hardware configuration as explained below. These settings are base minimum and has
to be incremented considering the deployment metrics into account. The increments are usually
handled in multiples of 128mb for heap and 64mb for stack.

Infrastructure Application Server Memory Settings

You can configure the Infrastructure Application Memory settings as follows:
1. Locate .profile file.

2. EditX ARGS field in this file for customizing memory settings and garbage collector
settings depends on the hardware configuration.

This has a default value X_ARGS="-Xms200m"

X ARGS=" "$X ARGS" $DELIM -Xmx2048m"

Note: This parameter is modified in 7.3.2 IR and you need to modify X_
ARGS_APP variable in the .profile file to customize Java Memory Settings
for Model Upload based on the Data Model size.

For Run and Rule executions, the following value is recommended:

X ARGS RNEXE="-Xmslg -Xmxlg -XX:+UseAdaptiveSizePolicy
-XX:MaxPermSize=512M -XX:+UseParallelOldGC
-XX:+DisableExplicitGC"

X ARGS RLEXE="-Xmslg -Xmxlg -XX:+UseAdaptiveSizePolicy
-XX:MaxPermSize=512M -XX:+UseParallelOldGC
-XX:+DisableExplicitGC"

Internet Explorer Settings

Note: OFSAAI supports only default zoom setting in Internet Explorer, that
is, 100%.
Cookies should be enabled.

The following browser settings have to be specified at every client machine prior to accessing
the Infrastructure application.

1. Open Internet Explorer. Select Tools > Internet Options. The Internet Options window
is displayed.

2. Click the Settings button. The Settings window is displayed.
3. Select the option Every time I Visit the webpage and click OK.

H-76 OFS BD Application Pack Installation and Configuration Guide



Additional Configuration

Figure H-1 Internet Options
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4.

In the Internet Options window, select the Security tab and select the Internet option

under Select a zone to view or change the security settings.

5. Click Default Level under Security level for this zone.
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Figure H-2 internet Options
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Click OK to save.

Click Internet Explorer >> Tools >> Compatibility View Settings.
Enter the OFSAA setup URL in the Add this website ficld.

Click Add.

© ® N o

10. Ensure the URL is listed under Websites you've added to Compatibility View.

11. In the Internet Options window, select the Privacy tab and select the Turn on Pop-up
Blocker option under Pop-up Blocker settings.
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Figure H-3 Internet Options- Popup Blocker Settings
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12. Click Settings. The Pop-up Blocker Settings window is displayed.

13. Enter the URL of the OFSAA Application in the Address of Website to Allow: field.
14. Click Add. The OFSAA URL is displayed in the Allowed Sites section.

15. Click Close.

16. Click OK in the Internet Options window.

Retrieve Patch Information
To identify the list of patches installed on your OFSAA setup, follow these steps:

1. Login to the OFSAA application as a user with Object AdminAdvanced Role.
2. Navigate to Object Administration tab.

3. Click System Ultilities.

4. Click Patch Information.
5

The page displays the list of patches installed on the OFSAA setup across Applications/
Platform.

OLAP Data Server Configuration
This section is applicable if you are using the OLAP feature of OFSAALI

The following parameters must be set to ensure that the system limitations are not exceeded at
any stage. The values for these OS parameters should be specified based on the expected load
at each implementation site.
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Example:

Process Memory Limit

Max Thread Stack Size

Max Number of Threads per Process

> Sort Buffer settings: This must be set at the Essbase application level appropriate to the
anticipated load.

> Shutdown and Restart: During shutdown of OFSAAI Server that has an instance of Data
Services that is communicating with an OLAP Data Server, it is imperative to ensure that
the cleanup of the old instance is completed on the OLAP Data Server before restarting the
OFSAALI Server. Pause for a period of time based on the load the system was subjected to,
before restarting the Data Services subsystem.

Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance

For information on this section, refer OFS Analytical Applications Infrastructure
Administration User Guide in OTN.

OFSAAI Setup Information Fetching Tool

Executing the SetupInfo.jar file available in the FIC_HOME path will help you retrieve the
related information about the OFSAAI Set up such as Operating System Name and version,
Database Type and Version, OFSAALI architecture, Log file locations and so on.

To execute "SetupInfo.jar" in console:
1. Navigate to the path $FIC_HOME.
2. Enter the command:

java -jar SetupInfo.jar

After execution, the output file location is displayed in the console.

Encryption Changer

This utility helps you to regenerate the new AESCryptKey.ext file and encrypt all the
encrypted values of the OFSAAI setup according to the new key.

To execute EncryptC.jar in console:
1. Navigate to the path $FIC_HOME.
2. Enter the command:
java -jar EncryptC.jar
A confirmation message is displayed after execution.

Once executed, you need to create and deploy the EAR / WAR file depending on the configured
Web Application Server. For more information, refer Appendix C.

Infrastructure LDAP Configuration

H-80

This provides you with the option of using LDAP (Lightweight Directory Access Protocol)
authentication or Infrastructure SMS authentication for logging on to Infrastructure.

If you are using the Infrastructure authentication, the user and user group details, profile
creation, function and role maintenance and other mappings can be done through the
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Infrastructure Administration module under Security Management. The data in this case, will
be updated in the CSSMS table.

However, if you wish to use LDAP for user authentication, then you have to ensure that the
LDAP server is installed and configured. Also make sure that OPEN LDAP 2.2.29+ is installed
and configured in Windows machine. Before doing the following configuration, it is required to
select the "Authentication type" as LDAP in the Configuration screen of Infrastructure. This
screen can be accessed by selecting System Configuration > Configuration in the LHS menu of
Infrastructure. In the Windows machine in which LDAP Server is installed, go to the
OpenLDAP installation directory through the command prompt and execute the command
"slapd -d 1" to start the LDAP server.

Configure Infrastructure "Configuration Schema"

In the Infrastructure "configuration schema", ensure the following entries in Configuration
Table.

Table H-1 Configuration Schema

PARAMNAME Description PARAM Value Example
AUTHENTICATIONTYPE Authentication type 3 - AUTHENTICATIONTYPE value
must be 3 for LDAP
ROOTCONTEXT The Root Context for the dc=<OFSAA>, dc=<com>
LDAP Directory
ROOTDN The Root dn for LDAP cn=<Manager>, dc=<Reveleus>,
directory dc=<com>
ROOTPASS Password for the Root <secret>
LDAPURL LDAP URL <ldap://10.11.12.13.1234/>
LDAP_SSL MODE LDAP in SSL Mode N for non - SSL and Y for SSL
HASHPASS Should the user password |FALSE or TRUE.
be Hashed

When HASSPASS is set as FALSE, we
need to have the ROOTDN value as
"uid=ORCLADMIN, ou =Users,
dc=0FSAAI, dc=com". ORCLADMIN is
a dummy user, it will be replaced
dynamically with the logged in user.

When HASSPASS is set as TRUE, we
need to have the ROOTDN value as
"en=orcladmin, cn=Users,
dc=1-flex,dc=com" and proper
oracladmin LDAP password as
ROOTPASS. First OFSAAI connects to
LDAP directory using orcladmin user
and fetches the login user details and
verifies the entered password.

RETRIEVE DN To retrieve Distinguished TRUE
Name

Note: ROOTCONTEXT, ROOTDN, and ROOTPASS entries should be
same as in the slapd. conf file.
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Configure OpenLDAP Files

1.

Copy the reveleusSchema. schema from <Infrastructure Installation
Directory> /ficapp/common/FICServer/conf/LDAP LDIF folder to LDAPServer
Schema folder.

Copy the Domains.1dif and Reveleus.ldif files from <Infrastructure
Installation Directorys/ficapp/common/FICServer/conf/LDAP LDIF folder to
OpenLDAPServer folder.

Note: Make sure that the ROOTCONTEXT in the Domains.1dif and
Reveleus.1dif files are the same as slapd. conf file.

Provide the appropriate entries for ROOTDN, ROOTPASS, and ROOTCONTEXT in
slapd.conf file in the OpenLDAPServer folder.

Add the text "include schema/reveleusSchema.schema" as the first line of the slapd. conf
file

Note: The above steps of the configuration are for OpenLDAP Server only.
If you need to configure Infrastructure for any other LDAP Server, you will
have to make the changes appropriately.

In the command prompt, navigate to the LDAP installation directory and execute the
command "ldapadd -D"ROOTDN" -w ROOTPASS -f/data/Reveleus.ldif"

This is for creating the entries for Users, User Groups, Functions, Profiles, Segments,
Domains, Roles, and HolidayMaster in the Data information Tree of LDAP.

Make an entry in the Domains.1dif file for each Information Domain that is created
through the Infrastructure UL

To add an entry corresponding to the new Information Domain to the Domains.1dif file, add
the following block of text with the appropriate values:

Note: DSNID refers to Information Domain name.

dn: DSNID=<DSN ID>,ou=Domains,@LDAP DIRECTORY ROOTCONTEXT@
changetype: add

mappedsegments: <Mapped segments/~>

dsnid: <DSN ID>

infodomname: < Information Domain Namex>

objectClass: Infodom

objectClass: top

infodomdescription: < Information Domain Description>

Example:

dn: DSNID=FUSIONMOCK, ou=Domains, dc=FTP1l,dc=com
mappedsegments: ~

dsnid: FUSIONMOCK
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infodomname: FUSIONMOCK
objectClass: Infodom
objectClass: top
infodomdescription: FUSIONMOCK

Then, navigate to LDAP installation directory and execute the command "D"ROOTDN" -w
ROOTPASS -f/data/Domains.ldif"

Note: You can add entries for multiple Information Domains at the same
time.

Migrate Data from CSSMS tables to LDAP server

If you are using LDAP authentication, it is required to migrate all the details from the CSSMS
table, which contains the information entered using the Infrastructure Administration module
under Security Management to the LDAP Server.

To migrate data from CSSMS tables to LDAP server:

1. Invoke the LDAP Migration.sh file in SFIC HOME/MigrationUtilities/Migration
LDAP/ bin folder. The Select Source & Destination for Migration window is displayed
with the option to migrate the data from SMS to LDAP or vice versa.

Figure H-4 Select Source & Destination for Migration

=Select Source & Destination for Migration—

LDAP To SMS
' SMS To LDAP

Ok Close

2. Select the SMS to LDAP option and click OK. The Select Entities to Migrate window is
displayed.
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Figure H-5 Select Entities to Migrate
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You can select the data that you wish to migrate such as Users, User Groups, Functions,
Roles, Segment, Profiles, Holiday Master, Function Role Maps, User - User Group Maps,
User Group Role Map, and User Group- Domain Map.

3. Select the entities that you wish to migrate and click Migrate. The data is migrated and a
confirmation dialog is displayed.

You can verify the data migrated to LDAP server through the LDAP Browser.

Note: You should also enter the passwords for all the users as passwords
are not migrated in migration process.

Configure OFSAAI Web Services

Web Services in OFSAAI is meant for exposing a web service to "asynchronously" or
"synchronously" execute requested tasks offered by OFSAAI The configuration steps given
below are to be done only if you are using the Web Services feature of OFSAAL

Configure DynamicWSConfig.xml File

For each third party web service that needs to be accessed using the OFSAAI Web services
framework and the operations to be invoked, corresponding entries are to be made in the
DynamicWSConfig.xml template file.

The variable <WebServer> denotes any one of the application server, i.e. WebSphere,
WebLogic, or Tomcat.

The DynamicWSConfig.xml file will be available in the <OFSAAI Installation
Directory>/EXEWebService/ <WebServers>/ROOT/conf directory. This file can be placed
in any directory that is accessible by the application and this location must be specified in the
web.xml file, as WSCONFIGFILE parameter.
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The DynamicWSConfig.xml template file will be in <WebServer Deployment Paths/
EXEWebService.ear/EXEWebService.war/conf directory

This template is given below:
<XML>
<WEBSERVICES>
<WEBSERVICE CODE="$CODE"
ENDPOINT="$ENDPOINT" TARGETNAMESPACE="$TARGETNAMESPACE"
XMLNS_ XSD="$XMLNS XSD" ENCODINGSTYLE="$ENCODINGSTYLE"
SERVICENAME="$SERVICENAME" PORTTYPENAME="$PORTTYPENAME"
SESSION MAINTAIN PROPERTY="$SESSION MAINTAIN PROPERTY"
USERNAME="SUSERNAME"
PASSWORD="$PASSWORD" STYLE="SWEBSERVICESTYLE"
STUBIMPLEMENTATION="$STUBIMPLEMENTATION" >
<OPERATION CODE="$CODE"
NAME="$NAME"
SOAPACTION="$SOAPACTION"
STYLE="$STYLE"
PACKAGENAME="$PACKAGENAME" >
<INPUT ORDER="$ORDER"
PARAMNAME="$PARAMNAME"
ARGTYPE="$SARGTYPE"
CLASSNAME="S$CLASSNAME" />
<OUTPUT PARAMNAME="$PARAMNAME"
RETURNTYPE="$SRETURNTYPE"
CLASSNAME="S$CLASSNAME" />
</OPERATION>
</WEBSERVICE>
</WEBSERVICES>
</XML>

The DynamicWSConfig.xml has the placeholders as tabulated below. These have to be updated
depending on the web service chosen and the mode of accessing it. For each Web service to be
accessed, the entire webservice tag in the DynamicWSConfig.xml file must be repeated. The
placeholders tabulated below should be set in accordance to the parameters published in the
third party wsdl files (webservices) to be accessed. The stub class specified must implement
the "com.iflex.Oracle Reveleus.execution.webservice.EXEWebIF" interface.

Attributes for WEBSERVICE tag
Table H-2 WEBSERVICE tag

Placeholder Description

$CODE Unique number within the xml file and cannot be 999 or 0.
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Table H-2 (Cont) WEBSERVICE tag

Placeholder

Description

$ENDPOINT soap: address location in the wsdl: service name tag of the
wsdl file.

$STARGETNAMESPACE The attribute value for the targetNamespace of the wsdl:
definitions tag.

$XMLNS_XSD The attribute value for the xmlns:s of the wsdl:definitions tag

$ENCODINGSTYLE The attribute value for the xmlns: soapenc of the
wsdl:definitions tag.

$SERVICENAME Name of the service found under the wsdl:service name tag of
the wsdl file.

$PORTTYPENAME wsdl port type name as mentioned in the wsdl file.

$SESSION MAINTAIN PROPERTY

nn

This could be given as "" also.

SUSERNAME User name to access the web services. Enter "" if no user name is
required.

$PASSWORD Password to access the web services. Enter "" if no password is
required.

SWEBSERVICESTYLE This can take either "rpc" in case of DII mode of invoking web
services or "stub" in case of static mode. This is a mandatory
parameter.

$STUBIMPLEMENTATION Fully qualified class name (package name .classname).

Attributes for OPERATION tag

Ensure that the "operation tag attributes" are repeated for each of the operation tags.

Table H-3 OPERSTION tag

Placeholder Description

$CODE Should be unique within the Webservice tag.

$SNAME The name of the Function that is to be called by the wsdl file.

$SOAPACTION The URL for the Operation to access. This is associated with the
Operation tag of the wsdl file.

$STYLE This can take "rpc" if the web services invoking is in DII
mode or "stub" if it is in static mode. This is a mandatory
parameter.

$SPACKAGENAME Represents the JAXB package of input object.

Attributes for INPUT tag

Table H-4 INPUT tag

Placeholder Description

$SORDER The sequential number of the INPUT tag. Should start
from 0. This is in line with the input order of the
arguments that the API accepts which is called by this
operation.

$PARAMNAME Input parameter name to be called by the wsdl file.

$ARGTYPE Input Parameter Data Type. If the input argument type is
complex object, specify SARGTYPE as "xmlstring".
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Table H-4 (Cont) INPUT tag

Placeholder Description

$CLASSNAME Represents class name of input object parameter.

Attributes for OUTPUT tag
Table H-5 OUTPUT tag

Placeholder Description

$PARAMNAME Output parameter name to be returned by the web
service.

SRETURNTYPE Output parameter Data Type. If the web service response is a

complex object, then specify SRETURNTYPE as "object".

$CLASSNAME Represents class name of output object parameter.

web.xml Entries

1. This step is optional and required only if the web application server used is Tomcat. In
case of any other application server, skip and proceed with next step.

Navigate to SFIC_HOME/webroot /WEB-INF/ and edit the web.xml file. Set parameter
value DOCSERVICEAPP to EXEWebServiceAXIS.

2. Navigate to <OFSAAI Installation
Directory>/EXEWebService/<WebServer>/ROOT/WEB- INF/ and edit the web.xm]l file
as explained below.

Note: In case of Java 7 when WebLogic is used as web application server
replace following line of <OFSAAI Installation
Directory>/EXEWebService/Weblogic/ROOT/WEB-INF/web.xml file
that is

<?xml version='1.0' encoding='UTF-8'?>

<web-app id="WebApp ID" version="3.0"
xmlns="http://java.sun.com/xml/ns/javaee"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http://java.sun.com/xml/ns/javaee

http://java.sun.com/xml/ns/javaee/web-app 3 0.xsd"
metadata-complete="true">

with
<?xml version='1.0' encoding='UTF-8'?>
<web-app xmlns="http://java.sun.com/xml/ns/j2ee"

xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

Entry for WSConfig File

The WSCONFIG file (DynamicWSConfig.xml) is available in the <WebServer Deployment
Path>/ EXEWebService.ear/EXEWebService.war/conf directory. This file can be placed in any
directory that is accessible by the application.
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The path where the WSCONFIG file is placed must be specified in place of
$WSCONFIGFILELOCATIONS in the below block of text in web.xml.

<context-param>

<description>WebServices Configuration File</description>
<param-name>WSCONFIGFILE</param-name>
<param-value>$WSCONFIGFILELOCATIONS</param-values>
<!--Specify the Location of DynamicWSConFig.xml-->

</context-param>

Proxy Settings

The following block of text in web.xml file, replace the <param-value> given in bold below
with appropriate values.

If no values are required, leave the <param-value> blank.
<context-param>
<description>http Proxy Host</description>
<param-name>http.proxyHost</param-name>
<param-value>$PROXYHOST$</param-value>
<!-- Specify the IP address or hostname of the http proxy server--»>
</context-param>
<context-param>
<description>http Proxy Port</description>
<param-name>http.proxyPort</param-name>
<param-value>$PROXYPORTS</param-value>
<!--Port Number for the Proxy Server-->
</context-param>
<context-param>
<description>http proxy UserName</description>
<param-name>http.proxyUserName</param-name>
<param-value>$PROXYUSERNAMES</param-value>
<!-- User ID To get authenticated by proxy server-->
</context-param>
<context-param>
<description>http proxy Password</description>
<param-name>http.proxyPassword</param-name>
<param-value>$PROXYPASSWORDS</param-value>
<!-- User Password To get authenticated by proxy server-->
</context-param>

<context-param>
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<description>http non-ProxyHosts</description>
<param-name>http.nonProxyHosts</param-name>
<param-value>$NONPROXYHOST$</param-value>

<!--Hosts for which the proxy settings should get by-passed (Note:
Separate them by "|" symbol) -->

</context-param>

OFSAAI Home Entry

This entry should point to the Application layer / Web layer of the OFSAAI installation and
should be accessible.

Replace SFIC_HOMES in the following block of text in web.xml with <WebServer
Deployment Path>/EXEWebService.ear/EXEWebService.war.

<context-param>
<description>OFSAAI Web Home</description>
<param-name>FIC HOME</param-name>
<param-value>$FIC HOMES</param-values
<!--OFSAAI Installation Folder--»>

</context-param>

<context-param>
<description>OFSAAI Web Home</description>
<param-name>FIC PHYSICAL HOME</param-name>
<param-value>$FIC HOMES</param-values
<!--OFSAAI Installation Folder--»>

</context-param>

DynamicWSConfig.xml

For each third party web service that needs to be accessed using the OFSAAI Web services
framework, and the operation to be invoked, make corresponding entries into this file. This file
is to be placed in the location that is specified in the web.xml, as WSCONFIGFILE parameter.

Deploy OFSAAI Web Services

You can deploy OFSAAI Web Services separately if you had not configured OFSAAI Web
Services as part of the installation.

1. Complete the manual configuration of OFSAAI Web Services.

2. Navigate to <OFSAAI Installation Directorys>/EXEWebService/<WebServers and
execute the command:

./ant.sh
This will trigger the EAR/WAR file creation, which is required for the deployment.
3. Deploy the generated EXEWebService.EAR/EXEWebService.WAR file into the WebServer.

If you have already configured OFSAAI Web Services as part of the installation, deploy the
generated EXEWebService.EAR/ EXEWebService.WAR file into the OFSAAI Deployment
area in WebServer profile.
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Configuration to Enable Parallel Execution of DML statements

A configuration file, OracleDB.conf has been introduced to accommodate any configurable
parameter related to operations on oracle database. If you do not want to set a parameter to a
specific value, then the respective parameter entry can be removed/commented off form the
OracleDB.conf file which resides in the path SFIC DB _HOME/conf.

As of now, the OracleDB.conf file has only one parameter namely CNF_DEGREE OF
PARALLELISM. This parameter indicates the degree of parallelism to be used for a DML
operation if parallel DML is explicitly enabled in the session with the ENABLE PARALLEL
DML clause of the ALTER SESSION statement. The default mode of a session is DISABLE
PARALLEL DML. If CNF_DEGREE_OF PARALLELISM is not set, then the default degree,
as decided by Oracle will be used.

Configure Message Details in Forms Designer

You can configure the Message Details in Forms Designer under Data Entry Forms and Queries
module by updating the details of mail server in the "NotificationConfig.cfg" file which
resides in the path $FIC_APP HOME/common/FICServer/conf.

Ensure that the "authorized User details" for whom you need to configure the Message details
are included in Administration > Security Management > User Administrator > User
Maintenance window.

Update the following parameters in the "NotificationConfig.cfg" file:

Table H-6 NotificationConfig.cfg File

Parameter Description
SMTP_SERVER_IP Specify the hostname or IP address of SMTP Server.
SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 'true’,

otherwise set value to 'false’'.

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be
authenticated, otherwise set to 'false'.

SMTP_USERNAME Username required for logging into SMTP server, if
authentication is not required use a dummy value.

SMTP_PASSWORD Password required for logging into SMTP server, if
authentication is not required use a dummy value.

SMTP_MAILID If the Messages has to go from a Particular ID that ID
need to be added. Exchange server forces you set a valid
ID that is there in the exchange server. (Based on
Security settings)

Ensure that the authorized User details are included in Administration > Security Management
> User Administrator > User Maintenance window.

Clearing Application Cache
This is applicable to all Web Servers (that is, WebSphere, WebLogic, and Tomcat).

Prior to the deployment of Infrastructure or Application Service Packs / One-off patches, clear
the cache. Navigate to the following path depending on the WebServer configured and delete
the files:

»  Tomcat: <Tomcat installation
folder>/work/Catalina/localhost/<Application name>/org/apache/jsp

H-90 OFS BD Application Pack Installation and Configuration Guide



Additional Configuration

WebLogic: <Weblogic installation locations>/domains/<Domain
name>/servers/<Server names/tmp/ WL user/<Application name>/gaelce/jsp
servlet

WebSphere: <Websphere installation
directory>/AppServer/profiles/<Profile name>/temp/<Node
name>/serverl/<Application name>/<.war file name>

Configuring Passwords Changes

This section explains about how to modify the OFSAA Infrastructure Config Schema and
Atomic Schema passwords.

OFSAA Infrastructure Config Schema password modification

To change the Config Schema password, perform the following steps:

1.
2.
3.

Change the Config schema User Password in the database.
Delete the SFIC_HOME/conf/Reveleus.SEC file.
Shutdown the OFSAAI App service:

cd SFIC APP HOME/common/FICServer/bin
./stopofsaai.sh

Start the Infrastructure Server in foreground directly on the server or through X-Windows
software using the command:

./startofsaai.sh

At the prompt, enter System Password. Enter the "new Config schema" password. The
service will start and initialize itself if it is able to successfully connect to the DB.

Post successful startup of the service, if required, the Infrastructure server may be shut
down and restarted in the background using nohup mode.

OFSAA Infrastructure Atomic Schema password modification

To change the Atomic Schema password, perform the following steps:

1.
2.

Change the Atomic schema User Password in the database.

Login to the application from the browser using SYSADMN account or any user id, which
has System Administrator role mapped.

Navigate to System Configuration > Database Details window. Select the appropriate
connection and edit the password.

Navigate to Data Management Tools >Data Sources> Source Designer window. Update
the password of the appropriate Source

If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag
details in Server.xml file from the $SCATALINA HOME/conf folder. (In case of Tomcat
only Atomic <Resource> will exist).

If you are using WebSphere as Web server:
a. Login to the WebSphere Administration Console, from the left side menu.

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated
on the right side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both
Config and Atomic data sources will need to be modified).
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If you are using WebLogic as Web server:
a. Login to the WebLogic Administration Console, from the left side menu

b. Under Domain Structure list box, expand the appropriate Domain and navigate to
Services > JDBC >Data Sources. A list of data sources will be populated on the right
side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both
Config and Atomic data sources need to be modified).

6. Restart the OFSAALI services.

Configure Internal Service (Document Upload/ Download)

H-92

This step can be ignored if it has already been configured as part of any previous IR /ML
installation.

The Document Upload /Download feature has undergone a change and can now be configured
to use Internal service for document upload / download instead of the earlier ExeWebService.

To facilitate Internal service for document upload/ download, perform the following
configurations:

1. Create the folders download, upload, TempDocument and Temp in the local path of Web
application server and provide Read/Write permission.

> To find the exact location, execute the following query in CONFIG schema:
select localpath from web server info

> To create folders with Read/Write permission, execute the command:
mkdir -m 777 download upload TempDocument Temp

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide Read/Write
permission.

> To find the exact location, execute the query in CONFIG schema:
select ftpdrive from app server info

> To create folder with Read/Write permission, execute the command:
mkdir -m 777 DocStorage

By default, the parameter DOCUMENT_SERVICE _TYPE_EXTERNAL value is set to
FALSE in the Configuration table in CONFIG schema and hence the application
“ExeWebService” will not be used. It is recommended that the value to be set to FALSE and
use the Internal service for document upload/ downloads. If you intend to continue using the
External ExeWebService, set the value to TRUE.

Navigate to SFIC_HOME/EXEWebService/<WEBSERVER TYPE> directory of WEB tier
and type ./ant.sh. This triggers the creation of EAR/WAR file EXEWebService.ear/.war. The
EAR/WAR file EXEWebService.ear/.war will be created in $FIC
HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier. Redeploy the
generated EAR/WAR file onto your configured web application server.
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Patching OFSAA Infrastructure Installation

Patching Your OFSAA Infrastructure Installation

Oracle strongly recommends installing the latest available patchset so as to be up to date with
the various releases of the OFSAA product.

Refer http://support.oracle.com for more information on latest release.
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Grants for Atomic/ Config Schema

This section mentions about the various grants required for the CONFIG, ATOMIC schemas.
This section discusses the following sections:

> Grants for Atomic Schema

> QGrants for Config Schema

> Grants for Config Schema Entities for Atomic Users

Grants for Atomic Schema

Atomic Schema creation requires certain grants for object creation. This can be located in
SFIC HOME/privileges atomic_user.sql file.

The following are the Grants for Atomic Schema:

grant create SESSION to &database username

/

grant create PROCEDURE to &database username

/

grant create SEQUENCE to &database username

/

grant create TABLE to &database username

/

grant create TRIGGER to &database username

/

grant create VIEW to &database username

/

grant create MATERIALIZED VIEW to &database username
/

grant olap user to &database username

/

grant select on SYS.V_SPARAMETER to &database username
/
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grant create SYNONYM to &database username

/

Note: If you intend to use Oracle OLAP feature, execute the below grant
on all ATOMIC schema(s) grant olap user to &database username

Grants for Config Schema

Config Schema creation requires certain grants for object creation. This can be located in
SFIC HOME/privileges config user.sql file.

The following are the Grants for Config Schema:

grant create SESSION to &database username

/

grant create PROCEDURE to &database username

/

grant create SEQUENCE to &database username

/

grant create TABLE to &database username

/

grant create TRIGGER to &database username

/

grant create VIEW to &database username

/

grant create MATERIALIZED VIEW to &database username
/

grant olap user to &database username

/

grant select on SYS.V_SPARAMETER to &database username
/

grant create SYNONYM to &database username

/

Grants for Config Schema Entities for Atomic Users

Atomic Schema creation requires certain grants for config schema object access. This can be
located in SFIC_HOME/config table privileges for atomic_user.sql file.

The following are the Grants for Config Schema entities for Atomic Users:
grant select on CSSMS USR_PROFILE to &database username
/

grant select on CSSMS ROLE MAST to &database username
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grant select on CSSMS GROUP_MAST to &database username

grant select on CSSMS FUNCTION MAST to &database username

grant select on CSSMS USR GROUP MAP to &database username

grant select on CSSMS USR _GROUP DSN SEG MAP to &database username

grant select on CSSMS ROLE FUNCTION MAP to &database username

grant select on CSSMS GROUP_ROLE MAP to &database username

grant select on CSSMS SEGMENT MAST to &database username

grant select on CSSMS USR DSN SEG MAP to &database username

grant select on CSSMS USR ROLE MAP to &database username

grant select on CSSMS METADATA SEGMENT MAP to &database username

grant select on BATCH RUN to &database username

grant select on PR2 FILTERS to &database username

grant select on PR2 TASK FILTER to &database username

grant select on PR2 TASK FILTER DETAIL to &database username

grant select on ST STRESS MASTER to &database username

grant select on ST SCENARIO MASTER to &database username

grant select on ST SHOCK MASTER to &database username

grant select on BATCH MASTER to &database username
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grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

/

grant

select

select

select

select

select

select

select

select

select

delete

insert

update

select

delete

insert

update

select

select

delete

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

ICC_MESSAGELOG to &database username

PR2 MASTER to &database username

PR2_RUN REQUEST

MF_MODEL_SCRIPT

MF_INPUT VALUES

MF_MODEL_OUTPUT _

to &database username

MASTER to &database username

to &database username

VALUES to &database username

DB MASTER to &database username

DSNMASTER to &database username

pr2_rule map to

pr2_rule map pr

pr2_rule map pr

pr2_rule map pr

pr2_rule map pr

pr2_rule map pr_

pr2_rule map pr_

pr2_rule map pr_

pr2_rule map pr_

&database username

to &database username

to &database username

to &database username

to &database username

tmp to &database username

tmp to &database username

tmp to &database username

tmp to &database username

pr2_rule map exclude to &database username

pr2_rule map exclude pr to &database username
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grant insert on pr2 rule map exclude pr to &database username

grant update on pr2 rule map exclude pr to &database username

grant select on pr2 rule map exclude pr to &database username

grant delete on pr2 rule map exclude pr tmp to &database username

grant insert on pr2 rule map exclude pr tmp to &database username

grant update on pr2 rule map exclude pr tmp to &database username

grant select on pr2 rule map exclude pr tmp to &database username

grant select on pr2 run object to &database username

grant select on pr2 run object member to &database username

grant select on pr2 run map to &database username

grant select on pr2 run execution b to &database username

grant select on pr2 run execution filter to &database username

grant select on pr2 firerun filter to &database username

grant select on pr2 filters to &database username

grant select on configuration to &database username

grant select on batch parameter to &database username

grant select on component master to &database username

grant select on MDB_OBJECT TYPE ATT LAYOUT to &database username
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grant select on REV_OBJECT ATTRIBUTE DTL to &database username

/

grant select on FORMS LOCALE MASTER to &database username

/

grant select on mdb object dependencies to &database username
/

grant select on mdb execution details to &database username

/

grant select on REV_STAT DATA to &database username

/

grant select on REV_OBJECT REPOSITORY B to &database username
/

grant select on REV_OBJECT REPOSITORY TL to &database username
/

grant select on REV_OBJECT ATTRIBUTE DTL MLS to &database username
/

grant select on REV_OBJECT APPLICATION MAP to &database username
/

grant select on MDB_OBJ EXPR DETAILS to &database username

/

grant select on MDB_EXECUTION DETAILS to &database username

/

grant select on REV_OBJECT TYPES CD to &database username

/

grant select on REV_OBJECT TYPES MLS to &database username

/

grant select on REV_APPLICATIONS CD to &database username

/

grant select on REV_APPLICATIONS MLS to &database username

/

grant select on METADATA BROWSER LOCALE to &database username
/

grant select on MDB STAT DATA to &database username

/

grant select on MDB OBJECT TYPE LAYOUT to &database username
/

grant select on ofsa md id ref to &database username
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/

grant select on MDB_ETL MAPPING to &database username

/

grant select on setupinfo to &database username

/

grant select on LOCALEREPOSITORY to &database username
/

grant select on MF_MODEL MASTER to &database username

/

grant select on MF_SANDBOX MASTER to &database username
/

grant select on MF_VARIABLE MASTER to &database username
/

grant select on MF_TECHNIQUE MASTER to &database username

grant select on MDB_RULE SOURCE HEADER to &database username

grant select on MDB_RULE TARGET HEADER to &database username

grant select on MDB _RULE TARGET MEMBER HEADER to &database username

grant select on MDB_RULE GRID DATA to &database username

grant select on MDB _MODEL MAPPING to &database username

grant delete on AAI MAP MAPPER to &database username

grant insert on AAI MAP MAPPER to &database username

grant update on AAI MAP MAPPER to &database username

grant select on AAI MAP MAPPER to &database username

grant select on RTI_UI EXCLUDE PDM LIST to &database username

grant select on RTI VIR PHY TBL NAME to &database username
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grant select on infodom patches to &database username

/
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Configuring Applications Pack XML Files

This section explains configuration of OFS BD PACK.xml and OFS BD SCHEMA IN.xml
files.

This section includes the following topics:
> Configuring OFS BD PACK.xml file
> Configuring OFS BD SCHEMA IN.XML file

Configuring OFS_BD_ PACK.xml file

The OFS_BD_ PACK.xml file holds details on the various OFSAA products that are packaged
in a particular Applications Pack.

The following table gives details about the various tags/ parameters available in the file and the
values that need to be updated. Prior to installing the OFSAA Applications Pack in SILENT
mode, it is mandatory to update this file.

Note:
updated.

If you are installing in the GUI mode, then this file need not be

Table K-1 OFS_BD_PACK.XML Parameters

Tag Name/ Attribute Default Value/

Name Description Mandatory (Y/N) Permissible Value | Comments

APP PACK ID Unique Y Unique Seeded Value | DO NOT modify this
Applications Pack value.
Identifier

APP PACK NAME Unique Y Unique Seeded Value | DO NOT modify this
Applications Pack value.
Name

APP PACK Unique Y Unique Seeded Value | DO NOT modify this

DESCRIPTION Applications Pack value.
Description

VERSION Unique Y Unique Seeded Value | DO NOT modify this
Application Pack value.
release version

APP Unique Y Unique Seeded Value | DO NOT remove
Application these tags.
Entries

Configuring Applications Pack XML Files K-105




Configuring OFS_BD_SCHEMA_IN.XML file

Table K-1 OFS_BD_PACK.XML Parameters

Tag Name/ Attribute Default Value/
Name Description Mandatory (Y/N) Permissible Value | Comments
APP_ID Unique Y Unique Seeded Value | DO NOT modify this
Application value.
Identifier
APP_ID/ PREREQ Prerequisite Y Unique Seeded Value | For most applications
Application/ Infrastructure would
Product be the prerequisite set.
For certain other
applications, an
appropriate
Application ID would
be set.
DO NOT modify this
value.
APP_ID/DEF _SEL FLAG | Default Selected |Y Default - YES In all Applications
Flag Packs, Infrastructure
would have this value
setto "YES". DO
NOT modify this
value.
APP_ID/ ENABLE Enable YES if installing in Default - Set this attribute-value
Application/ SILENT mode. to YES against eve
Pr%%uc ¢ YES for Infrastructure APP_ID %v hich is Yy
NO for Others licensed and should be
Permissible - YES or enabled for use.
NO Note: Application/
Product once enabled
cannot be disabled.
However,
Application/ Product
not enabled during
installation can be
enabled later through
the Administration UL
APP_NAME Unique Y Unique Seeded Value | DO NOT modify this
Application/ value.
Product Name
APP_DESCRIPTION Unique Y Unique Seeded Value | DO NOT modify this
Application/ value.
Product Name
VERSION Unique release Y Unique Seeded Value | DO NOT modify this
version value.

Configuring OFS_BD_SCHEMA_IN.XML file

Creating database schemas, objects within schemas and assigning appropriate grants are the

primary steps in the installation process of OFSAA Applications. The OFS_ BD SCHEMA _
IN.xml file contains details on the various application schemas that should be created prior to
the Applications Pack installation.

The following table gives details about the various tags/ parameters available in the file and the
values that need to be updated. Prior to executing the schema creator utility, it is mandatory to
update this file.
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Table K-2 OFS_BD_SCHEMA_IN.XML Parameters

Tag Name/
Attribute Name

Description

Mandat

ory
(YIN)

Default Value/
Permissible Value

Comments

APP_PACK_ID

Unique Applications Pack
Identifier

Y

Unique Seeded Value

DO NOT modify this value.

<IDBC_URL>

Enter the JDBC URL

Note: You can enter RAC
and NON-RAC enabled
database connectivity URL.

Y

Example,

jdbe:oracle:thin: @<HOST/I
P>:<PORT>:<SID>

or

jdbc:oracle:thin:@//[HOST][
:PORT]/SERVICE

or

jdbc:oracle:thin: @(DESCRI
PTION=(ADDRESS _
LIST=(ADDRESS=(PROTO
COL=TCP)(HOST=[HOST]
)(port=[PORT]))(ADDRESS
=(PROTOCOL~=TCP)(HOS
T=[HOST])(PORT=[PORTY])
YLOAD_
BALANCE=yes)(FAILOVE
R=yes))(CONNECT _
DATA=(SERVICE _
NAME=[SERVICEY))))

For example,
jdbc:oracle:thin:@//dbhost.se
rver.com:1521/servicel

or

jdbc:oracle:thin:@//dbshost.s
erver.com:1521/scan-1

or

jdbc:oracle:thin: @(DESCRI
PTION=(ADDRESS
LIST=(ADDRESS=(PROTO
COL=TCP)(HOST=dbhost1.
server.com)(port=1521))(AD
DRESS=(PROTOCOL=TCP
)(HOST=dbhost2.server.com
)(PORT=1521))(LOAD _
BALANCE=yes)(FAILOVE
R=yes))(CONNECT _
DATA=(SERVICE _
NAME-=servicel)))

Ensure to add an entry (with
SID/ SERVICE NAME) in
the tnsnames.ora file on the
OFSAA server. The entry
should match with the
SID/SERVICE NAME used
in the JDBC URL.

<IDBC_
DRIVER>

By default this driver name
is seeded.

Note: Do not edit this
attribute value.

Example,

oracle.jdbc.driver.OracleDriv
er

Only JDBC Thin Driver is
supported.

DO NOT modity this value.

<HOST>

Enter the Hostname/ IP
Address of the system on
which you are installing the
OFSAA components.

Host Name/ IP Address
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Table K-2 OFS_BD_SCHEMA_IN.XML Parameters

Mandat
Tag Name/ ory Default Value/
Attribute Name | Description (Y/N) Permissible Value Comments
<SETUPINFO>/ | Enter the acronym for the Y Accepts strings with a This name would appear in
NAME type of implementation. This minimum length of two and | the OFSAA Landing Page as
information will be maximum of four. "Connected To: xxxx"
displayed in the OFSAA Example, The schemas being created
Home Page. DEV. SIT. PROD would get this prefix. For
Note: On executing the > E.g. dev_ofsaaconf, uat
schema creator utility, this ofsaaconf etc.
value will be prefixed with
each schema name. For
example: dev_ofsaaconf,
uat_ofsaaatm.
<SETUPINFO>/ | Identifies if the value N YES or NO Default value is YES.
PREFIX specified in <SETUPINFO>/
SCHEMA _ NAME attribute should be
NAME prefixed to the schema name.
<PASSWORD>/ | Enter the password if you N The maximum length
DEFAULT* want to set a default allowed is 30 characters.
password for all schemas. Special characters are not
Note: You also need to set allowed.
APPLYSAMEFORALL
attribute as Y to apply the
default password for all the
schemas.
<PASSWORD>/ | Enter as Y if you want to Y Default - N If set to N, need to specify
APPLYSAMEFO | apply the password specified Permissible - Y or N PASSWORD value for every
RALL in DEFAULT attribute for all SCHEMA.

the schemas.

If you enter as N, you need
to provide individual
passwords for all schemas.

Note: In case you have
entered Y in
APPLYSAMEFORALL
attribute and also have
specified individual
passwords for all the
schemas, then the specified
individual passwords will
take precedence.

Note: Setting this attribute
value is mandatory, If
DEFAULT attribute is set.
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Table K-2 OFS_BD_SCHEMA_IN.XML Parameters

Mandat
Tag Name/ ory Default Value/
Attribute Name | Description (Y/N) Permissible Value Comments
<SCHEMA>/ The different types of Y ATOMIC/CONFIG/SANDB | Only One CONFIG schema
TYPE schemas that are supported OX/ADDON can exist in the file.
in this release are ATOMIC, . . . .
Ui e e e
ADDON. SANDBOX AND ADDON

By default, the schemas
types are seeded based on
the Applications Pack.

Note: Do not edit this
attribute value.

schemas are not applicable
for OFS AAAI Applications
Pack.

that holds the OFSAA setup
details and other metadata
information.

Multiple ATOMIC/
SANDBOX/ ADDON
schemas can exist in the file.

ATOMIC schema refers to
the Information Domain
schema. SANDBOX schema
refers to the SANDBOX
schema. ADDON schema
refers to other miscellaneous
schema (not applicable for
this Applications Pack).
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Table K-2 OFS_BD_SCHEMA_IN.XML Parameters

Mandat
Tag Name/ ory Default Value/
Attribute Name | Description (Y/N) Permissible Value Comments
<SCHEMA.>/ By default, the schemas Y The permissible length is 15 | SETUPINFO/ NAME
NAME names are seeded based on characters and only attribute value would be
the Applications Pack. alphanumeric characters prefixed to the schema name
You can edit the schema allowed. No special being created.
. . characters allowed except . .
names if required. o For E.g. if name is set as
underscore ' . , , .
Note: - ofsaaatm' and setup}nfo as
'uat' then schema being
The Schema Name will have created would be 'uat
a prefix of the SETUPINFO/ ofsaaatm'.
NAME attribute. NAME should be same
SCHEMA NAME must be where APP_GRP=1 for all
same for all the ATOMIC SCHEMA tags (Not
Schemas of applications applicable for this
within an Applications Pack. Applications Pack).
Note:
For example:
<Variable
name="DATABASE
NAME">KYCDB.oracle.com
</Variable>
A TNS entry must be made
in tnsnames.ora with
tnsname same as the value
provided for KYC Database
Name. If sqlnet.ora is
configured with a vaue in
NAMES.DEFAULT _
DOMAIN then ensure to use
the same domain while
defining Database Name. It
is required for KYC Batch
processing.
This name should be unique
The same above steps to be
done for FATCA and CTR.
A restart of web and app
servers are necessary
whenever any changes are
done to config schema
<SCHEMA>/ Enter the password of the N The maximum length Note: You need to
PASSWORD* schema to be created. allowed is 30 characters. mandatorily enter the
Note: Special characters are not password if you have set the
) allowed. <PASSWORD>/
If this attribute is left blank, APPLYSAMEFORALL
then the password specified attribute as N.
i<nPE£§SWORD> /DEFAULT Takes precedence over
attribute is applied as the DEFAULT attribute value of
Sch P 4 <PASSWORD> tag.
chema Password.
<SCHEMA>/ By default, the Application Y Unique Seeded Value Identifies the Application/
APP_ID ID is seeded based on the Product for which the
Applications Pack. schema is being created.
Note: Do not edit this DO NOT modity this value.

attribute value.
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Table K-2 OFS_BD_SCHEMA_IN.XML Parameters

Mandat
Tag Name/ ory Default Value/
Attribute Name | Description (Y/N) Permissible Value Comments
<SCHEMA>/ Enter the available default N Default - USERS Modify this value to
DEFAULTTABL | tablespace for DB User. .. .. associate any valid
Permissible - Any existing .
ESPACE . tablespace with the schema.
Note: valid tablespace name.
If this attribute is left blank,
then USERS is set as the
default tablespace.
<SCHEMA>/ Enter the available N Default - TEMP Modify this value to
TEMPTABLESP | temporary tablespace for the Permissible - Any existin associate any valid
ACE DB User. . Y & tablespace with the schema.
valid temporary tablespace
Note: name.
If this attribute is left blank,
then TEMP is set as the
default tablespace.
<SCHEMA>/ Enter the quota to be seton | N Example, Modify this value to grant
QUOTA DEFAULTTABLESPACE 600M/m the specified quota on the
attribute for the schema/ mentioned tablespace to the
user. By default, the quota 20G/g user.
size is set to S00M. ..
Minimum: 500M or UNLIMITED/unlimited
Unlimited on default
Tablespace
SCHEMA/APP_ | This flag indicates group of | Y Unique Seeded Value DO NOT modify this value.
GRP=1 APP_ID and type=Atomic
share same atomic schema
and Infodom
SCHEMA/ Infodom Name Associated Y Enter the name of the Valid string with up to 11
INFODOM with each Atomic Schema Information Domain to characters.

and ADDON.

associate this schema.

The schema creator utility
automatically derives an
Information Domain Name
based on the Applications
Pack if no value is specified
for this attribute.

Mandatory for Silent
Installation Mode
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This section gives details about the OFSAAI InstallConfig.xml file.

Configuring

OFSAAIL_InstallConfig.xml file

To configure the OFSAAI InstallConfig.xml file, follow these steps.

1.

2
3.
4

Navigate to OFS_ AAAI PACK/OFS_AAl/conf/
Open the file OFSAAI InstallConfig.xml in text editor.

Configure the OFSAAI InstallConfig.xml as mentioned in the below table:

You need to manually set the InteractionVariable parameter values as mentioned in the
table. If a value is not applicable, enter NA and ensure that the value is not entered as

NULL.

Table L-1 OFSAA Infrastructure Installation Tasks and Descriptions

Interaction Variable
Name

Significance and Expected Value

Mandatory

<Layer name="GENERAL">

WEBAPPSERVERTYP
E

Identifies the web application server on which the OFSAA Infrastructure web
components would be deployed.

The below numeric value should be set depending on the type:
»  Apache Tomcat = 1

»  IBM WebSphere Application Server =2

»  Oracle WebLogic Server =3

For example, <InteractionVariable
name="WEBAPPSERVERTYPE">3</InteractionVariable>

Yes

DBSERVER_IP

Identifies the hostname or IP address of the system on which the Database
Engine is hosted.

Note: For RAC Database, the value should be NA.

For example, <InteractionVariable name="DBSERVER
IP">14.15.16.17</InteractionVariables> or <InteractionVariable
name="DBSERVER IP">dbhost.server.com</InteractionvVariable>

Yes

ORACLE_
SID/SERVICE_ NAME

Identifies the Oracle DB Instance SID or SERVICE NAME

Note: The Oracle SID value should be exactly the same as it is mentioned in
JDBC_URL.

For example, <InteractionVariable name="ORACLE SID/SERVICE_
NAME">ofsaser</InteractionVariable>

Yes
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Table L-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

Interaction Variable
Name

Significance and Expected Value

Mandatory

ABS DRIVER PATH

Identifies the directory where the JDBC driver (ojdbc<versions.jar) exists.
This would typically be the SORACLE HOME/jdbc/1ib

For example, <InteractionVariable name="ABS DRIVER
PATH">">/oradata6/revwb7/oracle </InteractionVariable>

Note: Refer Appendix N for identifying the correct "ojdbc<version>.jar" version
to be copied.

Yes

OLAP_SERVER
IMPLEMENTATION

Identifies if the OFSAA Infrastructure OLAP component needs to be configured
depending on whether you intend to use the OLAP feature. The below numeric
value should be set depending on the choice:

> YES-1
» NO-0

in.profile:

ARBORPATH, HYPERION HOME and ESSBASEPATH.

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following environment variables are set

SFTP_ENABLE

Identifies if the SFTP (Secure File Transfer Protocol) feature is to be enabled.
The below numeric value should be set depending on the choice:

p SFTP -1
> FTP-0

Yes

Note: The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle recommends using SFTP
instead of FTP because SFTP is considered more secure. However, a client may choose to ignore this recommendation
and to use FTP by setting SFTP_ENABLE to 0. This selection may be changed later by using the OFSAAI administration

the OFSAA Infrastructure supports only US English.

For example, <InteractionVariable name="LOCALE">en
US</InteractionVariable>

interface.
FILE TRANSFER Identifies the port used for the file transfer service. The default value specified is |Yes
PORT 22 (SFTP). Specify value as 21 or any other PORT value if value for SFTP_
ENABLE is 0.
For example, <InteractionVariable name="FILE TRANSFER
PORT">21</InteractionVariable>
LOCALE Identifies the locale information to be used during the installation. This release of |Yes

Note: The below ports are used internally by the various OFSAA Infrastructure services. The default values mentioned
below are set in the installation. If you intend to specify a different value, update the parameter value accordingly and
ensure this port value is in the range of 1025 to 65535 and the respective port is enabled.

JAVAPORT 9999 Yes
NATIVEPORT 6666 Yes
AGENTPORT 6510 Yes
ICCPORT 6507 Yes
ICCNATIVEPORT 6509 Yes
OLAPPORT 10101 Yes
MSGPORT 6501 Yes
ROUTERPORT 6500 Yes
AMPORT 6505 Yes

Note: If value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a trusted CA and the same
is configured on your web application server.
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Table L-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

Interaction Variable
Name

Significance and Expected Value

Mandatory

HTTPS ENABLE

Identifies if the UI should be accessed using HTTP or HTTPS scheme. The
default value set is 0. The below numeric value should be set depending on the
choice:

> YES-1
» NO-0

For example, <InteractionVariable name="HITPS
ENABLE">0</InteractionVariable>

Yes

WEB_SERVER_IP

Identifies the HTTP Server IP/ Hostname or Web Application Server IP/
Hostname, to be used for accessing the UI. This IP would typically be the HTTP
Server IP.

If no separate HTTP Server is available, the value should be Web Application
Server IP/Hostname.

For example, <InteractionVariable name="WEB SERVER_
IP">10.11.12.13</InteractionVariable>

or

<InteractionVariable name="WEB_SERVER
IP">myweb.server.com</InteractionVariable>

WEB_SERVER_PORT

Identifies the Web Server Port. This would typically be 80 for non SSL and 443
for SSL. If no separate HTTP Server exists, the value should be the port
configured for Web Server.

Note: The port value will not be accepted as 80 if HTTPS_ENABLE is 1 and as
443, if HTTPS_ENABLE is 0.

For example, <InteractionVariable name="WEB_SERVER
PORT">80</Interaction Variable>

CONTEXT NAME

Identifies the web application context name which will be used to built the URL
to access the OFSAA applications. The context name can be identified from a
URL as below:

<scheme>://<host>:<port>/<context-name>/login.jsp
Sample URL: https://myweb:443/ofsaadev/login.jsp

For example, <InteractionVariable name="CONTEXT
NAME">ofsaadev</InteractionVariable>

Yes

WEBAPP_CONTEXT
PATH

Identifies the absolute path of the exploded .ear file on the web application
server.

For Tomcat, specify the Tomcat directory path till /webapps, such as
/oradata6/revwb7/tomcat /webapps/.

For WebSphere, enter the WebSphere path as <WebSphere profile
directory>/installed Apps/ <NodeCellName>. For example,
/data2/test//WebSphere/AppServer/profiles/<Profile
Name>/installedApps/aix-imfNode01Cell. Where aix-imf is Host name.

For WebLogic, provide the WebLogic home directory path as /<WebLogic home
directory paths/bea/wlserver 10.3

Yes

WEB_LOCAL_PATH

Identifies the absolute path to any directory on the web application server that
can hold temporary files being uploaded as part of the applications usage.

Note: In case of a clustered deployment, ensure this path and directory is same
on all the nodes.

Yes
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Table L-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

Interaction Variable
Name

Significance and Expected Value

Mandatory

WEBLOGIC_

Identifies the WebLogic Domain Home.

Yes Specify

> HIVE SERVER FTPDRIVE:

Identifies the absolute path to the directory identified as file system stage
area of HIVE server.

., HIVE_SERVER_FTP_USERID:

Identifies the user who has RWX permissions on the directory identified
under the preceding parameter HIVE_SERVER FTPDRIVE.

> HIVE_SERVER_FTP_PROTOCOL:
If the HIVE_SERVER PORT is 21, then value is FTP, else it is SFTP.

DOMAIN_HOME For example, <InteractionVariable name="WEBLOGIC_DOMAIN_ g:l;?%ue
HOME">/home/weblogic/bea/user _ projects/domains/mydomain WEBSERV
</Interaction Variable> ERTYPE is

setas 3
(WebLogic)

OFSAAI FTPSHARE |Identifies the absolute path to the directory identified as file system stage area. Yes

PATH
Note:

»  The directory should exist on the same system on which the OFSAA
Infrastructure is being installed (can be on a separate mount).

» The user mentioned in APP_SFTP_USER _ID parameter below should have
RWX permission on the directory.
For example, <InteractionVariable name="APP_FTPSHARE
PATH">">/oradata6/revwb7/ftpshare</InteractionVariable>

OFSAAI SFTP_ Identifies the user who has RWX permissions on the directory identified under Yes

USER ID parameter APP_ FTPSHARE PATH above.

HIVE _ Details ? HIVE _SERVER PORT: NA as OFS

) ) . . |BD does not
Identifies the port used for the file transfer service. The default value specified is support
22 (SFTP) or 21 (FTP). HIVE.
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Migration for Excel Upload

This section provides detailed instructions to migrate for excel upload.

Prerequisites

The following are the prerequisites for migration.

?

?

?

?

"Data model in ATOMIC schemas should be same on the source and target setups
"OFS AALI (platform) patch level version should be same on the source and target setups.
"PL/SQL Developer to connect and query the database.

"WinSCP to connect and access server file system.

Migration for Excel Upload

To migrate, follow these steps:

1.

6.

Open PL/SQL Developer and logon to the source setup's configuration (CONFIG) schema
by entering the appropriate username and password.

In a new SQL window query the data of table EXCEL_MAPPING MASTER.

Open a new session in PL/SQL developer and logon to the target setup's configuration
(CONFIG) schema by entering the appropriate username and password.

Insert the records from Step 1 above in to this table.

In V_INFODOM column of EXCEL_MAPPING MASTER table update the infodom name with
the target infodom name.

Note: If all the mappings can work out of the single target Infodom, update
same Infodom value across all rows. If only few mappings will work out of
the target infodom, update the infodom value for selective records. Kindly
note, excel upload mappings will work only if the target infodom has same
data model entities as used in the mappings defined on source setup.

Update V_CREATED BY column with the name of any user present in the target setup that
has appropriate roles to perform Excel Upload tasks.

Note: It is mandatory to update values for V_INFODOM and V_CREATED
BY columns.
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7. Open WinSCP and login a new session by entering the host name, port number, user name
and password to access the source setup.

8. Navigate to the folder referred as FTPSHARE.

9. Copy the excel-entity mapping xml file(s) which are located in this folder according to
their folder structure on to your desktop. For example: /ftpshare
/STAGE/ExcelUpload/$SOURCE INFODOM NAME/$EXCEL FILE NAME.xml

Note: Actual file name of Excel Sheet is mentioned in the V_EXCEL NAME
column of EXCEL_MAPPING MASTER table.

10. Copy the excel templates (.xlIs/ .x1sx) file(s) which are located in this folder according to
their folder structure on to your desktop. For example:
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.x1ls or *.xlsx

Note: Ignore this step if files are not present at the location.

11. Login a new session in WinSCP by entering the host name, port number, user name and
password to access the target setup.

12. Copy the xml file(s) from Step3 to the below location in the target setup. For example:
/ftpshare/STAGE/ExcelUpload/$TARGET_INFODOM_NAME/$EXCEL_FILE_NAME.xml

Note: S$TARGET INFODOM NAME should be target setup infodom in which
you have uploaded the appropriate data model and the name should be same
as the V_INFODOM column value updated in EXCEL_MAPPING MASTER table.

13. Copy the xIs/ xIsx file(s) from Step 3 to the below location in target setup. For example:
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.x1ls or *.xlsx

Note: Ignore this step if files are not present at the location.
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JDBC Jar Files

The ojdbc<versions.jar file should be copied based on Database & Java version. Refer to
the following table for details.

Table N-1 JDBC Jar files version details

Oracle Database
Version

JDK/JRE Version
Supported

JDBC Jar files specific to the
release

12.1 or 12¢cR1

JDK 8,JDK 7 and JDK 8

0jdbc7.jar for JDK 7/JDK 8

0jdbc6.jar for JDK 6

11.2 or 11gR2 JDK 6 & JDK 5 0jdbc6.jar for JDK 7
JDK 7 supported in 11.2.0.3 o0jdbc6.jar for JDK 6

and 11.2.0.4 ojdbes.jar for JDK 5
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Upgrading an Existing OFSAA 8.0.x Java 7
Instance to Java 8

This section explains the configurations required to upgrade an existing OFSAA 8.0.x Java 7
instance to Java 8. It consists of the following topics:

> Prerequisites

> Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8§

> Web Application Server Configurations

> OFSAA Generic Configurations

> OFSAA Configurations for New Web Application Server Installation

Prerequisites
The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 8:

> Java 8 should be installed on the OFSAA server and Web Application Server.

> Oracle WebLogic Server should be 12.1.3.0 or above. Download and install patch
18729264 from http://support.oracle.com/ for the same.

Note: IBM WebSphere 8.5.x (Full Profile) on Java 8 is not available.

Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8
To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps:

1. Configure Web Application Server to Java 8. For more information, refer Web Application
Server Configurations.

2. Configure the OFSAA instance to Java 8. For more information, refer OFSAA Generic
Configurations. For a newly installed Web Application Server, refer OFSAA
Configurations for New Web Application Server Installation

3. Restart the OFSAA services. For more information, refer the Start/Stop Infrastructure
Services section in Appendix D

4. Generate the application EAR/WAR file and redeploy the application onto your configured
web application server. For more information on generating and deploying EAR / WAR
file, refer Appendix C.
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Web Application Server Configurations

Web Application Server Configurations

This section describes the changes to be made in the Web Application Server. Following are the
two options to perform Web Application Server Configurations which are listed as follows:

> Upgrade the existing Web Application Server installation to Java 8
> Install a new instance of the Web Application Server with Java 8
This section consists of the following topics:

> Oracle WebLogic Server Updates

> Apache Tomcat Server Updates

Oracle WebLogic Server Updates

Perform the following configurations to upgrade the existing WebLogic server instance to Java
8:

1. Navigate to <WLS_HOME>/Middleware/Oracle Home/wlserver.

2. Editthe product.properties file. Set JAVA HOME, WLS JAVA HOME,
JAVAHOME properties to the new Java path and java.vm.version to the new Java
version. For example,

JAVA HOME=/usr/java/jrel.8.0_ 45
WLS_JAVA HOME=/usr/java/jrel.8.0 45
JAVAHOME=/usr/java/jrel.8.0 45
java.vm.version=1.8.0 45

3. Navigate to <WLS_HOME>/Middleware/Oracle Home/user
projects/domains/<domain>/bin. Update SUN JAVA HOME, DEFAULT
JAVA HOME, JAVA HOME in the setDomainEnv. sh file to point to the new Java
path. For example,

SUN JAVA HOME="/usr/java/jrel.8.0 45"
DEFAULT SUN_JAVA HOME="/usr/java/jrel.8.0 45"
JAVA HOME="/usr/java/jrel.8.0 45"
4. Clear the Application cache. Navigate to the following path and delete the files:

<Weblogic installation location>/domains/<Domain names>/servers/<Server
name>/tmp/ WL user/<Application name>/qaelce/jsp servlet

If you wish to install a new instance of the Oracle WebLogic Server, follow these steps:
1. Install Oracle WebLogic Server 12.1.3.x on Java 8.

2. Perform the configurations for the newly installed WebLogic server. For more information
refer Configuring Resource Reference in Web Application Servers.

Note: While creating WebLogic Domain, the Listen Port should be set
same as that of the existing Domain.

Note down the new Domain path to perform OFSAA Configurations.
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Apache Tomcat Server Updates

Perform the following configurations to upgrade the existing Apache Tomcat Server from Java

7 to Java 8:

1. Login to the Apache Tomcat Server as a non-root user.

2. Edit the user .profile. Update the value for JAVA HOME from JRE 1.7 to JRE 1.8. For
Example,
JAVA HOME=/usr/java/jrel.8.0 45

3. Clear the Application cache. Navigate to the following path and delete the files:

<Tomcat installation folder>/work/Catalina/localhost/<Application
name>/org/apache/jsp

If you wish to install a new instance of the Apache Tomcat Server, follow these steps:

1.
2.

Install Apache Tomcat Server 8 with Java 8.

Perform the configurations for the newly installed Tomcat server. For more information
refer Configuring Resource Reference in Tomcat Application Server.

Note: Update the Connector Port in
/apache-tomcat-8.0.21/conf/server.xml file to that of the
existing Tomcat instance.

Note down the new deployment path to perform OFSAA Configurations.

OFSAA Generic Configurations

This section consists of the following topics:

2

2

User .profile Settings

Configurations for Java 8

User .profile Settings

Perform the following configurations:

1.
2.

Login to the OFSAA Server as a non-root user.

Edit the user.profile. Update the value for PATH variable from JRE 1.7 to JRE 1.8. For
Example,

PATH=/usr/java/jre 1.8.0 45/jre
JAVA BIN=/usr/java/jre 1.8.0 45/jre/bin

LD LIBRARY PATH=$LD LIBRARY PATH:/usr/java/jre 1.8.0
45/9jre/lib/amd64/server

Configurations for Java 8

Perform the configurations explained in the section Configurations for Java 8
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OFSAA Configurations for New Web Application Server

Installation

This configuration is required only if you have freshly installed Oracle WebLogic 12.1.3 or
Apache Tomcat Server 8.0. Follow these steps:

1.

Modify the following parameters in the Configuration table present in the Config Schema
with the new Domain Path in case of WebLogic or with the new deployment path in case
of Tomcat:

» DeFiHome

»  REV_IMG_PATH

»  EMBEDDED JSP_JS PATH

Login to the OFSAA Server as a non-root user.

Navigate to SFIC_HOME/ficweb/webroot/WEB INF and update the following
parameters in the web . xml file with the new Domain path in case of WebLogic or with
the new deployment path in case of Tomcat:

? FIC PHYSICAL HOME LOC
? FIC HOME

»  ICC_SERVLET LOG_FILE

Navigate to SFIC_HOME/ficweb/webroot/conf and update the Domain path in
case of WebLogic or with the new deployment path in case of Tomcat:

»  OFSAALogger.xml

»  MDBLogger.xml

»  RevLog4jConfig.xml

»  RFDLogger.xml

»  ExportLog4jConfig.xml
»  RFDLogger.xml

? PR2Logger.xml
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Removing OFSAA

This chapter includes the following sections:
> Uninstalling OFSAA Infrastructure

> Uninstalling EAR Files in WebSphere

> Uninstalling EAR Files in WebLogic

> Uninstalling WAR Files in Tomcat

Uninstalling OFSAA Infrastructure

This section will guide you through the necessary steps to uninstall the OFSAA Infrastructure
product.

Before you start the uninstallation process, ensure that no open connections exist to the OFSAA
Infrastructure Config and Atomic Schemas and Infrastructure services are brought down.

To uninstall OFSAA Infrastructure:

1. Log in to the system as non-root user.

2. Navigate to the SFIC_HOME directory and execute the command:
./Uninstall.sh

3. Enter the password for OFSAAI Configuration Schema when prompted as shown in the
following figure.

Figure 6-26 Uninstalling OFSAA Infrastructure

fzoratchd/of zaadb0FSAAL:, Alhinstall,sh

Ininztallation Started [time @ Tue Jun 10 14:20:27 I5T 2014 1
S5 e
%% Driver loaded with Driver oracle, jdbc,driver.Oraclelriver

Pleaze enter Configuration schema Password @

Connected to Config Schema

Cleaning config schema ...

config schema cleaned ...

Cleaning up Infrastructure Home Dir |

Please wait ..

hinstallation Completed | Thank You [time 3 Tue Jun 10 14:21:53 IST 2014 ]
AR R R R R R R R R R R R
/zoratchdof saadb OFSAAT ]
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Note:

> Uninstallation does not remove the Infrastructure application from the
Web Application Server. This has to be done manually.

> The entries in the .profile file will have to be removed manually.

> The files/ folders under the file system staging area (ftpshare) have to be
deleted manually.

> All the Database objects from Atomic Schemas have to be dropped
manually.

Uninstalling EAR Files in WebSphere

Following are the steps to uninstall any previously deployed application:

1. Open the URL in the browser window: http://<ipaddress>:<Administrative
Console Port>/ibm/console (https if SSL is enabled). The Login window is displayed.

2. Login with the user id that has admin rights.

3. Expand Applications > Application Types > WebSphere enterprise applications from the
LHS. The Enterprise Applications window is displayed with all the deployed applications.

Figure 6-27 Enterprise Applications

Enterprise Applications ?-
Enterprise Applications
Use this page to manage installed spplications. A single zpplication can be deployed onte multiple servers.
[ FPreferences
Start | | Swop || Install [ Uninstall Update I Rollout Update Remove File | Export I Export DDL ] Export File
DR
U
Salact| Name & Application Status ().
You can administer the following resources:
|| fayltaspolication L
B ivtapp L3
| uery L
El upgs73 y
Total 4

4. Select the checkbox adjacent to the application to be uninstalled and click Stop.
5. Click Uninstall. The Uninstall Application window is displayed.

Figure 6-28 Uninstall Application

Chck OK to remove the following appbcaton(s). If you do not want 1O remove the appications, cick Cancel 1o retumn
Lo the previous page

Nami
ALXGAST

@ Cancel
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6. Click OK to confirm.

7. Click Save to save the master file configuration.

Uninstalling EAR Files in WebLogic

On the machine that hosts WebLogic, perform the following steps to uninstall any previously
deployed application:

1.  Open the URL in the browser window: http://<ipaddress>:<admin server
port>/console (https if SSL is enabled). The Login window of the WebLogic Server
Administration Console is displayed.

2. Login with the WebLogic user credentials having administrator privileges.

3. From the Domain Structure LHS menu, click Deployments. The Summary of
Deployments screen is displayed.

Figure 6-29 Summary of Deployments

Summary of Deployments
Control ~ Monitorng
This page displays a st of Java EE apphcations and stand-alone application modulss that have besn instaled to this domain, Instafied applcations and modules can be stacted, stoppad, updated

(redepioyed), or delzted from the domain by first ssiacting the apolication name and using the cantrols on this page.

To install a new applcation or module for deployment to targets in this damain, dick the Install button.

¥ Customize this table
Deployments

insiall | | Update | Delete |S:a.'1v

Showing 1to 10f 1 Previous | Mext

When work completes

¥ | hame State Health ) Deployment Order
Force Stop Now yee
@ Rupg7273 Stop, but continue servicing administration requests Active @ ok Erterprise Anphicaton 100

ingtall | | Update | Delete

| Start» | | Siop v Showing 110 1of 1 Previows | Next

4. Select the checkbox adjacent to the application to be uninstalled and click Stop> Force
Stop Now.

5. Click Yes in the confirmation dialog to stop the selected deployment.
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Figure 6-30 Summary of Deployments- Messages

Select the checkbox adjacent to the application and click Delete to delete the selected
deployment.

Click Yes in the confirmation dialog to remove the selected deployment from the domain
configuration.

Uninstalling WAR Files in Tomcat

On the machine that hosts Tomcat, perform the following steps to uninstall any previously
deployed application:

1.

Comment out Context path section from server.xml file in SCATALINA HOME/conf
directory to avoid conflict during undeploy and re-deploy of the WAR file.

Place comment <!-- --> in between the context path section. For example:
<l--

<Context path ="/pr2test"
docBase="/home/perfuser/tomcat-7.0.19/webapps/pr2test" debug="0"
reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/PR2ATM"

type="javax.sqgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="pr2atm"

password="pr2atm"
url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST"
maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>
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-->

Restart the Tomcat service by doing the following:

d. Login to the "Unix server" through a terminal emulator.

e. Navigate to $catalina home/bin directory.

f.  Stop the tomcat services using the command . /shutdown.sh
g. Start the tomcat services using the command . /startup.sh

2. Open the URL in a browser window: http://<IP address>:<Tomcat server ports.
(https if SSL is enabled). The Tomcat home window is displayed.

3. Click the Manager App. The Connect to window is displayed.

4. Login with the user credentials having admin rights. The Tomcat Web Application Manager
window is displayed with the list of all applications deployed in Tomcat.

Figure 6-31 Tomcat Web Application Manager

S Apache

Software Foundation
http://www.apache.org/

Tomcat Web Application Manager

| List Applications L 1 r Higl Lanager Hal Server Sialus
| Path Display Name Runak L= d
Start Stop Bsioad Undsploy
Stari Sloo Beiged Lodeoioy
| ocs Tameat Dacumentation true 2 vt e 230 | minutes
Start 5o Beloag Lndecloy
e St i 355 Eaine P i e 230 .
| most-manager Teomeat Manager Aggication true 2 Expire gessions with e 3| 30 minutes
Start Stop Reicad Undeploy
| imansger Tomcat Wana per Appication trie 2 with e 2| 30 Minites
| lfsanmt Reveleus web Applcation | true 1 Start Siog Heioad Undeploy

5. Click the Undeploy link against the deployed Infrastructure application. A confirmation
message is displayed on the application /Infrastructure being uninstalled.
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Tunable Database Parameters

This appendix contains the Tunable Database Parameters.

Note:

server specifications and estimated data volume. For values of PGA

Review the Oracle recommended guidelines in setting the SGA
TARGET, SGA_MAX SIZE and PGA AGGREGATE TARGET parameters. The
values for these memory parameters can vary significantly based on database

AGGREGATE_TARGET parameters Oracle recommends that they be kept at a
minimum of 1024 MB.

Table Q-1 Database Tunable Parameters

Tunable Database Parameters

Parameter Values

Oracle
Oracle Recomme
Recomme | nded for
Category Parameter Name Type Default nded Exadata
Parameters CHARACTER SET string AL32UTFS8 | AL32UTF8 | AL32UTF8
affecting :
database NLS LENGTH string byte byte byte
SCHEMATICS
creation (not
tunable NLS _SORT binary binary binary binary
through the MAXDATAFILES integer 254
init.ora MASXINSTANCES | integer 1
file) MAXLOGFILES integer | 32
MAXLOGHISTORY | integer 24794
MAXLOGMEMBER | integer 2 4 4
S
REDO LOG SIZE integer 10M 3G 16G
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Table Q-1 Database Tunable Parameters

Tunable Database Parameters

Parameter Values

Oracle
Oracle Recomme
Recomme | nded for
Category Parameter Name Type Default nded Exadata
Parameters DB BLOCK SIZE integer 2048 8192 8192
affecting 1/0 :
operation DB FILE integer The default | 32 32
MULTIBLOCK value
READ_COUNT corresponds
to the
maximum
/O size that
can be
efficiently
performed
and is
platform-de
pendent.
DB FILES integer 200
DISK _ASYNCH_IO | boolean TRUE
TAPE ASYNCH_IO | boolean TRUE
DB _WRITER integer 1 4 4
PROCESSES

Oracle Financial Services Behavior Detection Application Pack




Table Q-1 Database Tunable Parameters

Tunable Database Parameters

Parameter Values

Oracle
Oracle Recomme
Recomme | nded for
Category Parameter Name Type Default nded Exadata
Parameters FAST START string LOW HIGH HIGH
affecting PARALLEL ROLLB
resource ACK
consumption :
and parallel LOG_BUFFER integer ™ 10000000 10000000
operations LOG _ integer | 0 10000 10000
CHECKPOINT _
INTERVAL
LOG _ integer 0 0 0
CHECKPOINT _
TIMEOUT
OPEN_CURSORS integer 50 4096 4096
PARALLEL _ integer 2148 16384 16384
EXECUTION _
MESSAG E_SIZE
PARALLEL MAX | integer 10 * No of | Setifyou Do not set or
SERVERS CPUs are change
configuring
DOP
manually at
site and
PARALLEL
_DEGREE _
POLICY is
set to
MANUAL.
PARALLEL MIN integer 0 Set if you Do not set or
SERVERS are change
configuring
DOP
manually at
site and
PARALLEL
_DEGREE
POLICY is
set to
MANUAL.
PROCESSES integer 150 600 600
LARGE POOL SIZE | integer 0 512M
PARALLEL MIN integer 0 Set if you Do not set or
PERCENT are change
configuring
DOP
manually at
site and
PARALLEL
_DEGREE
POLICY is
set to
MANUAL.
PARALLEL integer 2

THREADS_PER _
CPU
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Table Q-1 Database Tunable Parameters

Tunable Database Parameters

Parameter Values

Oracle
Oracle Recomme
Recomme | nded for
Category Parameter Name Type Default nded Exadata
Additional OPTIMIZER _MODE | string ALL ALL ALL
needed ROWS ROWS ROWS
parameters - -
COMPATIBLE string 11.2.0 (for 11.2.0 .3.0(f
Oracle using Oracle
11gR2) 11.2.0.3.0)
otherwise
11.2.0.2.0
GLOBAL NAMES string FALSE TRUE TRUE
PRE PAGE_SGA string FALSE TRUE TRUE
UNDO _ string AUTO AUTO AUTO
MANAGEMENT
UNDO _ string Set as Per Set as Per
TABLESPACE Site Values Site Values
UNDO_RETENTION | integer 900 10800 18000
TIMED_STATISTICS | boolean TRUE TRUE TRUE
OPTIMIZER _ integer 0
INDEX CACHING
OPTIMIZER _ integer 100 30
INDEX COST_ADIJ
QUERY_REWRITE | string TRUE FALSE FALSE
ENABLED
STAR _ string FALSE FALSE FALSE
TRANSFORMATION
_ENABLED
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FAQs and Error Dictionary

This section of the document consists of resolution to the frequently asked questions and error
codes noticed during OFSAALI installation.

> Frequently Asked Questions
> Error Dictionary

OFSAALI installer performs all the pre-requisite validation check during installation. Any errors
encountered in the process is displayed with an appropriate Error Code. You can refer to the
Error Dictionary to find the exact cause and resolution to rectify the error.

Frequently Asked Questions

You can refer to the Frequently Asked Questions which has been developed with the interest to
help you resolve some of the OFSAALI Installation and configuration issues. This intends to
share the knowledge of problem resolution to a few of the known issues. This is not an official
support document and just attempts to share the knowledge of problem resolution to a few of
the known issues.

This section includes the following topics:
» OFSAAI FAQs
> Applications Pack 8.0.0.0.0 FAQs

> Forms Framework FAQs

OFSAAI FAQs
What are the different components that get installed during OFSAAI?

The different components of OFSAALI are illustrated in Figure 1-2, "Components of
OFSAAT".

What are the different modes of OFSAAI installation?
OFSAAI can be installed in two modes, Silent Mode, and GUI mode.
Can the OFSAA Infrastructure components be installed on multi-tier?

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on multi-tier.
By default, they will be installed on single-tier. However, OFSAA Infrastructure can be
deployed within the n-Tier architecture where the Database, Web Server and Web Application
Server is installed on separate tiers.

Is JDK (Java Development Kit) required during installation of OFSAA? Can it be
uninstalled after OFSAA installation?
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JDK is not required during installation of OFSAA and only a run time is needed for
details. Refer Hardware and Software Requirements, Java Runtime Environment section.

Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI
installation?

Only JRE (Java Runtime Environment) is required during installation of OFSAA and
cannot be uninstalled as the JRE is used by the OFSAA system to work.

How do I know what is the Operating system, webservers and other software versions that
OFSAA supports?

Refer to OFSAA Technology Stack Matrices.
What are the different files required to install OFSAAI?

The following files are required:

> setup.sh.

> envCheck.sh

> preinstallcheck.sh

> Verlnfo.txt

> OFSAAlnfrastructure.bin

> validatedXMLinputs.jar

> MyResources_en_US.properties

> logdj.xml

> OFSAAI PostlnstallConfig.xml

> OFSAAI InstallConfig.xml

> privileges_config user.sql

> privileges atomic user.sql

> XML Utility.jar

What should I do if I get the following error message during installation, "Execute
Permission denied"?

Please check whether all the files provided for OFSAALI installation has execute
permissions.

To give execute permissions,
> Navigate to the path OFSAAI 80000 and execute the command
chmod 755
"Graphical installers are not.."

If error resembles "Graphical installers are not supported by the VM. The console mode
will be used instead..." then check whether any of the X-windows software has been
installed.

Example: Hummingbird Exceed is started and configured to Graphical mode installation.

Note: Type 'xclock' from prompt and this should display clock in
graphical mode.
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""No Java virtual machine could be..."

If the error message reads "No Java virtual machine could be found from your PATH
environment variable. You must install a VM prior to running this program", then

> Check whether "java path" is set in PATH variable. See the Table 3—1, " Prerequisite
Information"section in this document.

> Check whether sufficient temporary space is available.

> Ensure that the movement of OFSAALI Installer text files to the target system is done
in the Text mode so that setup. sh file does not contain control line feed characters
("M).

What should I do if I get the following error message during installation, "OracleDriver
Files Not Found, Please Choose the Right Path To Continue''?

Check whether the provided path for Oracle Driver files is correct and whether the user has
permissions to access the files.

What should I do if I get the following error message during installation, ""User must have
CREATE TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX, CREATE
SEQUENCE, CREATE PROCEDURE' even though the oracle schema user created has the
mentioned privileges?

OFSAALI installer validates the database details provided during installation, so ensure:

> Whether the oracle schema user has the required set of privileges for successful
installation.

> Whether the oracle schema user has been created with quota privileges on tablespace
to create database objects.

> See the Table 3—1, " Prerequisite Information" section in this document.
Installation of OFSAAI was completed successfully! What next?

Post the successful completion of OFSAALI installation, one has to perform the Post
Installation steps. See Chapter 5, "Post Installation Configuration".

What is to be done when OFSAAI Installation is unsuccessful?

OFSAALI installer generates log file OFSAAInfrastructure Install.log in the
Infrastructure Installation Directory. There is also another log file created in the path
configured in Log4j .xml. The logs of any of these reported, Warnings/Non Fatal
Errors/Fatal Errors/Exceptions should be brought to the notice of the OFSAAI Customer
Support. It is recommended not to proceed, until the reported problems are adequately
addressed.

How do I completely uninstall OFSAAI?

OFSAALI can be completely uninstalled by performing the steps provided in Uninstalling
OFSAA Infrastructure in the OFS AAAI Installation and Configuration Guide Release
8.0.0.0.0.

Can OFSAAI config and atomic schemas be on different databases?

OFSAALI requires both config and atomic schemas to be present on the same database
instance.

How to grant privileges if a new information domain is created?

If you are creating a new information domain, provide a set of privileges (database
permissions) to the new Atomic schema.

> Log into the database as sys and connect as sysdba user.
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> Execute the file privileges config user.sql available under $FIC HOME
directory

> Enter the database schema for which you want to grant privileges.
When should I run the MLS utility?

See the Multiple Language Support (MLS) Utility section in OFS AAI Administration
Guide available on OTN.

Does OFSAAI support Oracle Linux versions other than 5.5?

OFSAALI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 and
above.

What should I do if I get the following error message on the UNIX System terminal while
executing ./setup.sh, "Insert New Media. Please insert Diskl or type its location''?

1. Login as root user on the Unix machine where OFSAALI is getting installed.

2. Navigate to the path /etc/security/.

3. Edit the file 1imits.conf to add/edit a row for the unix user installing OFSAA:
<Unix User> soft nofile 9216

4. After saving the changes, log in as unix user with which OFSAALI is getting installed
and execute the command:

ulimit -n
The command should return the value 9216.
How do I verify if the system environment is ready for OFSAAI installation?

To verify the system environment meets the minimum requirements for the installation, a
Pre-Install Check utility is available within the Install Kit archive file. This utility can also
be obtained separately by contacting Oracle Support.

See Verifying System Environment section for additional information.
How do I know if the installation is completed successfully?

The OFSAA Infrastructure installation performs a post install health check automatically
on successful installation of the product. To rerun the post install verification at a later
time, perform the following steps:

1. Navigate to the path SFIC_HOME (Product Installation Directory).
2. Execute the command:
./piverify.sh
What should I do if the installation in GUI mode is not invoked?

There are set of configuration steps required to be performed during the installation in
GUI mode. Verify whether the steps mentioned under Configuration for GUI Mode
Installation section are done correctly.

What should I do if there are any exceptions or errors in installation and how to proceed?
1. Please backup the installation logs.
2. Share the backup logs with Oracle support.

What should I do if I get the following error message during OFSAAI installation on Solaris
11 system?:

"Error: OFSAAI-1108
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ORA-00604: error occurred at recursive SQL level 1
ORA-01882: timezone region not found"
Or

"Time zone cannot be set as null or 'localtime

This happens if the time zone is not set, that is NULL or it is set as "localtime’. Set the
environment variable TZ to a valid time zone region in the .profile file. For example,

TZ=Asia/Calcutta
export TZ
What should I do if the installation process is abruptly terminated or aborted?

If the installation is abruptly terminated, then the installation process will be incomplete.
To recover from this, follow the below steps:

1. Drop the DB objects in the config schema created by OFSAALI installation.

2. Open the .profile and remove the entries made by the OFSAAI installation which
are made between the comment statements, #Beginning of entries by OFSAA
Infrastructure installation and #End of entries by OFSAA Infrastructure installation.

3. Delete the OFSAA install directory created by the OFSAALI installer.
4. Perform the OFSAALI installation again.

Does OFSAA support any other web server types, other than the ones stated in tech matrix
and installation guide?

No, all the supported softwares and versions are stated in the OFSAA Technology Stack
Matrices.

What should I do if the database connection from connection pool displays the following
error message, ""java.sql.SQLRecoverableException: 10 Error: Connection reset'?

This happens while running several database intensive tasks in parallel. To correct this error,
add the line securerandom. source=file:/dev/./urandom in the java.security
configuration file available in $JAVA HOME/jre/lib/security/ path.

Note: This needs to be configured on all the machines or VMs where the
OFSAAI components are installed.

If the issue is not resolved even with the above settings, check the MTU(Maximum
Transmission Unit) settings on the linux box. For details on MTU settings and updating
them, contact your system Administrator.

What should I do when I get syntax errors/file not found error messages while invoking
setup.sh file from my install archive?

This could mostly happen:
> When installer was not unzipped rightly or corrupted during unzip.

> setup.sh file which resides within the install archive was not transferred in ASCII or
text mode, which could have corrupted the file.

To correct this, follow the steps:

1. Copy the installer (in BINARY mode) to the system on which the OFSAA
Infrastructure components will be installed.
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2. Unzip the installer using the command:
unzip <OFSAAI Installers>.zip

3. The corrupted setup. sh file would have introduced certain “M characters into the
file. You can remove "M characters from setup.sh file by following the below steps:

a. Login to the server where the installer is copied.
b. Navigate to the directory OFSAAI 80000.
c. Open the setup.sh file in the vi editor using the command: vi setup.sh.

d. Inside vi editor in Esc mode, type: %s/*M//g

Note: To enter “M, hold the CTRL key then press V and M in succession.

e. Save the setup.sh file by typing: wq!
Does OFSAA support Oracle DB 11g Standard edition?

The OCI client and the jdbc driver does not change depending on whether it is a standard
or enterprise edition. So, OFSAAI will work with standard edition as well.

We do not recommend standard edition because it will not scale and does not support
partition pack, database security vault, or advanced analytics.

What should I do if I get the following error message while executing ./startofsaai.sh file on
the UNIX System terminal "./startofsaai.sh: /java: Execute permission denied'?

> Ensure JAVA BIN environment variable path is set on the "unix user" terminal from
where the . /startofsaai.sh file is invoked.

> Ensure the .profile where the environment/ path settings are made has been
executed successfully.

What should I do if the OFSAAI Login page does not open and I get the following error
message, ""Could not retrieve list of locales''?

This could be due to 2 reasons:

> System is unable to resolve the hostname configured.
> Conflict with the ports configured.

To correct them, follow the below steps:

A. Steps to replace the hostnames with IP address:

1. Stop all the OFSAA services. For more information, refer Stopping Infrastructure
Services.

2. Replace all the hostnames with the IP address in all the places mentioned in the
document (Where to find port, IP address, HTTPS Configuration for OFSAAI 7.2
Installation (DOC ID 1500479.1)).

3. Restart all the OFSAALI services. For more information, refer Starting Infrastructure
Services section.

w

. Steps to correct the port number conflicts

1. Stop all the OFSAA services.
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2. Referto the port numbers stated in the document (Where to find port, IP address,
HTTPS Configuration for OFSAAI 7.2 Installation (DOC ID 1500479.1)) and check
on the discrepancy in the port numbers and correct them.

3. Restart all the OFSAAI services.

What happens when the OFSAAI Application Server does not proceed even after providing
the system password?

Ensure that, the System Password provided when prompted should match with the "Oracle
Configuration password" provided during installation. Also check whether the connection
to the "configuration schema" can be established through sqlplus.

Although the OFSAAI installation has completed successfully, when OFSAAI servers are
started, and the application URL is accessed, it gives an error message "'the page cannot be
found or displayed" or ""Could not retrieve list of languages from Server. Please contact the
system administrator''. What should one do?

Ensure OFSAALI servers have been started and are running successfully. On the server start
up parameters options, refer Starting Infrastructure Services section.

For more details on the issue, refer on to the Revappserver log in SFIC_APP
HOME /common/FICServer/logs directory or the Web Server log files.

Is it necessary to provide the specified grants to the Oracle schema user before
installation? If yes, can it be revoked after completing the installation?

The "Oracle schema" user requires the necessary grants specified before, during, and after
the installation process. Grants provided should never be revoked as the application makes
use of these grants all the time.

Can we have distributed OFSAAI Application Server for load balancing?

OFSAALI Application server can be scaled out/distributed across different JVM's
(machines) based on the various services and Information Domains, in other words, Load
balancing could be achieved with distribution of services.

Why do we need Ftpshare on all the layers? Can we have ftpshare on another machine other
than the machines where OFSAAI is installed?

Ftpshare is a Metadata Repository directory. All the metadata related files used in
Infrastructure are stored in the ftpshare directory. The ftpshare contains folders for each
Information Domain, with each Information Domain folders holding Erwin, log, and
scripts folder. The transfer of data among the Web, Application, and Database servers in
Infrastructure takes place through FTP/SFTP.

You need to configure FTP/SFTP and enable communication between the servers by
providing App server's FTP/SFTP credentials to the Web server and DB server users.

Yes, we can have ftpshare on another machine other than the machines where OFSAAI is
installed.

Is it mandatory to provide the ftp/sftp password?

Yes, OFSAAI needs credentials of the user which has complete permissions on ftpshare
directory, and should be able to independently login to the unix server.

What are the permissions required for ftpshare and when should I give them?

It is recommended to provide permissions on ftpshare in case of installations done across
different machines or VMs (multitier installation).

In case of single tier installation, 770 permissions can be provided if the unix users of
OFSAALI and web server belong to the same unix group.
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And on any new file that is created in the 'ftpshare' folder of any installation layer should
be granted specific/explicit permission.

Port Change utility could be used to have the Port number modified, which are currently
being used by the Infrastructure application. For more information, refer Changing IP/
Hostname, Ports, Deployed Paths of the OFSAA Instance section.

Are there any in-built system administration users within OFSAAI Application?

The three in-built system administration users are provided to configure and setup

OFSAAL

> SYSADMN
> SYSAUTH
> GUEST

Does OFSAAI Application support both FTP and SFTP?
OFSAALI supports both FTP and SFTP configuration.
Is it necessary to enable the FTP/SFTP services to use the OFSAAI?

Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards using the
OFSAAL

OFSAAI Configuration: Unable to save the server details?
> Ensure the input User ID, Password, and Share Name are correct.
> Ensure FTP/SFTP services are enabled.
> Have a test FTP/SFTP connection made and confirm if they are successful.

What should I do if I get the following message while creating Information Domain, "'Please
create a database and then create the information domain''?

Information Domain is mapped to only one Database; and thus before the creation of
Information Domain, at least one database details would need to exist.

What should I do if I get the following message during startup of backend engine message
server, ""ConnectToDatabase: FatalError, could not connect to the DB server'?

Verify whether connection to the "configuration schema" can be established through sqlplus.
> Verify "configuration schema" password is modified post installation.

> Ensure oracle database alias name created for oracle instance and oracle service name
are same.

> On a multi tier Installation mode, ensure TNSNAME and SID are the same in both the
Application and Database Layers.

What should I do if I get the following message during the startup of backend engine
message server, ""Fatal Error, failed to get user ID from LibSmsConnect"'?

Ensure Reveleus.sec file exist under the SFIC_HOME/conf directory where the Database
components are installed.

Does OFSAAI Application support LDAP authentication?
OFSAALI supports LDAP configuration and authentication.
Does OFSAAI support multiple languages?
Yes, OFSAALI supports multiple languages.
Does OFSAAI provide any data back-up features?
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OFSAALI does not have built-in back up facility. External Storage Infrastructure is
recommended for back-up.

What kind of security features does the OFSAAI provide?
OFSAALI provides security at:
> Segment Level - Users can access only the segment they are mapped to.

> Application Level - Users can perform an operation only if mapped to appropriate role
and functions.

Does OFSAAI have the ability to enforce periodic password change?

OFSAALI provides configurable parameters to define number of days after which the user
password would expire and then the user is forced to change the password after expiration
period.

What is the password policy followed in OFSAAI?

OFSAALI enforces a minimum password length with a combination of Upper and Lower
case characters and alpha-numeric strings.

Which version of Erwin Data Modeller does OFSAAI support?

OFSAAI now supports ERwin version 9.2 and 9.5 generated xmls in addition to ERwin
4.1, ERwin 7.1, ERwin 7.3 and ERwin 9.0 formats.

Does OFSAAI provide the mechanism to upload Business Data model?
OFSAALI provides two mechanisms for business data model upload:

> Easy to use GUI based Model upload mechanism to upload the Business Data Model
through Unified Metadata Manager --> Import Model.

> OFSAAI also provides a model upload utility "upload. sh" for uploading the business
data model through the command line parameter by executing this shell script file
under the path <FIC HOME>/ficapp/common/FICServer/bin.

Refer the section Run Model Upload Utility of the OFS Analytical Applications Infrastructure
User Guide available on OTN for details.

How do I apply incremental change to the existing model when the Business Data model
undergoes a change?

Modified data model can be uploaded into the system and OFSAALI has the ability to
compare the changes within the data model with respect to the one already present in the
system and enables propagation of incremental changes in a consistent manner.

What are the different types of uploading a business data Model?

OFSAALI supports uploading of business data model from client desktop and also by
picking up the data model from the server location.

Can the OFSAAI "Configuration Schema' password be modified post installation?

The OFSAAI "configuration schema" password can be modified post installation. OFSAAI
application stores the password in the database and few configuration files, thus any
changes to the "configuration schema" password would necessitate updating in these.
Contact OFSAALI support for more details.

Can the OFSAAI "Atomic Schema' password be modified?

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application stores the
atomic schema password in the database and few configuration files, thus any change to
the atomic schema password would necessitate updating the password.
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To change the Atomic Schema password, follow the steps:
1. Login to OFSAA.

2. Navigate to System Configuration > Database Details window. Select the appropriate
connection, provide the modified password and save.

3. Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator >
Define Sources window. Update the appropriate Source details.

a. Ifyou are using Apache Tomcat as Web server:

*  Update the <Context> -> Resource tag details in server.xml file from the
SCATALINA HOME/conf folder. (In case of Tomcat only Atomic <Resource> will
exist).

b. If you are using WebSphere as Web server:
*  Login to the WebSphere Administration Console from the left side menu.

*  Navigate to Resources >JDBC >Data Sources. A list of data sources will be
populated on the right side.

*  Select the appropriate Data Source and edit the connection details. (In this case,
both Config and Atomic data sources need to be modified).

c. Ifyou are using WebLogic as Web server:
*  Login to the WebLogic Administration Console from the left side menu.

*  Under Domain Structure list box, expand the appropriate Domain and navigate to
Services > JDBC >Data Sources. A list of data sources will be populated on the
right side.

*  Select the appropriate Data Source and edit the connection details. (In this case,
both Config and Atomic data sources need to be modified).

4. Restart the OFSAAI services

Note: If the modified passwords are not updated, OFSAAI logs displays
the message ORA-28000: the account is locked.

Does the upload of Business Data model depend on Java Memory?

Business data model upload through OFSAAI depends on the Java memory settings on the
client and server machines. Java memory setting varies with the data model size and the
available RAM. Contact OFSAAI support for more details.

Why do the Business Metadata Management screens (Business Processors screen) in the
User Interface, take more time to load than other screens?

The Log file in DynamicServices.xml which resides in SFIC_HOME/conf is
continuously being updated/refreshed to cache metadata. This can be observed when you
are starting startofsaai.sh and if any of the log file (Ex: SMSService.log) in
DynamicServices.xml is being continuously refreshed for longer time.

By default, the Metadata Log file cache size is set to 1000. If in case the log is being
updated beyond this limit, retrospectively the preceding entries are overwritten. For
example, the 1001th entry is overwritten by deleting the first entry. This results in the
application screen taking a longer time to load.

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf,
depending on the currently logged count for the specific metadata.
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1. Generate the Log report by executing the below query in config schema.
select count(l), t.metadata name, m.dsn_ id
from metadata master m, metadata type master t
where m.metadata type = t.metadata type
group by t.metadata name, m.dsn_id

2. The above query returns a list of codes with their respective metadata count. You can
refer to "metadata_type master" table to identify the metadata name.

3. View the log report to identify the metadata which is being updated/refreshed beyond
the specified cache size limit. Accordingly increase the cache size limit in
Dynamicservices.xml depending on the currently logged count for the specific
metadata.

For example, if the "MEASURE CACHE_SIZE" is set to 1000 and total measure
reported in log is 1022, increase the limit to 2000 (approximately).

4. Restart Reveleus/OFSAALI servers (Web and APP) and check the issue.

What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere
application server?

The Java memory needs to be increased in ejbdeploy. sh file which is present under
<WebSphere Install directorys/AppServer/deploytool/itp. For example,

$JAVA CMD \
-Xbootclasspath/a:$ejbd bootpath \
Xms256m -Xmx1024m \
What configurations should I ensure if my data model size is greater than 2GB?

In order to upload data model of size greater than 2GB in OFSAAI Unified Metadata
Manager- Import Model, you need to configure the required model size in struts.xml
file available in the path $SFIC WEB_HOME/webroot/WEB-INF/classes.

Note: The size requirements have to be always specified in bytes.

For example, if you need to configure for model size of 2.5GB, then you can
approximately set the max size to 3GB (3221225472 bytes) as indicated below, in order to
avoid size constraints during model upload.

<constant name="struts.multipart.maxSize" value="3221225472"/>

After configuring struts.xml file, generate the application EAR/WAR file and redeploy
the application onto your configured web application server. For more information on
generating and deploying EAR / WAR file, refer Appendix C.

What should I do if my Hierarchy filter is not reflecting correctly after I make changes to the
underlying Hierarchy?

In some cases, the Hierarchy Filters do not save the edits correctly if the underlying
Hierarchy has been changed. This can occur in hierarchy maintenance, where you have
moved a member to another hierarchy branch, and that member was explicitly selected in
the Filter and is now a child of a node which is already selected in the Filter.

Please refer to Support Note for the workaround.
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Can I install an Applications Pack on an existing Atomic schema/ Information Domain
created manually?

No, you cannot install an Applications Pack on existing Atomic schema/Information Domain
created manually. Applications Packs can be installed only on Atomic Schemas/Information
Domain created using schema creator utility and/ or the Applications Pack installer.

What should I do if I get the following exception while trying to view the model outputs in
Model Outputs screen, ""Exception ->Local Path/STAGE/Output file name (No such file or
directory)''?

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" in the
web server details screen. This folder needs to be created under the local path on every node, in
case of web application server clustering.

What should I do if I get the following exception during OFSAA services startup, "Exception
in thread "main" java.lang.UnsatisfiedLinkError: net (Not a directory)'?

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to point to
a physical JRE installed.

What is the optimized memory settings required for "New'' model upload?

The following table lists the optimized memory settings required for "New" model upload.

Table R-1 Optimized Memory Settings for New Model Upload

X_ARGS_APP ENV
Size of Data Model Variable in OFSAAI
Model Upload Options XML File APP Layer

Pick from Server 106 MB "-Xms1024m
-Xmx1024m

36 MB "-Xms2048m
-Xmx2048m

815 MB "-Xms4096m
-Xmx4096m

1243 MB "-Xms6144m
-Xmx6144m

Model Upload Utility 106 MB "-Xms1024m
-Xmx1024m"-Xms2048m
-Xmx2048m

336 MB "-Xms4096m
-Xmx4096m

815 MB "-Xms4096m
-Xmx4096m

1243 MB "-Xms6144m
-Xmx6144m

Save New Erwin File In 106 MB "-Xms1024m
Server -Xmx1024m

336 MB "-Xms2048m
-Xmx2048m

"-Xms4096m
-Xmx4096m

"-Xms6144m
-Xmx6144m
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What should I do if I get the following error message, "ORA 01792 maximum number of
columns in a table or view is 1000 during T2T execution"'?

You should apply the below patch set from Oracle. Applicable only for 12c.
https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1

1 did not enable OFS Inline Processing Engine Application license during the installation.
However, I have enabled it post installation, using the Manage OFSAA Product License(s) in
the Admin UI. Are there any other additional configurations that I need to do?

Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration
Guide available on OTN.

1 get an error when I try to build an Oracle OLAP cube. What should I do?

Execute the below grant on the appropriate ATOMIC schema
grant olap user to &database username

How do you turn off unused Information Domains (Infodoms) from caching?
Follow these steps to turn off unused infodoms from caching:

1. Navigate to SFIC_HOME/conf in the APP layer of your OFSAALI installation.

N

In the DynamicServices.xml file, identify the section for <Service code="20">.
3. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1).

Repeat the same in the WEB layer too. Generate the application EAR/WAR file and
redeploy the application onto your configured web application server. For more
information on generating and deploying EAR / WAR file, refer Appendix C.

4. Restart the OFSAAI Services (APP and WEB). For more information, refer to the Starting
/ Stopping Infrastructure Services. section

Note: This setting will cache the Infodom metadata only for the infodoms
that get accessed upon user login. Infodoms which do not get accessed, will
not be cached.

Sample code is as follows:

<SERVICE CODE="20"
CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD"
SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10">
<PARAMETERS >

<PARAMETER NAME="CACHE ON_STARTUP" VALUE="0" />

<PARAMETER NAME="BACKUP_XML" VALUE="1" />

<PARAMETER NAME="MAX BACKUP_XML" VALUE="2" />

<PARAMETER NAME="PC NONBI BI SWITCH" VALUE="2048" />

<PARAMETER NAME="HIERARCHY NODE LIMIT" VALUE="2000" />

<PARAMETER NAME="ALIAS CACHE SIZE" VALUE="1000" />

<PARAMETER NAME="DATASET CACHE SIZE" VALUE="2000" />

<PARAMETER NAME="MEASURE CACHE SIZE" VALUE="2000" />

<PARAMETER NAME="HIERARCHY CACHE SIZE" VALUE="2000" />
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<PARAMETER NAME="DIMENSION CACHE SIZE" VALUE="2000" />
<PARAMETER NAME="HIERARCHYATTRIBUTE CACHE SIZE" VALUE="1000" />
<PARAMETER NAME="CUBE CACHE SIZE" VALUE="1000" />

<PARAMETER NAME="RDM CACHE SIZE" VALUE="1000" />

<PARAMETER NAME="BUSINESSPROCESSOR CACHE SIZE" VALUE="2000" />
<PARAMETER NAME="DERIVEDENTITY CACHE SIZE" VALUE="1000" />
<PARAMETER NAME="LOG_ GET METADATA" VALUE="false" />

<PARAMETER NAME="METADATA PARALLEL CACHING" VALUE="0" />
</PARAMETERS >

</SERVICE>

While creating an Excel Mapping, after specifying the excel worksheet, the target table, and
mapping each column in the worksheet to a target table, I click SAVE and nothing happens.
But when I click CANCEL, a message pops up informing me that all changes will be
discarded', what is to be done?

Check if the excel mapping creation is done using [.E 8 with JRE 1.4 plug in enabled on
machine. If so, upgrade the JRE plug in to 1.7+.

Can Multiple OFSAA Infrastructure instances share the same config schema?
No, only one OFSAA environment can be installed using one config schema.
Can Atomic schema be shared?

Yes, it can be shared between two OFSAA instances.

While setting a firewall, which ports should be opened for communication between the Web
Server (Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and the Web
Application Server (WebSphere/ WebLogic/ Tomcat) for OFSAAI to operate properly?

The OFSAA Servlet port which is same as Web server port should be open. Also the web
application port should be open.

Can I modify the NLS LENGTH_SEMANTICS to BYTE from CHAR for the Database
where older versions of OFSAA is Installed?

Yes, NLS LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are not
intending to use multi language support.

Can I install already installed application in a different infodom?
No, it is not possible to install the same application in two different infodoms.
How can I configure the OFSAA application for High Availability?

OFSAA can have active-passive high availability. For more details, refer Configuring OFSAA
in Clustered Environment Guide.

During OFSAA installation should I provide web application server's IP /Hostname and port
or web server's IP/Hostname and port, if the Apache HTTP Server/ Oracle HTTP Server/
IBM HTTP Server are configured?

In case the web server is configured, you should enter the Web Server I[P Address/Hostname
and Port details during OFSAA installation. Here the Servlet port should be same as the Web
Server port.
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If Web Server is not configured, the Web Application Server's IP Address/ Hostname and Port
is required during the installation process. Here the Servlet port should be same as the Web
application Server port.

Is "ReveleusAdminConsoleAgent" applicable for OFSAAI 8.0.0.0.0 and higher versions?

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. There is
a change in the way agentservers are managed through AGENTSTARTUP.SH &
AGENTSHUTDOWN. SH.

What should I do when the message server process does not open and I get the following
error message, ""CI18NProvider::CI18NProvider, Error, unable to connect to the config
database'?

This error is displayed due to the following reasons:
> The Config Schema password is already expired.

> If the config schema password is going to expire soon and the message like "ORA-28002:
the password will expire within 6 days" displays while connecting to config schema
through sqlplus.

> The Config schema password is Modified.

To resolve the error, re-set the config schema password to the old password. Else, if the config
schema password is modified to something else then follow the below steps:

1. Delete the SFIC_HOME/conf/Reveleus.SEC file.

2. Shutdown the OFSAAI App service: cd SFIC_APP
HOME/common/FICServer/bin ./stopofsaai.sh

3. Shutdown the OFSAAI App service: cd SFIC_APP
HOME/common/FICServer/bin ./stopofsaai.sh

4. Start the Infrastructure Server in foreground directly on the server or through XWindows
software using the command: . /startofsaai.sh

5. Enter System Password.

6. Enter the new Config schema password. The service starts and initializes if it is able to
successfully connect to the DB and generates the Reveleus. SEC file.

7. Post successful startup of the service, if required, the Infrastructure server may be shut
down and restarted in the background using nohup mode.

What is the mechanism of Log File sizing and backup?

OFSAAI Log files created under SFIC_APP HOME/common/FICServer/logs &
<OFSAAI DEPLOYED AREA>/<CONTEXT.war>/logs is configurable in
RevLog4jConfig.xml.

The default size of the log files (MaxFileSize) is set to max 5000kb & number of max backup
log files (MaxBackuplIndex) retained is set to 5, both of which are configurable. Increasing
these parameters to a higher value should depend on the server HW configurations and may
reduce the performance.

To configure the Logs file size on OFSAA Application server, follow these steps:
1. Navigate to SFIC_HOME/conf where OFSAA is installed.
2. Edit the following parameters in the file RevLog4jConfig.xml

> <param name="file" : Enter the path where the Logs are to be generated.

> <param name="MaxFileSize" : Provide the required file size.
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> <param name="MaxBackupIndex" : Provide the required number of backup files to be
created.

Example:

<appender name="REVSERVERAPPENDER"
class="org.apache.log4j.RollingFileAppender">

<param name="file" value="$FIC7
HOME/ficapp/common/FICServer/logs/RevAppserver.log"/>

<param name="Append" value="true" />

<param name="MaxFileSize" value="5000kb" />

<param name="MaxBackupIndex" value="5" />

<layout class="org.apache.log4j.PatternLayout">

<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/>
</layout>

</appender>

To configure the Deployed area logs file, follow these steps:

1. Navigate to <EAR/WAR Deploy area>/conf folder.
2. Repeat step 2 from the above section.

Can we modify the Log file path?

Yes. Log file path is configurable, it can be configured in RevLog4jConfig.xml . default
log file path (file) is set by the installer. This can be configured to another path.

Can I point the environment with HTTP enabled to HTTPS after installation and vice versa?
Follow these steps:
1. Create SSL related certificates and import to respective servers.

2. Enable SSL on a desired Port (example 9443) on your existing and already deployed web
application servers.

3. Replace the protocol as https and new ssl port (FIC_ SERVLET PORT) configured and in
all the URLSs specified on below files:

? SFIC HOME/ficapp/common/FICServer/conf/FICWeb.cfg and $FIC
HOME/ficweb/webroot/conf/FICWeb.cfg

? $FIC HOME/ficapp/icc/conf/WSMREService.properties

? SFIC HOME/ficweb/webroot/conf/ModelExecution.properties

2 SFIC _HOME/ficdb/conf/MDBPublishExecution.properties

? SFIC HOME/ficdb/conf/ObjAppMap.properties

2 SFIC HOME/utility/Migration/conf/WSMigration.properties

? SFIC _HOME/utility/WSExecution/conf/WSExecution.properties

? SFIC_
HOME/EXEWebService/WebSphere/ROOT/WEB-INF/wsdl/EXEWebServiceImpl
.wsdl

»  SFIC_
HOME /EXEWebService/Tomcat/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.ws
dl

2 $FIC_
HOME/EXEWebService/weblogic/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.
wsdl
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4. Replace XML attribute/Node values as specified on below files:
? SFIC _HOME/ficweb/webroot/WEB-INF/web.xml
FIC WEBSERVER PORT=9443
»  FIC_WEBPROTOCOL=https

SFIC _HOME/conf/LookUpServices.xml and SFIC
HOME/ficweb/webroot/conf/LookUpServices.xml

PORT="9443" PROTOCOL="https:"

5. Login to config schema and execute below SQL command to replace protocol and SSL
port.

SQL> update configuration cn set cn.paramvalue='9443' where
cn.paramname='SERVLET_ENGINE_PORT';

SQL> update configuration cn set
cn.paramvalue=replace (cn.paramvalue, "http:', 'https:') where
cn.paramname='FormsManagerCacheReload';

SQL> update web server info ws set
ws.servletport='9443"',ws.servletprotocol="https"';

6. Create EAR/WAR file and Re-Deploy.
What should I do if the sliced data model upload takes a long time to complete?

If the metadata cache size is set to a lower value than the actual count of each metadata type
(hierarchy, dataset, dimension etc), then it gets into performance degrade issues. We have to
increase the cache size for each metadata type according to the count in the environment.

Following are the parameters in DynamicServices.xml to be configured depends on the
metadata count in your environment.

<PARAMETER NAME="HIERARCHY NODE LIMIT" VALUE="2000"/>
<PARAMETER NAME="ALIAS CACHE SIZE" VALUE="1000"/>
<PARAMETER NAME="DATASET CACHE SIZE" VALUE="2000"/>
<PARAMETER NAME="MEASURE

CACHE _SIZE" VALUE="3000"/>

<PARAMETER NAME="HIERARCHY

CACHE SIZE" VALUE="2000"/>

<PARAMETER NAME="DIMENSION

CACHE SIZE" VALUE="2000"/>

<PARAMETER NAME="CUBE_CACHE SIZE" VALUE="1000"/>

<PARAMETER NAME="BUSINESSPROCESSOR CACHE SIZE"

VALUE="2000"/>

<PARAMETER NAME="DERIVEDENTIT

Y CACHE SIZE" VALUE="1000"/>

Metadata count can be derived based on the following queries:

select count (1) from metadata master where metadata version=0 --- for all
metadata select count (1) from metadata master where metadata version=0
and metadata type=1 --- for measure
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select count(l) from metadata master where metadata version=0 and
metadata_

type=2 --- for Dimension

select count(l) from metadata master where metadata version=0 and

metadata_

type=3 --- for HCY

select count(l) from metadata master where metadata version=0 and
metadata_

type=4 --- for DATASET

select count(1l) from metadata master wh
ere metadata version=0 and metadata
type=59 --- for BP's

select count(l) from metadata master wh
ere metadata version=0 and metadata
type=54 --- for Alias

select count(1l) from metadata master wh
ere metadata version=0 and metadata
type=5 --- for CUBES

select count(1l) from metadata master wh
ere metadata version=0 and metadata
type=856 --- for Derived Entit

For LDAP authentication, which server connects with the LDAP server, the Application
server (where ofsaai is installed), or Web Application server (where EAR is deployed)?

For LDAP authentication, the Application server (ficapp) connects with the LDAP server.

The LDAP server in the setup listens on secure protocol ldaps (port 636). I have the root
certificate of the LDAP server for SSL, and would like to know where to offload this
certificate?

You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp layer.
How to relocate FTPSHARE folder?

You can run the PortC.jar utility. For more details, refer Changing IP/Hostname, Ports,
Deployed Paths of the OFSAA Instance section in the OFSAAI Admin Guide available on OTN.

How do we identify the list of ports that are used by/configured in an OFSAA environment?
1. Navigate to SFIC_HOME folder on Target.
2. Run the PortC jar utility using the command:

java -jarPortC.jar DMP

A file with the name DefaultPorts.properties will be created under $FIC_HOME
directory which will contain the ports. For more information, refer Changing IP/Hostname,
Ports, Deployed Paths of the OFSAA Instance section in the OFSAAI Admin Guide
available on OTN.

What should I do if I get the following error message, ""Error while fetching open cursor
value Status : FAIL"?
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This error occurs while executing envCheck.sh because the user does not have access to
Vsparameter. This error does not occur due to sysdba or non sysdba privileges provided they
have access/grants to VSparameter.

Applications Pack 8.0.0.0.0 FAQs

What is an Applications Pack?

An Applications Pack is suite of products. For more information, refer About OFSAA
Infrastructure.

Can I get a standalone installer for OFSAAI 8.0?

No. AAI is part of every Applications Pack and installs automatically.

How does OFSAA 8.0 Applications Pack relate to OFSAA 7.x series?

8.0 is a new major release consolidating all products from OFSAA product suite.
Can existing OFSAA 7.x customers upgrade to OFSAA 8.0 Applications Pack?

There is no upgrade path available. However, we will have migration kit / path for every
product to 8.0 Applications Pack. Further details will be available with Oracle Support.

Does OFSAA 8.0 Applications Pack UPGRADE automatically to existing environments?

No. OFSAA 8.0 Applications Pack has to be installed in an new environment and subsequently
migration path / migration kit needs to be run to migrate from 7.x to 8.0. Note that the objects
can be migrated only from the previously released version of OFSAA products.

Where can I download OFSAA 8.0 Applications Pack?

You can download the OFSAAI 8.0 Applications Pack from Oracle Software Delivery Cloud

(0SDC).

What are the minimum system and software requirements for OFSAA 8.0 Applications
Pack?

Refer installation guide section Hardware and Software Requirements.

Is my environment compatible with OFSAA 8.0 Applications Pack?

Environment Check utility performs the task. It is part of install and can also be run separately.
Does the OFSAA 8.0 Applications Pack support all Operating systems?

OFSAA 8.0 Applications Pack supports the following Operating Systems: LINUX, AIX,
SOLARIS 10, 11. Refer to Technology Matrix for the technology matrix that OFSAA suite
products are/ will be qualified on.

How can I install OFSAA 8.0 Applications Pack?

Refer to Oracle Financial Services Advanced Analytical Infrastructure Installation And
Configuration Guide published in OTN for the Applications Pack installers.

Does this installation require any Third party Softwares?

Oracle Financial Services Advanced Analytical Infrastructure Installation And Configuration
Guide published in OTN lists the third party software that needs to be installed.

What languages are supported during OFSAA 8.0 Applications Pack installation?
US English is the language supported.

What mode of installations OFSAA Applications Pack supports? [i.e., Silent, GUIJ
OFSAA Applications Packs supports both, GUI and Silent Mode.
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Does OFSAA 8.0 Applications Pack support Multi tier Installations?

OFSAA 8.0 supports only single tier installation. For more information refer to OFSAAI FAQs
section.

Does this Applications Pack validate all Pre-requisites required for this installation i.e.,
Memory, Disk Space etc.?

Yes. The pre-requisite checks are done by the respective Applications Pack installer.

What happens if it aborts during installation of any application with in Applications Pack?
You must restore the system and retrigger the installation

Does this Applications Pack 'Roll Back'if any application installation fails due to errors?
Rollback of installation is not supported.

Does the Applications Pack install all applications bundled?

All Applications Pack system files are installed but there is an option to enable the licensed
products.

Can I re-install any of the Applications Packs?

You can retrigger in case of failure.

Does this Applications Pack allow enabling / disabling any of the applications installed?
Yes. You cannot disable once the product is enabled in an environment.

I have installed one application in an Applications Pack, can I install any of new application
within the Applications Pack later?

No, installation of additional applications is not required. If you wish to add an application
later, you can enable the application at that time.

How many OFSAA Infrastructures can be installed in a single server?

There is no issue in installing separate OFSAAI installations, each with their own PFT/FTP
installations and separate associated database instances and separate Web Server installations
on the same server as long as adequate memory is allocated for each instance and as long as
each OFSAALI installation is installed using a separate UNIX user and profile. Care should be
taken if running multiple OFSAALI installations on a single server. Adequate memory will be
required for each installation as several OFSAAI processes (model upload, DEFQ services, etc)
take significant amounts of memory. So it depends on your server memory.

Is it possible to Install OFSAA 8.0 Applications Pack on an existing 'Infodom’ where
another OFSAA 8.0 application is installed?

Yes. However, the Behavioral Detection Applications Pack and Compliance Regulatory
Reporting Applications Pack are the exceptions. They need to be installed in a different
INFODOM.

Can I select an Infodom in Applications Pack during installation?
Yes. You can select or change the required infodom.
Can I install all Applications Packs in a 'Single Infodom'?

Yes. But Behavioral Detection Applications Pack and Compliance Regulatory Reporting
Applications Pack are the exceptions. They need to be installed in a different INFODOM.

Is it possible to install applications on different Infodom within the Applications Pack? (For
example, I want to install LRM & MR in two infodoms)

Applications within Applications Pack have to be installed in the same information domain in
the same environment.
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How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.3.0.0?

You can install only one infodom during installation. But after installation, you can create
multiple infodoms.

Is the 'Data Model' bundled specific to an Applications Pack or to an individual application?

A merged data model for all applications within the Applications Pack is bundled and
uploaded.

Is it possible to install OFS Enterprise Modeling later?

OFS Enterprise Modeling is a separate product and can be enabled as an option later from any
Applications Pack that bundles Enterprise Modeling.

Does the Applications Pack create sandbox automatically for the required applications?
Yes, Sandbox creation is part of application install process.
Are upgrade Kits available for individual applications or the complete Applications Pack?

Maintenance Level (ML) Release / Minor Release upgrades are available across all
applications.

Can I upgrade AAI only?
Yes, you can upgrade AAI alone.

Can I upgrade one application within the Applications Pack? (For example, I want to
upgrade LRM in the Treasury Applications Pack, but not MR.)

No, an upgrade is applied to all applications in the Applications Pack.

Is it possible to uninstall any Application from the Applications Pack?

No, it is not possible to uninstall any Application from the Applications Pack.

Can I uninstall entire Applications Pack?

No, you cannot uninstall the Applications Pack.

Is it possible to uninstall only application and retain AAI in the installed environment?
No, you cannot uninstall only the application and retain AAI in the installed environment.
Does Applications Pack contain all Language Packs supported?

Language Packs need to be installed on 8.0 Applications Packs.

Can I install an Applications Pack over another Applications Pack (that is same infodom or
different infodom)?

Yes, you can install an Applications Pack over another Applications Pack in the same
information domain or different information domain. But Behavioral Detection Applications
Pack and Compliance Regulatory Reporting Applications Pack, Asset Liability Management
Applications Pack and Profitability Applications Pack are the exceptions. They need to be
installed in a different INFODOM.

Can I use an existing manually created schema as information domain for Applications
Pack installation?

No. Schemas required by OFSAA applications have to be created using Schema Creator Utility.
Does OFSAA 8.0 support on WebLogic 10.3.6 with Oracle 12¢?

Yes, OFSAA 8.0 will support on WebLogic 10.3.6 with Oracle 12¢c. WebLogic 10.3.6 supports
oracle 12¢ with some additional configurations. Refer the link
http://docs.oracle.com/cd/E28280 01/web.1111/e13737/ds_12cdriver.htm#JDBCAG655 for
additional configurations.
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What should I do if I get the following error message while running the schema creator
utility, ""HostName in input xml is not matching with the local hostname"'?

One possible reason could be the machine is configured for zonal partitioning. Ensure all the
known IP Addresses of the machine are present in the /etc/hosts file.

What are the Java versions supported in OFS AAAI Applications Pack version 8.0.0.0.0?
OFS AAAI Applications Pack supports Java 1.7.x and 1.8.x.
Is OFS AAAI Applications Pack version 8.0.0.0.0 supported on Java 8?

Yes. To install this release of the OFS AAAI Applications Pack version 8.0.0.0.0 on Java 8. For
more information, refer to specific notes mentioned in the sections Installer and Installation
Prerequisites, Configurations supported for Java 8, Configuring and Executing Schema Creator
Utility, GUI Mode Installation, SILENT Mode Installation.

What should I do when I get "[ERROR] - Error : APP Setup bin file failed."" message during
OFS_Application_PACK installation?

This is a generic error message that appears during application installation failure. You should
check the installation log files for more information about what failed the installation.

However, if the message is displayed and the log files are not generated, it could be that it is a
temp directory issue. The resolution is that your UNIX administrator has to disable the
NOEXEC option. The installers extract the installation files into the /tmp directory, and if
NOEXEC is enabled, execution of binaries will not happen in the directory and the installation
fails. Re-run the installer after the configuration is changed. For detailed information, see the
support note at https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1.

Forms Framework FAQs

What should I do when I have large volume of data to be exported?

It is recommended to use BIP reports or OBIEE reports if you have to export large volume of
data.

How do I export the columns added to the grid using Field Chooser option?

Perform Grid Export operation to export the columns added to the grid by Field Chooser
option.

'Expand All/ Collapse All' button is not visible in the Hierarchy Browser window. What
should I do?

Expand All/ Collapse All button is enabled only if the number of hierarchy nodes is less than
50. If it is more than that, it is considered as large hierarchy and the data will be fetched
dynamically when you expand each node.

Error Dictionary

This contents of this section has been created with the interest to help you resolve the
installation issues if any. There is a compilation of all the possible errors that might arise during
the installation process with the possible cause and the resolution to quickly fix the issue and
proceed further with the installation.

This section includes the following topics:
> Accessing Error Dictionary

> Error Code Dictionary
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Error Dictionary

Accessing Error Dictionary

Instead of scrolling through the document to find the error code, you can use the pdf search
functionality. In the "Find" dialog available in any of the Adobe Acrobat version that you are
using to view the pdf document, follow the below instructions to quickly find the error
resolution.

1. With the Installation pdf open, press Ctrl+F or select Edit > Find.

2. The Find dialog is displayed as indicated.

3. Enter the error code that is displayed on screen during Infrastructure installation.
4

Press Enter. The search results are displayed and highlighted as indicated below.

Figure R-1 Error Code

Error code - OFSAAI-1003

Catse JAVA_HOME/bin ot found in PATH variable

Resolution | 'mport <JAVA_ HOME»bin inlo PATH vanable
Example. PATH = SJAVA_HOMEbin SPATH export PATH

View the details of the issues, its cause, and resolution specific to the error code. Repeat the
step to find an answer to any other errors that you notice during installation. If you are not able
to resolve the issue even after following the steps provided in resolution, you can contact
support.oracle.com along with log files and appropriate screen shots.

Error Code Dictionary

Error code - OFSAAI-1001

Table R-2 Error code - OFSAAI-1001

Cause Unix shell is not "korn" shell.

Resolution Change the shell type to "korn". Use chsh unix command to change SHELL
type.
Shell type can also be changed by specifying shell path for the Unix user in
/etc/passwd file.

Note: chsh command is not available in Solaris OS.

Error code - OFSAAI-1002

Table R-3 Error code - OFSAAI-1002

Cause No proper arguments are available.
Resolution Provide proper arguments. Invoke Setup.sh using either SILENT or GUI
mode.

Example: . /Setup.sh SILENT or ./Setup.sh GUI

FAQs and Error Dictionary R-157


https://support.oracle.com/epmos/faces/MosIndex.jspx?_afrLoop=171145527063081&_afrWindowMode=0&_adf.ctrl-state=9bxcn9tmr_9
https://support.oracle.com/epmos/faces/MosIndex.jspx?_afrLoop=171145527063081&_afrWindowMode=0&_adf.ctrl-state=9bxcn9tmr_9

Error Dictionary

Error code - OFSAAI-1004

Table R-4 Error code - OFSAAI-1004

Cause File .profile is not present in $HOME.

Resolution Create .profile in $SHOME, i.e. in the home directory of user.

Error code - OFSAAI-1005

Table R-5 Error code - OFSAAI-1005

Cause File OFSAAInfrastructure.bin is not present in current folder.

Resolution Copy OFSAAInfrastructure.bin into installation kit directory.

Error code - OFSAAI-1006

Table R—-6 Error code - OFSAAI-1006

Cause File CustReg.DAT is not present in current folder.

Resolution Copy CustReg.DAT into installation kit directory.

Error code - OFSAAI-1007

Table R-7 Error code - OFSAAI-1007

Cause File OFSAAI InstallConfig.xml is not present in current folder.

Resolution Copy OFSAAI InstallConfig.xml into installation kit directory.

Error code - OFSAAI-1008

Table R-8 Error code - OFSAAI-1008

Cause File validateXMLInputs.jar is not present in current folder.

Resolution Copy validateXMLInputs.jar into installation kit directory.

Error code - OFSAAI-1009

Table R-9 Error code - OFSAAI-1009

Cause File 1og4j.xml is not present in current folder.

Resolution Copy log4j.xml into installation kit directory.

Error code - OFSAAI-1010

Table R-10 Error code - OFSAAI-1010

Cause Unknown error occurred.
Resolution Make sure to provide proper argument (SILENT or GUI) to the Setup.sh
file.
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Error code - OFSAAI-1011

Table R-11 Error code - OFSAAI-1011
Cause XML validation failed.

Resolution Check InfrastructurePre Validations.Log for more details.

Error code - OFSAAI-1012

Table R-12 Error code - OFSAAI-1012

Cause Property file with locale name does not exist.

Resolution Copy MyResources_en US.properties to the setup kit directory and keep
en_US in LOCALE tag of OFSAAI InstallConfig.xml.

Error code - OFSAAI-1013

Table R-13 Error code - OFSAAI-1013

Cause File OFSAAI InstallConfig.xml/OFSAAI PostInstallConfig.xml not
found.
Resolution Copy OFSAAI InstallConfig.xml/OFSAAI PostInstallConfig.xml to

the setup kit directory.

Error code - OFSAAI-1014

Table R-14 Error code - OFSAAI-1014
Cause XML node value is blank.

Resolution Make sure all node values except SMTPSERVER, PROXYHOST,
PROXYPORT, PROXYUSERNAME, PROXYPASSWORD,
NONPROXYHOST, or RAC_URL are not blank.

Error code - OFSAAI-1015

Table R-15 Error code - OFSAAI-1015

Cause XML is not well formed.

Resolution Execute the command dos2unix OFSAAI InstallConfig.xml to convert
plain text file from DOS/MAC format to UNIX format.
OR

Make sure that OFSAAI InstallConfig.xml is valid. Try to open the file
through Internet Explorer for a quick way to check validity. If it is not
getting opened, create new OFSAAI InstallConfig.xml using the XML
Utility.jar.

Error code - OFSAAI-1016

Table R-16 Error code - OFSAAI-1016

Cause User installation directory contain blank spaces.

Resolution Provide an installation path that does not contain spaces. Check the tag
USER_INSTALL DIRin OFSAAI InstallConfig.xml file. This path
should not contain any spaces.
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Error code - OFSAAI-1017

Table R-17 Error code - OFSAAI-1017

Cause User installation directory is invalid.

Resolution Provide a valid installation path. Check if you are able to create the
directory mentioned in USER_INSTALL DIR tag value of OFSAAI
InstallConfig.xml file.
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